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Introduction
Overview

Welcome to SEP sesam Recovery Pro, the mailbox recovery software that saves tfime, money, and
resources when recovering Microsoft® Exchange Server data.

SEP sesam Recovery Pro works with your existing Microsoft Exchange Server backup architecture
and procedures to recover individual mailboxes, folders, messages, attachments, calendaritems,
notes, and tasks directly to your production Microsoft Exchange Server or any Personal Folders (PST)
file. This eliminates time-consuming and expensive single mailbox (brick-level) backups. This
powerful software also lets you search and create a copy of all archived email that matches a
given keyword or criteria.

Five Major Reasons for Using SEP sesam
Recovery Pro

There are five primary ways you can benefit from using SEP sesam Recovery Pro:

1. Minimize the time to restore an individual mailbox.

SEP sesam Recovery Pro can slash restore time, making it possible to restore mailitems from a
previous full backup directly intfo your production Microsoft Exchange Server, or directly info a new
or existing PST file. This eliminates the need for arecovery server and the extra steps required to
separately import mail back into Microsoft Exchange Server or Microsoft® Office Outlook®.

2. Eliminate backups of an individual mailbox.

SEP sesam Recovery Pro eliminates the need to back up individual mailboxes because they can
be restored directly from a Microsoft Exchange Server Database (EDB) file.

3. Minimize the time to locate all email matching specific criteria.

SEP sesam Recovery Pro includes an Advanced Find feature that can search across all mailboxes
in an archive EDB file, rather than searching one mailbox at a time or bringing an old backup back
online for analysis. And you can search by a variety of criteria, including keywords, subject, date
and specific users.

4. Minimize storage space and the cost required to store and archive your backups.

Because you do not need to back up mailboxes individually doing a brick-level backup, you
eliminate the backup space, cost, and time associated with performing brick-level backups.

5. Minimize the time to back up all mailboxes.

SEP sesam Recovery Pro eliminates the need to back up mailboxes individually. Normally,
companies do a full Microsoft Exchange Server backup, and then run a second process to back
up "Very Important Mailboxes" (VIMs) individually as well. SEP sesam Recovery Pro eliminates this
second process.



Readme File

The SEP sesam Recovery Pro Readme file contains additionalinformation about the SEP sesam
Recovery Pro, including:

Supported environments
Licensing

Limitations

Technical support

About the Microsoft Exchange Server Database

The Microsoft Exchange Server database consists of the following files:

.edb file (rich text database file) contains data placed in the store through Messaging
Application Programming Interface (MAPI), as well as all the database tables that define
mailboxes, messages, folders, and attachments.

.stm file (streaming database file) contains common Internet formatted content, such as
Multipurpose Internet Mail Extensions (MIME) content, that protocols other than the MAPI
profocol placein the store.

Note: The .stm file is new to Microsoft Exchange Server 2000. Microsoft Exchange Server 5.5
does not contain .stm files.

Jlog files (fransaction logs) are history files recording server activity used in restoring and
backing up Microsoft Exchange Server data. Transaction logs for Microsoft Exchange Server
5.5,2000, and 2003 are 5 MB in size. Transaction logs for Microsoft Exchange Server 2007 and
later are 1 MBin size.

Each storage group uses its own set of transaction log files. For example, if a storage group
contains five stores, all transactions for all five stores are recorded in a single series of
transaction log files. You can determine where to locate the fransaction log files for each
storage group.

.chk (check) files are checkpoint files used forrecovering (playing) data from transaction
logs info EDB files. The checkpoint is the place marker in the EDB.CHK file that indicates which
fransactions have been performed. Whenever data is written to an EDB file from the
transaction log, the EDB.CHK file is updated with information specifying that the transaction
was successfully committed to the respective EDB file. Separate EXX.CHK files are
maintained for each storage group using ESE (Extensible Storage Engine).

.pat (patch) files are used to record information on page splits in Microsoft Exchange Server
5.5 through Microsoft Exchange Server 2000 (SP1). In Microsoft Exchange Server 2000 (SP2)
and later, the functionality provided by .pat files is incorporated into Microsoft Exchange
Serverlog files.



Organizing the Microsoft Exchange Server Database Files for
SEP sesam Recovery Pro

For best results when using an online incremental or differential backup

®m Pyt the .edb, .stm, and .pat files in one directory.
= Pyt the associated log files (for example, .log, .chk) in one directory.
Note: The two directories can be different.

SEP sesam Recovery Pro does not require .stm or .log files, but you should include them to ensure
that all email datais recovered. You may get corruption errors if these files are not present.

If you are using an offline backup

You need to use the .edb and .stm files for offline backups. To ensure that allemail datais
recovered, you should also include all .log files, and, if they exist, .pat and .chk files. SEP sesam
Recovery Pro performs its own verification process and includes the .log and .pat files to determine
ifit needs them torecover the data.

Getting Help

SEP AG provides you with the following ways to get help with SEP sesam Recovery Pro:

= Online Help
®m Technical Support

Online Help
Online Help includes all of the information in the user guide. You can quickly access this information

using the following online Help tabs:

= Contents: Displays a hierarchical view, similar to the Contents of the user guide.
= Index: Provides a list of key words to locate specific topics.
= Search: Offers a full-search of the Help file.

To start online Help
Do one of the following:

® Onthe Help menu, click Contents.

® Click @on the toolbar.
® Pressthe F1 key.

Context Sensitive Help

You can click the Help button that appears on many of the dialog boxes when using SEP sesam
Recovery Pro to open the online Help topic related to the current task.



Tooltip

When you position the pointer over a tool or confrol and pause, a message box appears with a
definition of your selected item.

Technical Support

If you have questions or problems not answered in the user guide or the online Help (F1), call our
Technical Support group. When reporting anissue, please include any information that might help
us diagnose the problem. The following details are often the most helpful:

The version of SEP sesam Recovery Pro you are using (on the Help menu, click About).

The versions of the Windows® operating systems and Microsoft Office Outlook that you are
running.

The version of Microsoft Exchange Server that contained the source EDB file.

The circumstances and sequence of steps that led to the problem.

The text of the error messages (if any appeared), and the contents of the Details window.
A list of other Windows-based programs that you were running when the error occurred.

See "ContactInformation” at the beginning of this user guide.

See Also:

Contact and Legal Information


Contact-Legal-Information.htm

Chapter 1: Looking at the Interface

Overview

This chapter describes the parts of the main window of SEP sesam Recovery Pro and shows you

how to preview messages, view details of an EDB, PST, or CAS file, and change the view.

Main Window

The main window is where you do most of your work. This window displays the source EDB or PST file
(s) or Content Analysis Store (CAS), as well as the target PST file(s), Microsoft Exchange Server, or
CAS. The target acts as a container for the restored files. The various work areas and controls are

described in the following sections.
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Figure 1-1: The main window with four panes

Key items on the SEP sesam Recovery Pro main window:

1. Menu Bar
2. Toolbar
3. Source Location




Source Pane
Source Message List
Target Location
Target Pane

Target Message List

W © N O O A

Status Bar

Note: In the illustration above, the Source pane displays an EDB file, but it could just as easily
display a PSTfile, CAS, or even multiple EDB and PST files. The Target pane displays a PST that acts
as a container forrestored files. Keep in mind that the Target pane could just as easily display a
Microsoft Exchange Server.

Source Pane

The Source pane displays the data you intend to recover, such as the EDB file(s) or a content
analysis store (CAS).

—|-=0 Sources
-2 Source 1- 11.15step3
(23 Profile1 (Completed)
(23 Profile2 (Completed)
|-k Seurce 2 - Personal Folders
E# Calendar
[l Contacts
U Deleted Items
(-] Drafts
+- %%y Inbox
& Journal
D Motes
% Outbox
Sent [tems
Tasks
+- %4 Source 3 - PUB.EDB

Figure 1-2: Example of Source pane (description of icons in table below)

Icon Description

= Sources Root Node contains one or more source data stores that are pre-pended
with a"SourceX"where Xis a number starting with 1 and isincremented for each
additional source opened. You can select the sources root node as your search
source.

% |source EDB File (for example, % Source 3 - PUB.EDB ) contains the Microsoft Exchange

Server Information Store data. Click the plus sign (+) next to an EDB file to expand its
contents.




Icon Description

L | Mailbox (for example, <4 Personal Folders , G Archive, and %sPublic Folder) contain the

Microsoft Office Outlook folders. Click the plus sign (+) next to a mailbox to expand its
contents.

Microsoft Office Outlook Folders (for example, ® Inbox, L& Contacts, ! Tasks)
contain Microsoft Office Outlook message items. Select a folder to view its contents
in the Source Message list.

5] Source CAS File (forexample, 3 source 1) contains the content analysis store data

created to analyze content based on certain criteria.

(& | cAS Profile Folder (for example, [& Profile2 (Completed) ) contains the results of a content
analysis.

Inaccessible Mailbox which displays if a mailboxisinaccessible. Aninaccessible
mailbox presents no visible content.

.

Source Message List

The Source Message list displays the message items in the Microsoft Office Outlook folder that you
selected in the Source pane. This folder is one of the Microsoft Office Outlook folders (for example,
Inbox, Contacts, Tasks).

0 | () | Fraom | Subject | Create Date | Skatus
B Testa engr RE: message 2 Tue 6f03/2003 ...
4 Testa engr RE: test meeting  Tue &/03§2003 ...
B4 Testa engr Message Recall ... Tue &/03§2003 ...
B Teste Engr Fuv: stuff Tue /0302003 ..,
B4 Teste Engr recall test Tue 6f0312003 ...
(] Teste Engr message 4 Tue 6f03f2003 ...
(] Teste Engr 1 recall kest Tue 0312003 ...
B Teste Engr kesk message 9 Tue 6f03/2003 ...
4 Teste Engr messagell Tue &/03/2003 ...
B Teste Engr message 11 Tue /0302003 ...
%5 Teste Engr another mesting  Tue &/03J2003 ...

Figure 1-3: The Source Message list (displaying messages in an Inbox)

The Source Message list displays metadata about the message items in six columns. The metadata
includes file type; attachments, if any; message sender; subject; date; and status. The Sent Iltems
folder also displays the "To" column. For more information on the message list, see "Sorting
Messages in the Message Lists".



The source content analysis store message list includes file type; Database #, Database, and Path.
The source content analysis store profile folder message list includes file type; Attachment, if any;
From; Subject; Create Date; Sent Date; Database #; Folder, and Status. For more information on
content analysis stores, see "Content Analysis Store".

Target Pane

The Target pane can display one or more target PST files and/or one or more target mailbox,
public folders and mailboxes from a Microsoft Exchange Server, and content analysis stores (CAS)
with profile folders. The target acts as a container for yourrestored files. If a targetis a newly
created PSTfile, it defaults to Microsoft Office Outlook folders. If a target is an existing PST file or
Microsoft Exchange Server, it shows whatever folders are in the target. It is into these folders that
you paste and restore your message items. Forinformation on restoring message items, see
"Restoring Microsoft Exchange Server Data".

Target: C:\Documents and
" B e - 11.15stepl +-- = Dbase
%'Eiﬂiﬁmms (28 Profile1 (Completed) || =G o lR o
&4 Drafts m Profile2 (Completed) +-[x<] Brad
: %fﬁﬁf e (&3 Profile3 (Completed) (& Calendar
=Eeveuna| 1= 75 Personal Folders 8 Contacts
(4 Folder 10 +-[=4 Brad U Deleted Items
(2 Calendar (=] Drafts
[0 Contacts +-[= Evno4v30Daa
D Deleted Items + ‘% Inbox
4 Drafts & Journal
+-[=2] Evno4v30aa [ ] Motes
—|- %% Inbox +- % Outbox
[+ Deleted Items +-[<] Personal Folders
(=] Folder 1 + Sent Items
Tasks
Target panes for PST | Target pane for a CAS file Target pane for a Microsoft
files Exchange Server

Figure 1-4: Target panes with PST, CAS, and Microsoft Exchange Server files




Target Message List (Restored Messages)

The Target Message list displays the message items in the Microsoft Office Outlook folder that you
selectedin the Target pane. If the target is a newly created PST file or CAS, the Outlook folders and
message list will be empty. If the target is an existing PST file, CAS file, or Microsoft Exchange Server,
orif you have restored message items to a newly created PST file, you can select a folderin the
Target pane to display messages in the Target Message list.

0 | ] I Fram | Subject | Create Date I
4 STM User1 test outlook express Fri 7/12/2002 4...
= STM User1 Fw:  Spedals from W... Fri 7/12/2002 4...
Bl [ sTMuUserl webpage Fri 7/12/2002 4...
B M STMUser2 Re: webpage ... Fri 7/12/2002 4...
Bl STM User 1 with stationary Fri 7/12/2002 4...

Figure 1-5: Target Message list displaying restored messages

The Target Message list displays metadata about the message items in five columns (instead of six
columnsin the Source Message list). The metadataincludes file type; attachments, if any;
message sender; Subject; and Create Date. The Sent ltems folder also displays the "To" column. For
more information on the message list, see "Sorting Messages in the Message Lists".

The target content analysis store message listincludes file type; Database #, Database, and Path.
The target content analysis store profile folder message list includes file type; attachment, if any;
From; Subject; Create Date; Database #; Folder; and Status. For more information on content
analysis stores, see "Content Analysis Store".

Menu Bar

File Edit Wiew Tools Help

Figure 1-6: The menu barin the main window

The menu bar contains all of the commands for SEP sesam Recovery Pro. The menu commands,
submenu commands, and resulting windows are discussed fully in the chapters that focus on
those specific commands. See the Index to quickly locate the pages on which a menu command
is discussed.

Toolbar

eSSV ¢ i L PRS oA

Figure 1-7: The Button Toolbarin the main window



The buttons on the toolbar perform the following functions:

Toolbar
Button

Function

Open Source opens the Source Selection page of the Data Wizard, where you can
navigate to and select a source Microsoft Exchange Server Database (EDB), PST, or
CAS file. The EDB, PST, or CAS file contains the message items you want to restore.

Open Target PST opens the Open Target PST dialog box, where you can navigate to
and select a target Personal Folders (PST) file. The target PST file is a container for
restored message items.

Open Target Microsoft Exchange Server opens the Target Selection page of the Data
Wizard, where you select the type and path of the target location for the data you
want to restore.

Create/Open Content Analysis Store displays the Create Content Analysis File
window, where you can open an existing content analysis store or to create a new
one inthe Target pane.

Copy copiesinto the Clipboard the selected message(s) in the Source Message list; or
the selected folder, mailbox, or EDB file in the Source pane.

Paste inserts the items from the Clipboard into the selected folderin the Target pane. If
you want to retain the directory structure of the restored messages, you must use the
Paste Special command instead of the Paste command or Paste button.

Export displays the Export window, where you can export messages to alocal or
network drive destination. You can choose to save exported messages as plain text
files (.1xt), Microsoft Office Outlook files (.msg), or Outlook Data files (.pst).

Search displays the Find window, where you can specify the desired search criteria for
finding messages in the Source pane.

Preview Pane displays the Preview pane on the SEP sesam Recovery Pro main
window, where you canread a message without opening it.

View Help displays SEP sesam Recovery Pro Online Help, which includes all of the
information in this user guide. You can quickly access the Online Help information
using its Contents, Index, Search, and Favorite tabs.

Message Table View is only available when a message in the Source Message list is
highlighted. It opens a Message Table View of that message and any message
related toiit.

Attachment Table View is only available when a message with an attachmentin the
Source Message listis highlighted. It opens an Attachment Table View of that
message and attachment and allrelated messages and attachments.

w9 Y @Y e i QSO @

7

Conversation View is only available when a message in the Source Message list is
highlighted. It shows the thread of that message with indentations to indicate the
responses fo each e-mail.

10



Shortcut Menu

You can access many of the same commands available on the menu bar and toolbar by right-
clicking the mouse to view a shortcut menu. The contents of the shortcut menu depend on
whether you right-click in the Source or Target pane. This manual explains how to use commands
on the menu bar and toolbar, and does not always specify when you can use the shortcut menu.
Once you become familiar with SEP sesam Recovery Pro, the commands available to you on the
shortcut menu should become apparent.

Previewing and Opening Messages

In the Preview pane, you can read the contents of a message item and open attachments. You
can preview a message located in either the Source Message list or the Target Message list. The
information displayed in the Message Header is different for messages, calendars, contacts, tasks,
and distribution lists.

To open the preview pane
Do one of the following:

= Onthe View menu, click Preview Pane.

)

" Onthetoolbar, click the Preview Pane icon in the toolbar.

To hide the preview pane

®m Repeat one of the previous steps.
Tip: Hiding the Preview pane will allow you to scroll through messages faster.
To display a message in the preview pane

1. Inthe Source or Target Message list, select a message.

2. Openthe Preview pane by clicking on the Preview Pane icon f“j in the toolbar.

From: Userl To: User2, User3, Userl
Subject: Summary Report @

Here is a sample summary report for your review. Let me know if you have any questions.

5 Message Item(s)

Figure 1-8: Preview pane for a message
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To open a message in its own window

= |nthe Source or Target Message list, double-click a message.

Changing the View

You can change the view in the SEP sesam Recovery Pro window by hiding the toolbar or status
bar, by using split bars; by sorting message lists; and by refreshing the screen.

Viewing or Hiding the Toolbar and Status Bar

The toolbar and status bar appear by default in the main SEP sesam Recovery Pro window, but
you can easily hide them.

To hide the toolbar or status bar

= Onthe View menu, click Toolbar or Status Bar. The check mark no longer appears next to
the name of the toolbar or status bar.

To view the toolbar or status bar

= Onthe View menu, click Toolbar or Status Bar. The check mark appears next to the name of
the toolbar or status bar.

Resizing Panes Separated by a Split Bar

You canuse a split bar (the horizontal or vertical double line that separates two panes) to increase
the area within one pane while simultaneously decreasing the area within the adjacent pane. The
Source pane, Source Message list, Target pane, Target Message list, and Preview pane all border
a split bar.

To resize panes separated by a split bar

1. Position the pointer over a split bar between the two panes on either the vertical or
horizontal split bar.

12



| Target: C:\Documents and Settings\My Documents\Mondays Files.pst

--[E calendar A B 0 |From | Subject | Create Date ~
[0 Contacts = | 6 STM User1 test outlook express Fri 7/12/2002 4...
7] Deleted Items = 5TM User1 Fw: Specials from W... Fri7/12/2002 4...
: ] Drafts =0 STM User1 webpage fonews.com Fri 7/12/2002 4... e
<-4 Evnody = 0 STM User2 Re: webpage fonews....  Fri 7/12/2002 4...
< | > [ STM Llser 1 T with statinnary Fri 7112/2007 4., b
From: STM Userl * To:
Subjact: test outlook express

this was sent from outlook express

5 Message Ttem(s)

Figure 1-9: Before dragging the split bar between the Target Message list and the Preview
pane

2. When the pointer becomes a double-headed arrow, dragit fo resize the pane.

Sorting Messages in the Message Lists

You can sort messages in the Source and Target Message lists based on attachments, message
sender, subject, date, and status. In addition, the Source Message list lets you sort messages based
on status, and the Sent Items folder lets you sort items based on the "To" heading. Sorfing messages
on the From column, for example, can help to identify messages from a specific sender.

To sort a message list

1. Click a column heading to sort the messages based on that heading. For most headings, an
arrow appears indicating the sort direction. An up arrow indicates that the messages
appearin ascending (A-Z) order. A down arrow indicates that the messages appearin
descending (Z-A) order.

2. Toreverse the order of the messages based on that column heading, click the column
heading again. Notice the arrow reverses directions.

An example of sorting messages:

* Ifyouclickthe o’r’rochmenTM column heading, messages are sorted in ascending
order based on this heading, even though no arrow appears. This means that messages
with attachments appear at the top of the message list, while messages with no
attachments appear at the bottom of the document list. If you click the attachment

L column heading again, the orderisreversed.

Note: The view settings (sort order and column width) for a folder or mailbox are saved until
you close the data store.
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Refreshing the Screen

You may want to refresh the screen occasionally when you are connected to a target Microsoft
Exchange Server. That is because the information on the server may change while you are
connected.

To refresh the screen
Do one of the following:

= Onthe View menu, click Refresh.
= Pressthe F5 key.

Opening Attachments

If you have the appropriate program installed on your computer, SEP sesam Recovery Pro loads
the application to view the selected attachment (for example, fo view an .xIs file attachment, SEP
sesam Recovery Pro willlaunch Microsoft® Excel®).

If no associated program is available for the attachment's file type, SEP sesam Recovery Pro
presents a message window saying the attachment cannot be viewed.

Note: SEP sesam Recovery Pro cannot view attached embedded graphics in HTML messages.

To open an attachment in an open message

1. Inthe message list, double-click a message that has the Attachment iconL next toits
name.

2. Click the Attachmenticon ﬁl on the right side of the message header. A pop-up window
lists the attachments for the selected message.

3. Click the name of the attachment you want to view.

To open an attachment in the preview pane

1. Inthe message list, select a message that has the Attachment iconL next toits name.

2. Openthe Preview pane. In the SEP sesam Recovery Pro main window, click the Preview
o
Paneicon ~! .Inthe Find window, select the Preview check box.

3. Clickthe Atachmenticon ﬁl on the right side of the message header in the Preview pane.
A pop-up window lists the attachments for the selected message.

4. Click the name of the attachment you want to view.
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Saving Attachments

A'"save attachments" option is available on the File menu and paperclip menu of an open
message, as well as on the paperclip menu of the Preview pane. The Save Attachments window
lists the attachments for the selected message and lets you select the attachments you want to
save.

To save attachments in an open message

1. Inthe Source or Target Message list, double-click a message that has the Attachmenticon
L next toits name.
2. Inthe open message, do one of the following:
¢ Onthe File menu, click Save Attachments.

* Click the Attachmenticon ﬂ on the right side of the message header, and then click
Save Attachments.

3. Inthe Save Attachments window, select one or more attachments, and click OK.
4. Inthe Browse For Folder window, select alocation for the attachment(s), and click OK.

To save attachments in the preview pane

1. Inthe Source or Target Message list, select a message that has the Attachmenticon ﬂ
next to its name.

2. Inthe Preview pane, click the Aitachmenticon ﬂ on theright side of the message header,
and then click Save Attachments.

3. Inthe Save Aftachments window, select one or more attachments, and click OK.
4. Inthe Browse For Folder window, select alocation for the attachment(s), and click OK.

Viewing the Properties of an EDB File, PST File,
CAS File, CAS Profile Folder, Folder, or Mailbox

SEP sesam Recovery Pro makes it easy to view the properties of a source PST file, EDB file, CAS file,
CAS profile folder, mailbox, or folder.

Note: Only accessible mailboxes can produce property reports. For CAS files, inaccessible
mailboxes within that data store are notincluded in the totals.

Note: When the Show Recoverable Items preference is enabled, the Recoverable Items folder,
subfolders, and messages will appearin the folder and message countsin the EDB properties. If the
preference is cleared, the Recoverable Items folders and messages are notincluded in the folder
and message counts.
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To view the properties

1. Inthe Source pane, right-click an EDB file, PST file, CAS file, CAS profile folder, mailbox, or
folder.

2. Onthe shortcut menu, click Properties. One of the following Properties dialog boxes
appears:

F N

Status.  Finished counting.

— EDE Info
server: AEXCHME1
EDE Consistency Check: Pass
EDE Creation Time: 871372012 18:03:41
Size of EDB File: 264 MB
EDE Version: Microsoft Exchange Server 2010
Number of Mailboxes: 33
Number of Root Public Folders: o
Number of Opened Mailboxes: 33
Number of Folders: 965
Number of Messages: 1630
Mailbox Criteria:
—Lag File Info
Mumber of Log Files: 1366
Size of Log Files: 1366 MB
—STM File Infa
STM File: No
Size of 5TM file: 0 MB

Save...

Figure 1-10: EDB File Properties dialog box

Note: The Save button is only available for Microsoft Exchange Server 2010 and earlier
databases. Click Save to save the Microsoft Exchange Server name to your hard drive.
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PST File Properties

Mumber of Folders: 13
Mumber of Messages: B
PST Creation Time: 104122006 15:53:30
Size of P5T File: 0 MB
PST Version: Qutlook 2007
Status: Finished
8].4 Help |

Figure 1-11: PST File Properties dialog box

CAS File Properties

MNumber of Source Containers: 0
Mumber of Profile Folders: 2
Number of Messages: 248
CAS Creation Time: 10/12/2006 135043
Size of CAS File: 0 MB
oK Help |

Figure 1-12: Content Analysis Store (CAS) File dialog box

Properties of Profile1

Full Path: 11.15step] 25 Profilel
Number of Messages: 0

Approximate Total Size of Messages: 0 Bytes

Number of Messages Processed: o
Status: Finished counting.
Processing State: Completed Processing

OK | Help

Figure 1-13: Content Analysis Store (CAS) Profile Folder dialog box
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Properties of User 1

Full Path: privl.edb\User 1

Number of Subfolders: 519

Mumber of Messages: 279

Number of Associated Messages: BS

Approximate Total 5ize of Messages: 14.22 megabytes
Status: Finished counting.

oK | Help

Figure 1-14: Properties of a Mailbox dialog box

An alternate way to view the properties of an EDB or PST file

Once you have viewed the properties of the source EDB or PST file as described above, you can
then display the properties in the Preview pane.

1. Open the Preview pane by clicking the Preview Pane icon [:] on the toolbar or by clicking
the View menu and pointing fo Preview Pane.
2. Click the source EDB or PST file in the Source pane and click Properties.

Database Details

Number of Folders: 11

MNumber of Messages: 1

PST Creation Time: 8/14/2007 16:44:00
Size of PST File: 50 MB

PST Version: Outlook 97/2000/XP

Figure 1-15: Properties of an EDB File

Performing an Integrity Check

You can perform an integrity check on messages, folders, mailboxes, PST files, CAS files, CAS profile
folders, EDB files, and live Microsoft Exchange Server target search results. During the integrity
check, SEP sesam Recovery Pro verifies that it can read all folder and message properties from the
selected source.

To perform an integrity check

1. Inthe Source pane, select an EDB file, PST file, CAS file, CAS profile folder, mailbox, folder, or
message(s).
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2. Do one of the following:
¢ On the Tools menu, click Integrity Check. The Integrity Check window appears.
* Right-click the item and click Integrity Check in the shortcut menu.

3. Click Print to print a copy of the integrity check.

4. Click Save to save a copy of the integrity check to file.

Creating a Mailbox List
You can create a text file with a list of all mailboxes available in an EDB source file.

Note: This is similar to the -list command line parameter.

To create a mailbox list

1. Inthe Source pane, select an EDB file.
2. Do one of the following:
e Right-click the EDB files and select Create Mailbox List in the shortcut menu.
e PressCtrl+Alt+L.
3. Onthe Save mailbox list dialog box, select the path and enter a File name, then click Save.

Viewing Deleted Messages

SEP sesam Recovery Pro can view and restore deleted messages that are held in the EDB file.
These messages appear with the value "Deleted" in the Status column of the Source Message list. If
deleted messages have been purged from the EDB file due to the deleted retention schedule, SEP
sesam Recovery Pro cannot view orrestore these messages.

Content analysis store deleted messages in both the Source and Target panes also appear with
the value "Deleted" in the Status column of the message list.

Viewing Deleted Items in Microsoft Exchange Server
Databases

Deleted items do not have the same functionality as items from earlier databases. Instead of
being stored in the folder they were deleted from, they are stored in a separate "Recoverable
ltems" folder.

Note: The Recoverltems folder only appears when using Microsoft Exchange Server 2010
databases and later.

By default, this separate folder does not appearin the source tree under the mailbox. A
preference setting allows you to view this folder in the source tree, making the deleted items
accessible to you. For more information, see Setting Preferences in the "Security Tab".
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When the Recoverable Items folder is visible, the subfolders are accessible as well, including:

= Audits: Holds audit log entries for the mailbox, if audit logging is enabled on the Microsoft
Exchange Server.

= Calendar Logging: Holds calendar changes that occur within a mailbox.

= Deletions: Holds messages that have been removed from the Inbox using the Delete key,
menu item, or shortcut key.

= DiscoveryHolds: Holds all items that meet the hold query parameters and are purged.

= Purges: Holds messages that have beenremoved from a mailbox via the "Recover Deleted
Items" tool in Microsoft Office Outlook when alegal hold is set for a mailbox.

= Versions: Holds sent and received messages that were edited by a userin a mailbox for
which alegal hold was set.

You can perform source operations on the messages in these folders, including copying and
exporting. The messages in Recoverable ltems and its subfolders are also included in searching,
creating reports, integrity checks, and property counts.

Note: Viewing the Recoverable ltems folder applies to sources only. It is not visible in target
mailboxes.

Setting Preferences

The Preferences dialog box allows you to streamline SEP sesam Recovery Pro operations. Most of
the preference settings in the four tabs are selected by default. There are two exceptions: the
"Display new PSTwhen PST limitis reached" sefting in the Target Opftions tab, and the "Enable
Tamper-Proof Target" setting in the Security tab. If you change the settings, they are stored and
reloaded on the nextrun of SEP sesam Recovery Pro.

General Tab

The General tab governs the tasks that SEP sesam Recovery Pro performs and the location of the
license file.
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Preferences @
General | Target Elptic-ns] Security] Warnings |
[v Run DataWizard on startup
[v Checkfor duplicate messages during copy and expart
[v Checkfor duplicate messages during search

[ Append to existing PST files during export

QK | Cancel | | Help

Figure 1-16: The General tab in the Preferences dialog box

To change the General preference settings

1.
2.

On the Edit menu, click Preferences, then click General.
Select or clear the following check boxes as desired:

Run Data Wizard on startup: The Data Wizard will launch every time you open SEP sesam
Recovery Pro.

Check for duplicate messages during copy and export: When restoring Microsoft
Exchange Server data, SEP sesam Recovery Pro does not copy duplicates of a message to
the destination folder if a message already exists in the destination folder. Selecting this
preference setting results in slower copy performance.

Check for duplicate messages during search: SEP sesam Recovery Pro will not return
duplicates of a message during a search. For example, if the same message exists in two or
more data stores, only the first message found is listed in the search results. Selecting this
preference setting results in slower search performance.

Append to existing PST files during export: If selected, SEP sesam Recovery Pro updates
previously exported PST files with new messages from the export process. If cleared, a new
PST file is created when exporting data.

Target Options Tab

The Target Options tab governs the target-related tasks that SEP sesam Recovery Pro perform:s.
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Preferences o

General Target Options ] Security] Wamings
PST Options
[V Create new PST folders when PST message/folder limits are reached

[v Display new PST when PST limit is reached
v Create Unicode PSTs

W Limit maximum PST file size 100 :ll ME

Microsoft Exchange Server
¥ Encrypt data connection with Microsoft Exchange Server

Use Autodiscover to detect Microsoft Exchange Server connection
settings

v Use Qutlook Anywhere to connect to Micrasoft Exchange Server

[~ Always prompt for credentials when connecting to a single mailbox

Mailbox Creation
v Allow mailbox creation during copy

ok | cancel Apply | Help |

Figure 1-17:The Target Options tab in the Preferences dialog box

To change the Target Options preference settings

1. Onthe Edit menu, click Preferences, then click Target Options.
2. Inthe PST Options group, select or clear the following check boxes as desired:
= Create new PST folders when PST message/folder limits are reached: SEP sesam
Recovery Pro automatically creates new folders (for example, Inbox) when the
16,383 messages/folder limit is reached. After SEP sesam Recovery Pro creates a new
folder, it continues to restore Microsoft Exchange Server data where it left off. For
more information, see "Limits for PST and Folder Targets".
= Display new PST when PST limit is reached: When the limit for a PSTisreached in the
Target pane, SEP sesam Recovery Pro automatically displays the overflow PST.

= Create Unicode PSTs: If selected, SEP sesam Recovery Pro always creates Unicode
PSTs. If cleared, SEP sesam Recovery Pro creates non-Unicode PSTs.

Note: The default maximum size for Unicode PST files is typically set by the locally
installed version of Microsoft Office Outlook. Forinformation on adjusting this
limitation, see https://support.microsoft.com/en-us/kb/832925.

= Limit maximum PST file size: If selected, SEP sesam Recovery Pro automatically
creates a new PST file when the MB size is reached during export. For more
information, see "Setting a Global Limit for PST Files"

Note: The MB field should not exceed 48640.

3. Inthe Microsoft Exchange Server group, select or clear the following check boxes as
desired:
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Encrypt data connection with Microsoft Exchange Server: If selected, SEP sesam
Recovery Pro willuse an encrypted connection to send data to the Microsoft
Exchange Server. Clear this if you are using an unencrypted connection.

Use Autodiscover to detect Microsoft Exchange Server connection settings: If
selected, SEP sesam Recovery Pro attempts to use Autodiscover to detect profile
settings for connecting to the target Microsoft Exchange Server.

Use Outlook Anywhere to connect to Microsoft Exchange Server: If selected, SEP
sesam Recovery Pro uses Outlook Anywhere settings to connect to the target
Microsoft Exchange Server. For more information, see "Outlook Anywhere and
Autodiscover".

Always prompt for credentials when connecting to a single mailbox: If selected, SEP
sesam Recovery Pro requests a username and password each fime it connects to a
mailbox on a Microsoft Exchange Server. This option requires a user to provide
credentials when connecting to asingle mailbox, even when the logged in user s
connecting to their own mailbox, or when managed passwords are set up for the
Microsoft Exchange Server.
4. Inthe Mailbox Creation group, select or clear the following check boxes as desired:

= Allow mailbox creation during copy: If selected and a mailbox copy is initiated by
you, mailboxes can be created during a mailbox copy. Ifitis cleared, mailbox
creation cannot take place during copy. This setting has no effect on manual
mailbox creation.

Security Tab

The Security tab conftrols the level of information available to the user when using the application
and governs the tasks that person can perform.

The optionsin the Security tab are modifiable by default only by users that belong to the
Administrator Group. The options are stored in the registry: HKEY_LOCAL_
MACHINE\NSOFTWARE\SEP Software\RecoveryPro.

The SEP sesam Recovery Pro Installation program sets this registry key to have read/write access to
users in the Administrators group and read-only access to any user in the Users group.
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Preferences @
'General] Target Options ~ Security |Wamings |
[v Allow preview of messages

[ Enahle Tamper-Proof Target

Allow Bec field to be included when restoring
or searching messages

[# Enable Message Yiews
[¢ Listinaccessible railboxes
[~ Show Recoverable ltems
[~ Enable Multi-Tenant Support
o
o

QK | Cancel | | Help

Figure 1-18: The Security tab in the Preferences dialog box

To change the security preference settings

1. Onthe Edit menu, click Preferences, then click Security.
2. Select orclearthe following check boxes as desired:

= Allow preview of messages: If this option is not selected, you willnot have the ability to open
or preview messages in the source or target.

= Enable Tamper-Proof Target: If this option is selected, SEP sesam Recovery Pro does not
allow you to delete messages or folders in the target or have the ability to rename folders in
the target. You only have the ability to add (copy) to the target.

= Allow Bcc field to be included when restoring or searching messages: If this optionis
selected, SEP sesam Recovery Pro includes Bcc information when restoring or searching
messages. This means that a recipient is able to see Bcc recipients that he or she was not
infended fo see. It also means that searching with the "Sent to" option returns messages for
Bcc recipients.

= Enable Message Views: If this optionis selected, it makes the Message Views available.

= Listinaccessible mailboxes: When SEP sesam Recovery Pro connects to a Microsoft
Exchange Server, it can display both accessible and inaccessible mailboxes. If this option is
selected, the inaccessible mailboxes listed in the directory appear and are display-only.

®  Note: Clearing this option while you have mailboxes open refreshes the mailbox list and no
longer displays the inaccessible mailboxes.

= Show Recoverable ltems: Selecting this option allows the "Recoverable ltems" folder to be
displayed under your mailbox, enabling you to have access to any deleted items. It also
provides access to the "Purges” and "Versions" folders, which are also sub-folders of
"Recoverable Items."
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Note: This setting only applies to Microsoft Exchange Server 2010 and later.

Selecting the Show Recoverable ltems preference causes your Microsoft Exchange
Server 2010 and later EDB sources to close. A warning message appears giving you
the option to cancel or continue changing the setting.

= Enable Multi-Tenant Support: If this option is selected, multi-tenant support is enabled. This
allows you to filter a source or target from a list of Microsoft Exchange Server 2010 through
SP3 hosted organizations or Microsoft Exchange Server 2010 SP2 and later Address Book
Policies (ABPs). It also selects and opens all mailboxes or displays mailboxes not containedin
any hosted organization (hosted environment only).

« Enforce ABP or Hosted Organization for current user: If this option is selected, you cannot
select from alist of hosted organizations or Address Book Policies (ABPs) from source or
target dialog boxes. Rather, you are limited to opening only the mailboxes included in
the Global Address List (GAL) of your assigned ABP or mailboxes contained in the hosted
organization to which you belong.

Note: This option is only available when Enable Multi-tenant Support is selected.

* Show deleted or unrecognized mailboxes: When this option is selected, SEP sesam
Recovery Pro opens mailboxes not found in the current environment. These
unrecognized mailboxes may have been previously present in the environment and
were deleted or are mailboxes from a different environment. Unrecognized mailboxes

are opened and displayed in the source free, in conjunction with the selected ABP or
organization mailboxes. This option only applies to the opening of source EDBs.

Note: This option is only available when Enable Multi-tenant Support is selected.

Warnings Tab

The Warnings tab controls whether or not warning messages appear when various tasks are
performed.
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Preferences @

'General] Target Options | Securty  Warmings

[v Show warning when logs specified but not found
[v Show warning when nolog file path specified
[v Show warning when copying to Exchange Server root

Show warning when opening a Microsoft Exchange Server and a
Microsoft Exchange Server is already open

QK | Cancel | | Help

Figure 1-19: The Warnings tab in the Preferences dialog box

To change the warnings preference settings

1. Onthe Edit menu, click Preferences, then click Warnings.
2. Select orclearthe following check boxes as desired:

= Show warning when logs specified but not found: SEP sesam Recovery Pro warns you when
opening an EDB file if no .log files were found at the specified directory.

= Show warning when no log file path specified: SEP sesam Recovery Pro warns you when
opening an EDB file if a .log file path has not been specified.

= Show warning when copying to Microsoft Exchange Server root: SEP sesam Recovery Pro
warns you when you are about to copy alarge amount of data to the Microsoft Exchange
Serverroot.

= Show warning when opening a Microsoft Exchange Server and a Microsoft Exchange
Server is already open: This warning appears when you attempt to connect to either a
single mailbox or all mailboxes on a Microsoft Exchange Server when a target Microsoft
Exchange Server connectionis already openin SEP sesam Recovery Pro.
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Chapter 2: Using SEP sesam Recovery
Pro

Overview

You can open a source Microsoft Exchange Server Database (EDB) file or PST file and specify a
target PST file or target Microsoft Exchange Server by using one of the following methods:

= Use the Data Wizard.

= Openthe source database and target mailboxes from the SEP sesam Recovery Pro main
window.

Note: You cannot open the same PST file as both source and tfarget.

Mailbox Criteria

When selecting the EDB Source Files, you can use the "Mailbox Criteria (optional)" box fo limit the
number of mailboxes that are opened and displayed in the Source pane. This box appears on the
Source Selection dialog box (opened by clicking File then Open Source) or the Source Selection
page of the Data Wizard.

When you enter a string in the Mailbox Criteria box, SEP sesam Recovery Pro matches your entry
against the display name and alias of the mailboxes to select datain the source database. Only
mailboxes matching your entries are displayed on the Source pane.

Note: With Microsoft Exchange Server 2013 and later, SEP sesam Recovery Pro matches your
Mailbox Criteria box string entry against the display name only.

The mailbox criteria uses a simple "string contains" match andis not case sensitive. You can use a
semi-colon to separate and enter multiple strings. If you want to include a semi-colon in one of your
enftries, use double quotes around that entry.

Mailbox criteria only works with mailbox stores, it does not work with public folder stores. If you use
mailbox criteria on a public folder store, it is not used and all public folders are opened.

Note: Any mailboxes which do not match the entered string do not appearin the Source pane
and are notincluded in any subsequent tasks, such as searching, copying, and exporting of the
entire database.
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Multi-Tenancy Support

Microsoft Exchange Server 2010 and laterincludes features that aid multi-tenancy deployments.
SEP sesam Recovery Pro provides support for the Exchange Hosted Organizations feature
(infroduced in Microsoft Exchange Server 2010 SP1) and Address Book Policies (infroducedin
Microsoft Exchange Server 2010 SP2).

When selecting the Microsoft Exchange Server 2010 and later EDB Source File or Target Server, you
can use the Multi-Tenancy Criteria box to limit the number of mailboxes that are opened and
displayed in the Source and Target panes. The Multi-Tenancy Criteria box appears on the
following pages of the Data Wizard:

® Source Selection page
= Target Selection page

When Multi-Tenancy Support is enabled, you can filter a source or target from alist of hosted
organizations or Address Book Policies (ABPs), as well as select and open all mailboxes or view
mailboxes not contained in any hosted organization (hosted environment only).

Activate Multi-Tenancy Support using the Security tab on the Preferences dialog box. For more
information, see "Security Tab".

Outlook Anywhere and Autodiscover

In Microsoft Exchange Server, the Outlook Anywhere feature (also known as RPC over HTTP) allows
clients to connect using HTTP. This enables users outside of an organization's network to connect to
the Microsoft Exchange Server without having to use a VPN. Outlook Anywhere is supported by
Microsoft Outlook 2003 and later, and Microsoft Exchange Server 2007 and later.

Note: Microsoft Outlook 2003 is not supported for Microsoft Exchange Server 2013 or later.

With Microsoft Exchange Server 2013 and later, Direct RPC access to the Microsoft Exchange
Serveris no longer supported, so Outlook Anywhere isrequired to connect to the server.

SEP sesam Recovery Pro supports connecting to a Microsoft Exchange Server target using Outlook
Anywhere

Note: With Microsoft Outlook 2016 and later, only connection with Autodiscoveris supported.

Autodiscover simplifies the process of connecting to a Microsoft Exchange Server by returning the
connection settings when requested by a client application. Clients such as Microsoft Outlook
canrefrieve the connection settings by issuing a request to Autodiscover with the user's SMTP
email address. These settings are then used to configure the user's profile and connect.
Autodiscover is supported by Microsoft Outlook 2007 and later, and Microsoft Exchange Server
2007 and later.

Note: Microsoft Exchange Server 2007 is not supported for Microsoft Outlook 2016 or later.
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SEP sesam Recovery Pro supports using Autodiscover when connecting fo a Microsoft Exchange
Server target.

If you are using Outlook Anywhere to connect to a target Microsoft Exchange Server, SEP sesam
Recovery Pro uses Autodiscover to determine the correct connection policies. If Autodiscover s
notin use or cannot determine the connection polices, the Outlook Anywhere page appears.

The Outlook Anywhere page follows the Target Selection page on the Data Wizard and records
the protocol and verification method used when SEP sesam Recovery Pro connects to a target
Microsoft Exchange Server. The Outlook Anywhere page displays the values from the most recent
successful connection using Outlook Anywhere. The values are empty if no previous connection
exists.

You can configure SEP sesam Recovery Pro to use Outlook Anywhere and Autodiscover on the
Target Options tab of the Preference dialog box, where the Microsoft Exchange Server group
contains the following check boxes:

= Use Autodiscover to detect Microsoft Exchange Server connection settings
= Use Outlook Anywhere to connect to Microsoft Exchange Server

The following table explains the actions SEP sesam Recovery Pro performs based on the possible
combinations of selecting or clearing these two check boxes.

Use Autodis- Use Outlook Action
cover to detect | Anywhere to
Microsoft connectto

Exchange Server| Microsoft
connection set- | Exchange

tings Server
Selected (and Selected SEP sesam Recovery Pro connects to the target Microsoft
Autodiscover Exchange Server with Outlook Anywhere using the settings
response returned by Autodiscover.
successful)
Selected (and Selected If aserver name was entered on the Target Selection page,
Autodiscover Ouflook Anywhere page appears. If no server name was
not contacted) entered, an error message appears and the wizard stays on
the Target Selection page.
Selected (and Cleared SEP sesam Recovery Pro connects to the target Microsoft
Autodiscover Exchange Server with RPC over TCP/IP using the server
response returned by Autodiscover.
successful)

\
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Use Autodis- Use Outlook
cover to detect | Anywhere to
Microsoft connectto

Exchange Server| Microsoft
connection set- | Exchange

tings Server
Selected (and Cleared If aserver name was entered on the Target Selection page,
Autodiscover SEP sesam Recovery Pro connects to the target Microsoft
not contacted) Exchange Server with RCP over TCP/IP. If no server name was

entered, an error message appears and the wizard stays on
the Target Selection page.

Cleared Selected The Outlook Anywhere page appears.

Cleared Cleared SEP sesam Recovery Pro connects to the target Microsoft
Exchange Server with RCP over TCP/IP.

\.

For more information, see "Target Options Tab".

Connecting to Office 365

When connecting to a hybrid environment (where both on-premise and Office 365 mailboxes are
present), the following apply:

m Selecting All Mailboxes (on-premise) filters out Office 365 mailboxes and displays only on-
premise mailboxes.

= Mailbox creation creates mailboxes in the on-premise environment, but only if connecting
to on-premise mailboxes. This includes connect-to-all.

®m Copy edb toroot of server (with mailbox creation) "Creates mailboxes in the on-premise
environment, but only if connecting to on-premise mailboxes. This includes connect-to-all.

= Copy mailbox toroot of server (with mailbox creation) "Creates mailboxes in the on-premise
environment, but only if connecting to on-premise mailboxes. This includes connect-to-all

= Multi-tenancy filters out Office 365 mailboxes and displays only on-premise mailboxes. If the
ABP contains both on-premise and Office 365, only on-premise mailboxes are displayed. If
ABP contains only Office 365 mailboxes, no mailboxes are displayed.

Keyboard Shortcuts

The following table contains keyboard shortcuts for many of the common tasks performed when
using SEP sesam Recovery Pro.

Menu Bar Keyboard Shortcut

File Menu
Open Source Ctrl+S
LO|oen Target PST Cirl+T )
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Menu Bar Keyboard Shortcut

Open Target Microsoft Exchange Server Ctrl+E
Close Store Ctrl+L
Use Data Wizard Ctrl+W
Exit Alt+F4
Edit Menu

Copy Selection to Clipboard Ctrl+C
Paste Copied ltem(s) Cirl+V
Paste Special Ctrl+Y
Delete DEL
Rename Cirl+R
New Folder Cirl+N
New Mailbox Ctrl+M
Move To Folder (Microsoft Exchange Server as a target - Find window) Ctrl+Shift+V
Cut (Microsoft Exchange Server as a target - Find window) Ctrl+X
View Menu

Refresh Screen F5
Tools Menu

Export Ctrl+P
Export Organizational Forms Cirl+G
Create Mailbox List Cirl+Alt+L
Integrity Check Ctrl+l
Create Reports Ctrl+Q
Find F3
Online Help

LV iew Help F1 )

Opening a Microsoft Exchange Server as a Target

You can open live Microsoft Exchange Servers as a target within SEP sesam Recovery Pro using the
Data Wizard or Main Window. This means you can connect to one live Microsoft Exchange Server
at atime, establishing a single mailbox connection or connecting fo all accessible mailboxes and
displaying alist of the mailboxes found in that Microsoft Exchange Server. A status indicator tells
you if you have permission rights to view a mailbox.

Note: The Microsoft Exchange Server as a target feature is only supported if the system running SEP
sesam Recovery Pro is on the same domain as the Microsoft Exchange Server.
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Recommendation: If connecting to a Microsoft Exchange Server 2010 CAS Array, use the fully
qualified domain name of the CAS Array for the Server Name (for example,

casarray.domain.name).

When connecting to asingle mailbox, the Target pane populates with only the specified single
mailbox. When connecting to all mailboxes on a Microsoft Exchange Server, the Target pane
populates with the list of mailboxes found in that Microsoft Exchange Server.

Note: You can connect to only one live Microsoft Exchange Server at a time. If you attempt to
connect to an additional live Microsoft Exchange Server while a serveris already open, the current
server connection closes.

Paste, Paste Special, folder creation, folderrenaming, and the search functions are available for
the accessible mailboxes. A mailbox or server cannot be renamed.

Using the Data Wizard

The Data Wizard guides you through the loading of the Microsoft Exchange Database (EDB), PST
files, or content analysis store (CAS) files intfo SEP sesam Recovery Pro, and shows you how o
specify the target PST file or Microsoft Exchange Server.

Opening the Data Wizard

The first time you start SEP sesam Recovery Pro, the Data Wizard opens at the Source Selection
page.

When working in the main window, you can return to the Data Wizard at any time.

To manually start the Data Wizard

= On the File menu, click Use Wizard.

Data Wizard: Source Selection

On the Source Selection page of the Data Wizard, specify the type and path of the source from
the following options:

= APSTfile
= An EDB file
® A Content Analysis Store

Note:
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= |f you do notwant to select a source file at this time, click Skip.

= |fyou do not want to run the Data Wizard every time you start SEP sesam Recovery Pro, clear

the Run on Startup check box.

To specify a PST file as the source

1. Onthe Source Selection page, click Outlook Data File (*.pst) in Select Source list.

Note: You can also open Microsoft Explorer, click the PST file you want to open as the
source, then drag it to the Select Source list and skip the next step.

Data Wizard

Source Selection

Please select the type of source you want to open and its location. If you do not want to open a source at this time, click Skip
and select your target.

Select Saurce:

Qutlook Data File (% pst)

EDE File (*.edh)
Outlaok Data File (7. pst) || j Browse. ..

Content Anahysis Store (% cas)

W FEun On Startup | et > | Skip »» Cancel

Figure 2-1: Selecting a PST file as the source

2. Inthe Outlook Data File (*.pst) box, click Browse to open the Create PST File window and
locate the source PST file.

3. Click Next.

To specify an EDB file as the source

1. Onthe Source Selection page, click EDB File (*.edb) in Select Source list.

Note: You can also open Microsoft Explorer, click the EDB file you want to open as the
source, then drag it fo the Select Source list and skip to step 6.
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Data Wizard

Source Selection

Please select the type of source wou want to open and its location. If wou do not want to apen a source at this time, click Skip
and select your target.

Select Source:

EDE Fath (*. edb)

EDE File {*.edb)
QOutlook Data File {*.pst) I <] Browse..

Content Anahysis Store (% cas)

Log File Path (¥ log, ¥ pat, " chk)
| j Erowse. ..
Temporary File Path (*.idx, ™. dat, . lkp)

| j Erowse. ..

Mailbox Criteria {optional)

| B

W FEun On Startup | et > | Skip »» Cancel

Figure 2-2: Selecting an EDB file as the source

. Inthe EDB Path (*.edb) box, click Browse and use the Open window to locate the source
EDB file.

. Inthe Log File Path (*.log, *.pat, *.chk) box, click Browse to and use the Browse For Folder
window to choose the log files associated with the source EDB file.

Afteryou select an EDB file, the Log File Path box defaults to the source EDB file path, even if
the log files are not in the same directory as the source EDB file. Therefore, make sure you
enter the correctlog file path in the Log File Path box.

. Inthe Temporary File Path (*.idx, *.dat, *lkp) box, accept the default location for .idx and
.dat files, or specify a new location if they require more hard drive space. For more
information, see "Guidelines for Selecting a Microsoft Exchange Server Database”.
. Ifyou want to view afiltered display of mailboxes in the Source pane, use the Mailbox
Criteria (optional) box. For more information, see "Mailbox Criteria”.
. Ifmulfi-tenancy supportis enabled, do one of the following in the Multi-Tenancy Criteria
box:
= |f"Enforce ABP or Hosted Organization for current user”is not selected on the Security
tab on the Preferences dialog box, use the Multi-Tenancy Criteria box to select
hosted organizations or Address Book Policies from source or target dialog boxes.
m [f"Enforce ABP or Hosted Organization for current user" is selected on the Security tab
on the Preferences dialog box, use the Multi-Tenancy Criteria box to view the
organization or assigned address book policy.
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Data Wizard

Source Selection

Please select the type of source wou want to open and its location. If wou do not want to apen a source at this time, click Skip
and select your target.

Select Source:

~EDE Path (" edb)

EDE File {*.edb)
QOutlook Data File {*.pst) [l <] Browse.. |

Content Anahysis Store (% cas)

—Log File Path (" log, ™. pat, " chk)
I j Erowse. .. |
—Temporary File Path (% idx, ¥ dat, " [kp)

I j Erowse. .. |

—Mailbox Criteria {optional)
| =l
—Multi-Tenancy Criteria

IAII mailboxes j

W Eun On Startup < Back | et > I Skip»» | Cancel |

Figure 2-3: Selecting an EDB file as the source with multi-tenancy support

7. Click Next.

To specify a Content Analysis Store as the source

1. Onthe Source Selection page, click Content Analysis Store (*.cas) in Select Source list.

Note: You can also open Microsoft Explorer, click the CAS you want to open as the source,
then drag it to the Select Source list and skip the next step.
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Data Wizard

Source Selection

Please select the type of source wou want to open and its location. If wou do not want to apen a source at this time, click Skip
and select your target.

Select Source:

EDE File (% edb)
Qutlook Data File % pst)

"Content Analysis Store Path (% cas)

|| j Erowse. .. |

Caontent Analysis Store (. cas)

W Fun On Startup < Back | et > I Skip»» Cancel

Figure 2-4: Selecting a CAS as the source

2. Inthe Content Analysis Store Path (*.cas) box, click Browse to open the Create Content
Analysis File window and locate the source CAS.

3. Click Next.

The EDB or PST file appears in the Single Mailbox Recovery Source pane.

Source: C:\Documents and Se

- & Sources
+ ‘@}- Source 2 - Personal Folders
—-tE4 Source 3 - PUB.EDB
+-[=] 0001
+-[=] 1
+-[=4] 10-32-33 AM 17
[ 2
k4 3
(= 4
(=] 4.0.5
+-[=4d 4.0.8
(4 5

A«

Figure 2-5: Source pane for an EDB file
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Tip: You can use Windows Explorer to open an EDB, PST, or CAS file. In Windows Explorer, double-
click the file or drag into the SEP sesam Recovery Pro Source pane.

Guidelines for Selecting a Microsoft Exchange Server
Database

1.

For the best results when using an online incremental or differential backup:
e Putthe .edb, .stm, and .pat filesin one directory.
» Putfthe associated log files (for example, .log, .chk) in one directory.
Note: The two directories can be different.

Note: SEP sesam Recovery Pro does not require .stm or .log files, but you should include them
to ensure that allemail datais recovered

If you are using an offline backup: You need to use the .edb and .stm files. To ensure that alll
email datais recovered, you should also include all .log files, as well as .pat and .chk files if
they exist. SEP sesam Recovery Pro performs its own verification process and willinclude the
Jlog and .patfiles to determine if it needs them to recover the data.

For best results when specifying a temporary file path for .idx and .dat files: Make sure you
have a sufficient amount of hard drive space for .dat and .idx files. These files may require

hard drive space equal to the size of the .log files. Therefore, you may need to change the
default file path for .idx and .dat files if you need more space.

SEP sesam Recovery Pro never modifies an .edb file orits associated files (for example, .log,
stm, .pat, .chk); however, it does create .dat and .idx files the first time you open an .edb
file from a directory that contains log files. Each time you reopen the .edb file, SEP sesam
Recovery Pro uses the information in the .dat and .idx files to open the .edb file more
quickly.

Note: Only Microsoft Exchange Server 2000 and 2003 use .stm files.

Data Wizard: Target Selection

On the Target Selection page of the Data Wizard, specify the type and path of the target location
for the data you want to restore from the following options:

"To specify a PST file as the target for restored data

"To specify a content analysis store"

"To specify a Microsoft Exchange Server as the target for a single on-premise mailbox”
"To specify a single Office 365 mailbox as the target (Hybrid Modern Authentication) "
"To specify a Microsoft Exchange Server as the target for all mailboxes"

"To specify a Microsoft Exchange Server as the target for specific mailboxes with multi-
tenancy support”
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An option to open Public Folders is available upon connection to a Microsoft Exchange Server. SEP
sesam Recovery Pro connects to all public folders hosted by the target Microsoft Exchange server,
not specific databases or Public Folders mailboxes.

Note: Click Skip if you do not want to select a target file at this time.

To specify a PST file as the target for restored data

1. Onthe Target Selection page, click Outlook Data File (*.pst) in Select Target list.
Data Wizard

Target Selection

Please select the type of target you want to open and its location. If you do not want to open a target at this ume, click Skip.

Select Target:

Outlook Data File (*.pst) Qutlook Data File (*.pst)

Content Analysis Store (*_cas) | j Browse.
Single Mailbox (Office 363)

Single Mailbox (on-premise)

All Mailboxes (on-premise)

< Back | Next > | Skip »> Cancel

Figure 2-6: Selecting the PST File option on the Target Selection page

2. Do one of the following:
* Ifyou know the target PST file path, type it in the Outlook Data File (.pst) box.

e Click Browse to open the Create PST File window and navigate to the desired location.
Create a new PST file by typing a name in the File name box, or select an existing PST file.
Next, click Open. The path of the target PST file appears in the Target PST File Path box.

3. Click Next.
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To specify a content analysis store

1. OntheTarget Selection page, click Content Analysis Store (*.cas) in Select Target list.

Data Wizard

Target Selection

Please select the type of target you want to open and its location. If you do not want to open a target at this ume, click Skip.

Select Target:

F &
Outlook Data File (*.pst) Content Analysis Store Path (*.cas)
Content Analysis Store (*.cas) | j Browse. ..

Single Mailbox (Office 363)
Single Mailbox {on-premise)
All Mailboxes (on-premise)

< Back | Next > Skip >> Cancel

Figure 2-7: Selecting Content Analysis Store on the Target Selection page

2. Do one of the following:

« Ifyou know the target CAS file path, enteritin the Content Analysis Store Path box.

e Click Browse to open the Create Content Analysis File window. and navigate to the
desired location. Create a new CAS file by typing a name in the File name box or select
an existing CAS file. Next, click Open. The path of the target CAS file appearsin the
Content Analysis Store Path box.

3. Click Next.
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To specify a Microsoft Exchange Server as the target for a single on-premise mailbox

1. Onthe Target Selection page, click Single Mailbox (on-premise) in Select Target list.

Data Wizard

Target Selection

Please select the type of target you want to open and its location. If you do not want to open a target at this ume, click Skip.

Select Target:

Outlook Data File (*.pst) Microsoft Exchange Server

Content Analysis Store (*_cas) E-mail Address: j
Single Mailbox (Office 365)
Single Mailbox {on-premise)

All Mailboxes (on-premise) I¥ Connect To Public Folders

Example: user@server.com

¥ Connect using Autodiscover

< Back | Neat > Skip > | Cancel |

Figure 2-8: Selecting Single Mailbox (on-premise) displays the target Microsoft Exchange
Server

2. Inthe E-mail Address box, type the email address name.

Tip: If you are not using Autodiscover and you do not know the full name of the mailbox,
type the first letter of the mailbox in the E-mail Address box, and click Next. In the Check
Name window that appears, select the mailbox from the list, and click OK. If you are using
Autodiscover, you must type the full email address in the E-mail Address box.

3. With Connect To Public Folders selected, you can open public folders as a target for
restoring public folders or messages. If you do not want to restore to public folders, clear th
check box. For more information, see "Restoring to Public Folders".

4. The Connect using Autodiscover check box determines whether SEP sesam Recovery Pro
will use Autodiscover to connect to Microsoft Exchange Server. The default setting is
selected or cleared using the Target Options tab on the Preferences window.

is

5. If you are not connected to a domain, the Enter Password window appears. In this window,

enter a user name that has full rights to the mailbox, a password, and a domain name. The
click OK. This window may appear again, which requires you to reenter this information.

6. Click Next.

n
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To specify a single Office 365 mailbox as the target (Hybrid Modern Authentication)

1. Onthe Target Selection page, click Single Mailbox (Office 365) in Select Target list.

Data Wizard X

larget Selection

Please select the type of target you want to open and its location. If you do not want to open a target at this time, click Skip.

Select Target:

M ft Exch S
Outlook Data File (*_pst) D

Content Analysis Store (*.cas) E-mail Address: | j
Single Mailbox (Office 365) Example: user@server.com
Single Mailbox (on-premise) "
Client ID
All Mailboxes (on=-premise) <t | j

Tenant ID: | L]

Client Secret |

I Connect To Public Folders

Figure 2-9: Selecting Single Mailbox (Office 365) displays the target Office 365 mailbox

2. Inthe E-mail Address box, type the email address name.

Note: For example of proper environment setting see "EWS Configuration".

In the Client ID box, type Client ID associated with the email address.
Inthe Tenant ID box, type Tenant ID associated with the email address.
In the Client Secret box, type Client Secret associated with the email address.

With Connect To Public Folders selected, you can open public folders as a target for
restoring public folders or messages. If you do not want to restore to public folders, clear this
check box.

7. Click Next.

o0~ W
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To specify a Microsoft Exchange Server as the target for all mailboxes

1. Onthe Target Selection page, click All Mailboxes (on-premise) in Select Target list.

Data Wizard

Target Selection

Please select the type of target you want to open and its location. If you do not want to open a target at this ume, click Skip.

Select Target:

Outlook Data File (*.pst) Microsoft Exchange Server

Content Analysis Store (*_cas) Domain Controller: | j

Single Mailbox (Office 365)
Single Mailbox (on-premise )

All Mailboxes (on-premise) Server Name: | j

[v Connect To Public Folders

[V Connect using Autodiscover

I¥ Connect using Qutlook Anywhere

< Back | Neat > Skip > | Cancel |

Figure 2-10: Selecting All Mailboxes (on-premise) displays the target Microsoft Exchange
Server

2. Inthe Domain Controller and Server Name boxes, the domain controller and server names
auto-populate.

Note: For Microsoft Exchange Server 2010, specify the name of the Client Access Server
(CAS) that provides access to the mailboxes you want to access (not the mailbox server,
unless the mailbox server has the client access role installed).

Note: The mailboxes found will depend on both the Domain Confroller and Microsoft
Exchange Server entered. Only those mailboxes accessible through the entered Microsoft
Exchange Server and listed in the Active Directory of the given Domain Confroller will
attempt to be opened.

Note: For Microsoft Exchange Server 2013 or later, specify the name of any of your Microsoft
Exchange 2013 orlater Servers, orleave this field blank to auto detect. The mailboxes found
depend on the Domain Controller with only those mailboxes listed in the Active Directory of
the given Domain Controller opened, subject fo permissions.
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3. With Connect to Public Folders selected, you can open public folders as a target for
restoring public folders or messages. If you do not want to restore to public folders, clear this
check box. For more information, see "Restoring to Public Folders".

4. Ifyou are not connected to a domain, the Enter Password window appears. In this window,
enter a user name that has full rights to the mailbox, a password, and a domain name. Then
click OK. This window may appear again, which requires you to reenter this information.

5. Click Next.

To specify a Microsoft Exchange Server as the target for specific mailboxes with multi-tenancy
support

1. Onthe Target Selection page, click Specified Mailboxes (on-premise) in Select Target list.
2. Do one of the following:

« If"Enforce ABP or Hosted Organization for current user"is cleared on the Security tab on
the Preferences dialog box, use the Multi-Tenancy Criteria box to select hosted
organizations or Address Book Policies from source or target dialog boxes.

 If"Enforce ABP or Hosted Organization for current user" is selected on the Security tab on
the Preferences dialog box, use the Multi-Tenancy Criteria box to view the organization
or assigned address book policy.
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Data Wizard

Target Selection

Please select the type of target you want to open and its location. If you do not want to open a target at this ume, click Skip.

Select Target:

Outlook Data File (*_pst) Microsoft Exchange Server

Content Analysis Store (*_cas) Domain Controller: | j

Single Mailbox (Office 363)
Single Mailbox (on-premise)

Specified Mailboxes (on-premise) Server Name: | j

[v Connect To Public Folders

[v Connect using Autodiscover

¥ Connect using Qutlook Anywhere

Multi-Tenancy Criteria
All mailboxes j

< Back | Neat > Skip == | Cancel |

Figure 2-11: Selecting Specified Mailbox (on-premise) displays the target Microsoft
Exchange Server

. Inthe Domain Controller and Server Name boxes, the domain controller and server names

auto-populate.

Note: For Microsoft Exchange Server 2010, specify the name of the Client Access Server
(CAS) that provides access to the mailboxes you want to access (not the mailbox server,
unless the mailbox server has the client access role installed).

Note: The mailboxes found will depend on both the Domain Confroller and Microsoft
Exchange Server entered. Only those mailboxes accessible through the entered Microsoft
Exchange Server and listed in the Active Directory of the given Domain Controller will
attempt to be opened.

Note: For Microsoft Exchange Server 2013 or later, specify the name of any of your Microsoft
Exchange 2013 orlater Servers, orleave this field blank to auto detect. The mailboxes found
depend on the Domain Controller with only those mailboxes listed in the Active Directory of
the given Domain Controller opened, subject fo permissions.

. With Connect to Public Folders selected, you can open pubilic folders as a target for
restoring public folders or messages. If you do not want to restore to public folders, clear this
check box. For more information, see "Restoring to Public Folders".
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5. If you are not connected to a domain, the Enter Password window appears. Enter a user
name that has full rights to the mailbox, a password, and a domain name, then click OK. This
window may appear again, requiring you to reenter this information.

6. Click Next.

Data Wizard: Outlook Anywhere

With the Outlook Anywhere page, you can adjust the settings for using Outlook Anywhere to
connect to the target Microsoft Exchange Server. This page appears if you are using Outlook
Anywhere, but not Autodiscover, to connect to Microsoft Exchange Server. This page also
appearsif you are using Outlook Anywhere and Autodiscover to connect, but the Autodiscover
service cannot be contacted.

If SEP sesam Recovery Prois configured to use Outlook Anywhere, but "Connect using
Autodiscover"is not selected on the Data Wizard: Target Selection page, the Outlook Anywhere
page appears so you can configure the Outlook Anywhere connection. If "Connect using
Autodiscover"is selected, the Outlook Anywhere page does not appear, as Autodiscover
automatically configures the connection.

Note: The Outlook Anywhere page displays the values from the most recent successful
connection using Outlook Anywhere. The values are empty if no previous connection exists.

Data Wizard \EI

Outlook Anywhere
Pleaze configure your Outlook. Anywhere prosy settings to connect to thiz Microsoft Exchange server.

Use this URL to connect to my Microsoft Exchange proxy server:

https: // || j
I
[ Only connect to proxy servers that have this principal nare in their certificate:
[~ On fast netwarks, connect using HT TP first, then connect using TCF/IP
[~ On slow networks, connect using HTTP first, then connect using TCP/IP
Use this authentication when connecting to my proxy server for Exchange:
Easic j
< Back | Mext > | Cancel

Figure 2-12: Outlook Anywhere page
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To complete the Outlook Anywhere page

1. Onthe Outlook Anywhere page, do the following:
= |nthe http:// drop-down list, enter or select the URL to use when connecting the
Microsoft Exchange proxy server.
= |fyou wantto connect using only secure sockets layer, select Connect using SSL only
and enter the connection URL in the hitps:// drop-down list. You canrequire the use
of an authentication of certificate by selecting Only connect to proxy servers that
have principal name in their certificate and entering or selecting the principal name.
2. Select from the following to use HTTP on the first connection, and TCP/IP on all subsequent
connections based on the speed of your network:
= On fast networks, connect using HTTP first, then connect using TC/IP
= On slow networks, connect using HTTP first, then connect using TC/IP

Note: Outlook defines a fast connection as a connection thatis faster than 128 kilobits per
second (Kbps).

3. Inthe Use this authentication when connecting to my proxy server for Exchange drop-
down list, select from the following:

= Basic: Basic authentication uses clear text to send user and password information for
authentication. If selected, the Connect using SSL only box is selected automatically
and cannot be changed. This prevents passwords from being sent o the Microsoft
Exchange proxy serverin clear text when Basic authenticationis used.

= NTLM Authentication: If selected, NTLM authenticationis used. Thisis a
challenge/response scheme in which a hash of the password is used for
authentication. The password is not sent over the network.

= Negotiate Authentication: If selected, Kerberos is used for authentication, if possible.
Otherwise, NTLM authentication is used.

4. Click Next.

Data Wizard: Connection Settings

With the Connection Settings page, you can adjust the setfings fo connect to the target Microsoft
Exchange Server. This page appears if Autodiscover fails to connect to the target server or
Autodiscoveris not enabled in on the Preferences dialog box.
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Data Wizard

Connection Settings
Please corfigure your connection to server and set Outlook Anywhere proxy settings to connect to this Microsoft Exchange server if needed.

Target Server

Security

Logon network security:  |Anonymous Authentication j

¥ Connect using Outlook Anywhere

Use this URL to connect to my proxy server for Exchange:

https:.‘.'| j

¥ Connect using S5L only

¥ Only connect to proxy servers that have this principal name in their certificate:

| &
[ On fast networks, connect using HT TP first, then connect using TCP/IP
[ On slow networks, connect using HTTP first, then connect using TCP/IP
Use this authentication when connecting to my proxy server for Exchange:
Basic j

< Back | Cancel |

Figure 2-13: Connection Settings page

To complete the Connection Settings page

1. Onthe Connectionsettings page, type the server name of the Target Server.

2. Inthe Security drop-down list, select the method of security when logging on to the target
server network.

3. The Connect using Outlook Anywhere check box determines whether SEP sesam Recovery
Pro will use Outlook Anywhere (also known as RPC over HTTP) to connect to Microsoft
Exchange Server. The default setting is selected or cleared using the Target Options tab on
the Preferences window. If you choose Connect using Outlook Anywhere, do the following:

= |nthe hitps:// drop-down list, enter or select the URL to use when connecting the
Microsoft Exchange proxy server.

= |fyou wantto connect using only secure sockets layer, select Connect using SSL only
and enter the connection URL in the https:// drop-down list. You can require the use
of an authentication of certificate by selecting Only connect to proxy servers that
have principal name in their certificate and entfering or selecting the principal name.

4. Select from the following to use HTTP on the first connection, and TCP/IP on all subsequent
connections based on the speed of your network:

= On fast networks, connect using HTTP first, then connect using TC/IP
= On slow networks, connect using HTTP first, then connect using TC/IP

Note: Outlook defines a fast connection as a connection that is faster than 128 kilobits per
second (Kbps).
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5. Inthe Use this authentication when connecting to my proxy server for Exchange drop-
down list, select from the following:

= Basic: Basic authentication uses clear text to send user and password information for
authentication. If selected, the Connect using SSL only box is selected automatically
and cannot be changed. This prevents passwords from being sent o the Microsoft
Exchange proxy serverin clear text when Basic authenticationis used.

= NTLM Authentication: If selected, NTLM authenticationis used. Thisis a
challenge/response scheme in which a hash of the password is used for
authentication. The password is not sent over the network.

= Negotiate Authentication: If selected, Kerberos is used for authentication, if possible.
Otherwise, NTLM authenticationis used.

6. Click Next.

Data Wizard: Now Processing Data File
The Now Processing Data File page of the Data Wizard reports the processing of the EDB file in

three stages:

1. Pre-scanning the log files (integrity check)
2. Scanning the log files (playing the log files)
3. Hashing the EDB file (building a folder hierarchy)

When the processing is complete, the Data Wizard closes.

Note: If SEP sesam Recovery Pro encounters bad or missing log files during log playing, you will be
given the option to confinue without playing the logs. If you choose to confinue, SEP sesam
Recovery Pro processes the EDB without logs.

Results of Data Wizard

When you complete the Data Wizard, the Source and Target panes in the main window now
contain a source EDB file, PST file, CAS, target PST file, a target Microsoft Exchange Server, or target
CAS.
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Source: C:\Documents and||| gpyrge: C:\Documents ant Source: C:\Documents and Se

[£-&3 Sources
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Figure 2-14: Source panes with PST, EDB, and CAS files
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Figure 2-15: Target panes for PST files, Microsoft Exchange Server, and CAS file

Opening the Source Database and Target
Mailboxes from the Main Window

Instead of using the Data Wizard to open the source databases and target mailboxes, you can
open them from the main window.

Opening a Source and a Target from the Main Window

The section explains how to perform the following tasks from the Main Window:

= "To open a source file".

®= "To open an existing target PST".

= "To create a new target PST".

= "To open an existing target content analysis store”.
= "To open a new target content analysis store”.

= "To open a Microsoft Exchange Server as the target for restored data for a single on-
premise mailbox"

= "To open an Office 365 single mailbox as the target for restored data "

= "To open a Microsoft Exchange Server as the target for restored data for Specific Mailboxes
with multi-tenancy support"

To open a source file

1. Do one of the following:
= On the File menu, click Open Source.
. . .
On the toolbar, click the Open Source icon .

Important: Before you select a source EDB file in the window below, see "Guidelines for
Selecting a Microsoft Exchange Server Database".

2. Follow the instructions in the "Data Wizard: Source Selection" topic "Data Wizard: Source
Selection”.

3. Click OK.The EDB, PST, or CAS file appearsin the SEP sesam Recovery Pro Source pane.

To open an existing target PST

1. Do one of the following:

= Onthe File menu, point fo Open\ Create Target, then Open Target PST, and click
Open Existing.
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* Onthetoolbar, click the Open Target PSTicon ﬁ .

2. Inthe Open Target PST window, navigate to the desired location, and select an existing PST
file.

3. Click Open.The PST file appearsin the SEP sesam Recovery Pro Target pane.

Tip: In Windows Explorer, you can drag a PST file into the SEP sesam Recovery Pro target
pane.

To create a new target PST

1. Onthe File menu, point to Open\ Create Target, then Open Target PST, and click Create
New.

2. Inthe Create PST File window, navigate to the desired location. You may want to create a
new folder.

3. Inthe File name box, type a name for the new PST file.
4. Click Open.The PST file appears in the SEP sesam Recovery Pro Target pane.

Note: With Microsoft Office Outlook 2003, you have to choose between the 97 and 2003
version of the PST.

Target: C:\Documents and £

¥ personal Folders
+-[=] Brad
E# calendar
[@ Contacts
D Deleted Items
(4] Drafts
+-E Evnodv30aa
1% Inbox
[ Deleted Items
[ Folder 1
[ Folder 10

Figure 2-16: Target pane for a PST file
To open an existing target content analysis store

1. Do one of the following:

= Onthe File menu, point to Open\ Create Target, then click Open Target Content
Analysis Store and click Opening Existing...

* Onthe toolbar, click the Open Target Content Analysis Store icon ﬁ .

2. Inthe Opening a Content Analysis File window, navigate to desired location and select an
existing CAS file.

3. Click Open.The CAS file appearsin the SEP sesam Recovery Pro Target pane.
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To open a new target content analysis store

1. Do one of the following:

= Onthe File menu, point to Open\ Create Target, then click Open Target Content
Analysis Store and click Create New....

On the toolbar, click the Open Target Content Analysis Store icon ﬁ

2. Inthe Create Content Analysis File window, navigate to desired location and type a File
Name for the new CAS file.

3. Click Open.The CAS file appearsin the SEP sesam Recovery Pro Target pane.

To open a Microsoft Exchange Server as the target for restored data for a single on-premise
mailbox

1. Do one of the following to display the Target Selection page of the Data Wizard:

= Onthe File menu, click Open\Create Target, then click Open Target Exchange
Server.

On the toolbar, click the Open Target Exchange Servericon ﬁ .

2. Follow the instructions in the "Data Wizard: Target Selection" topic "To specify a Microsoft
Exchange Server as the target for a single on-premise mailbox".

To open an Office 365 single mailbox as the target for restored data

1. Do one of the following to display the Target Selection page of the Data Wizard:

= Onthe File menu, click Open\Create Target, and then click Open Target Exchange
Server.

* Onthetoolbar, click the Open Target Exchange Server icon ﬁ .

2. Follow the instructions in the "Data Wizard: Target Selection" topic "To specify a Microsoft
Exchange Server as the target for all mailboxes".

To open a Microsoft Exchange Server as the target for restored data for Specific Mailboxes with
multi-tenancy support

1. Do one of the following to display the Connect To Exchange Server window:

= Onthe File menu, click Open\ Create Target, and then click Open Target Exchange
Server.

" Onthetoolbar, click the Open Target Exchange Server icon ﬁ .

2. Follow the instructions in the "Data Wizard: Target Selection" topic "To specify a Microsoft
Exchange Server as the target for specific mailboxes with multi-tenancy support”.
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Opening Multiple Sources and Targets

You can display multiple sources in the Source pane and multiple targetsin the Target pane.
Sourcesinclude EDB, PST, and CAS files. Targetsinclude PSTs, CAS, and Microsoft Exchange
Servers. See the instructions for using the Data Wizard or the main window to open one source or
one target at afime.

Source: C:\Documents and Settfll| Target: C:\Documents and Settin

—|- =0 Sources + ‘@ Personal Folders
+-Ch Source 1 - mwhard -tk personal Folders
+ ‘% Source 2 - priv1l.edb [ 11.15step124
¥4 Source 3 - publedb +- ] Calendar
O] Contacts
7] Deleted Items
[ Drafts

- % Inbox

+-[~4 Forensic Certification

& Journal
D Motes

% Outbox

Multiple sources Multiple targets

Figure 2-17: Multiple sources and targets can be displayed

Closing Sources and Targets

You can close sources and targets from the SEP sesam Recovery Pro main window.
To close a source

1. Inthe Source pane, select asource EDB, PST, or CAS file.
2. Do one of the following:
= On the File menu, click Close Store.
® Right-click the selection, and on the context menu click Close Store.

To close all sources

1. Inthe Source pane, right-click the sources roof node.
2. Onthe context menu, click Close All Stores.



To close a target

1. IntheTarget pane, select a PST file, Microsoft Exchange Server database, or CAS file.
2. Do one of the following:

¢ On the File menu, click Close Store.

* Right-click the selection, and on the context menu click Close Store.

Deleting Items in the Target Pane

Using the Delete key toremove anitem (for example, folder, message) from the SEP sesam
Recovery Pro Target pane permanently deletes the item, similar o using Shift+Delete in Microsoft
Office Outlook.

Note: Messages within a content analysis store profile folder cannot be deleted.

Creating New Mailboxes

You can create new mailboxes by either using the Mailbox Creation wizard or the Copy and Paste
functions. Possible uses for this function are migrating user accounts from an older version of
Microsoft Exchange Server or archiving legacy data.

Note: To use Mailbox Creation Wizard on your computer, you must have the Exchange Server
Management Tools for the version of Microsoft Exchange Server where you will be creating
mailboxes. Ensure the Exchange Server Management Tools and Microsoft Exchange Server
version, service pack, and rollup level are the same version. For supported operating system and
prerequisite requirements for the Exchange Server Management Tools, please refer to the
Exchange Server Management Tools documentation for your specific version.

User Permission

In order to create mailboxes, the following are required:

® You must have the necessary Active Directory permissions to create a mailbox on the
selected Microsoft Exchange Server.

®m Both the user accountlogons and the Name field must be unique to create a new user
account and mailbox. If you are creating a mailbox for an existing user, the Name field must
match the fullname of the existing user.

Tip: Itisrecommended that anyone creating mailbox-enabled users have fundamental
knowledge of Microsoft Exchange Server administration and Active Directory.
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Preference Settings

The Target Options tab of the Preferences dialog box contains a Mailbox Creation group with the
following option:

= Allow mailbox creation during copy

When selected, a copy operation can create new mailboxes, so a copy operation can create a
target mailbox for a source mailbox to allow it to be copied.

When cleared, new mailboxes are not created and only mailboxes that match an existing
mailbox can be copied. Any mailboxes that do not match a target mailbox are skipped.

The Security tab of the Preferences dialog box contains the following option regarding mailboxes:

m |istinaccessible mailboxes

When selected, mailboxes always appearin the Target pane and mailboxes willindicate if they
are accessible. Otherwise, inaccessible mailboxes are not displayed.

For more information, see "Setting Preferences".

Creating Mailboxes

You can create mailboxes with the Mailbox Creation wizard or by copying a single mailbox. You
can also copy the root of a source EDB to the root of a target Microsoft Exchange Server.

If the mailbox already exists and is accessible, it is added to the target directory and shown as
accessible. If the source mailbox did not exist in the target directory, a new mailboxis created on
either a new user account or an existing user account. If the mailbox you create is not accessible,
it appearsin the target directory and shown as inaccessible.

Note: Mailbox creation on disabled user accountsis not supported.

Note: The target Microsoft Exchange Server must be in the same domain as the SEP sesam
Recovery Pro computer.

Note: In a Microsoft Exchange Server 2010 environment installed using the /hosting switch,
mailboxes can only be created in the domain, not an Exchange Hosted Organization.

Note: In a Microsoft Exchange Server 2010 or 2013 environment that has deployed Address Book
Policies, an Address Book Policy cannot be assigned when creating a mailbox.

Creating Mailboxes Using the Mailbox Creation Wizard

You can manually create asingle mailbox on a target Microsoft Exchange Server by using the
Mailbox Creation wizard to specify user account and mailbox information.
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To create a Microsoft Exchange Server 2007 mailbox using the wizard

1. Open atarget Microsoft Exchange Serverin SEP sesam Recovery Pro.

2. Do one of the following to open the Mailbox Creation wizard:

Right-click the target Microsoft Exchange Serverroot directory and click New
Mailbox.

On the Edit menu, click New Mailbox.

Mailbox Creation Wizard &J

User Information
Enter the user name and account information.

I Specify the Organizational unit rather than using a default one:

|

First name: Initials: Last name:

Name:

User logon name {User Principal Name): UPM Suffix:

| |@cnrp.altegrity.com j

User logon name (pre-Windows 2000):

Password: Confirm password:

™ Save as default password

| Mext > | Cancel |

Figure 2-18: User Information page for Microsoft Exchange Server 2007

3. Onthe User Information page, enter the following:

Organizational unit: This field is pre-populated. You can change it by clicking Browse.

First name: (Optional) Enter the first name of the user. If a user account already exists,
but there is no mailbox based on this Name, the mailbox is created on the existing
user account.

Initials: (Optional) Enter the initials of the user.

Last name: (Optional) Enter the last name of the user. If a user account already exists,
but there is no mailbox based on this Name, the mailbox is created on the existing
user account.

Name: This field auto-populates as the First name, Initials, and Last name are entered.
This field can also be modified.

User logon name (User Principal Name): Create a userlogon name for the new
account. If this name matches the same field of an existing user account, an error
appears at the end of the process indicating that it is a duplicate.
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= UPN suffix: This field adds the Organizational Unit selected as the second half of the
logon name email address.

= User logon name (pre-Windows 2000): A user logon name for older versions of
Windows.

= Password and Confirm Password: The password must meet the domain's minimum
password requirements or the user/mailbox creation will fail.

= Save as default password: Select to designate the entered password as the default.
4. Click Next.

Mailbox Creation Wizard LﬁJ

Mailbox Settings

Enter the alias for the mailbox uzer, and then select the mailbox location.

Alias:

|TestUser|

Server

[E2KT

Storage group:

Mailbox database:

™ Managed folder mailbos policy:

I Exchange ActiveSunc mailbox policy:

< Back | Finigh | Cancel |

Figure 2-19: Mailbox Settings page for Microsoft Exchange Server 2007

5. Onthe Mailbox Settings page, do the following:
= Alias: Enfer the alias for the mailbox user.

= Server: Auto-populated with the Storage group and Mailbox database. Ensure these
seftings are correct.

= Mailbox database: The mailbox database is automatically selected by the Microsoft
Exchange Server if not specified. To specify the mailbox database, select the check
box which enables the drop-down list of all available mailbox databases.

= Managed folder mailbox policy: (Microsoft Exchange Server 2007 only) To apply a
managed folder policy to your mailbox, select the check box which enables the
drop-down list of all available managed folder mailbox policies in the organization.

= Exchange ActiveSync mailbox policy: (Microsoft Exchange Server 2007 only) To
apply an ActiveSync mailbox policy to your mailbox, select the check box which
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enables the drop-down list of all available ActiveSync mailbox policies in the

organization.

6. Click Finish. The mailboxinformationis validated and the mailbox is created.

Note: If the Managed folder mailbox policy check box is selected, a warning appears
stating: "When assigning a managed folder mailbox policy with managed custom folders to
a mailbox, Microsoft Office Outlook clients older than Microsoft Office Ouflook 2007 do not
have all available client features and clients older than Microsoft Office Outlook 2003 SP2
are not supported. Are you sure you want to assign a managed folder mailbox policy to this

mailboxzg"

To create a Microsoft Exchange Server 2010 (and later) mailbox using the wizard

1. Open a target Microsoft Exchange Server in SEP sesam Recovery Pro.

2. Do one of the following to open the Mailbox Creation wizard:

= Right-click the target Microsoft Exchange Serverroot and click New Mailbox

= On the Edit menu, click New Mailbox.

Mailbox Creation Wizard

==

User Information
Auto-populated fields are derived from the source mailbox.

[ Specify the Organizational unit rather than using a default one:

ez

First name: Initials: Last name:
Mame:
lUser logon name (User Principal Mame): UPN Suffic:

| | @corp altearity.com

User logon name (pre-Windows 2000):

Password: Corfirm password:

[~ Save as default password

< Back | Finigh | Cancel |

Figure 2-20: User Information page for Microsoft Exchange Server 2010 and later

3. Onthe User Information page, enter the following:

= Organizational unit: The Organizational Unit is automatically selected by the
Microsoft Exchange Server if not specified. You can change it by selecting the
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Specify the Organizational unit rather than using a default one check box. Select this
check box to enable the Browse button where you can select a different
Organizational unit.

First name: (Optional) Enter the first name of the user. If a user account already exists,
but there is no mailbox based on this Name, the mailbox is created on the existing
user account.

Initials: (Optional) Enter the initials of the user.

Last name: (Optional) Enter the last name of the user. If a user account already exists,
but there is no mailbox based on this Name, the mailbox is created on the existing
user account.

Name: This field auto-populates as the First name, Inifials, and Last name are entered.
This field can also be modified.

User logon name (User Principal Name): Create a user logon name for the new
account. If this name matches the same field of an existing user account, an error
appears at the end of the process indicating that it is a duplicate.

UPN suffix: This field adds the Organizational Unit selected as the second half of the
logon name email address.

User logon name (pre-Windows 2000): A user logon name for older versions of
Windows.

Password and Confirm Password: The password must meet the domain's minimum
password requirements or the user/mailbox creation will fail.

Save as default password: Select this check box to designate the entered password
as the default.

4. Click Next.
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Mailbox Creation Wizard ﬁ

Mailbox Settings

Erter the alias for the mailbox user, and then select the mailbox location and policy settings.
Alias:

[~ Specify the mailbox database rather than using a database automatically selected:

| =]
[

| =]
[~ Exchange ActiveSync mailbox policy:

| =]

< Back | Finish | Cancel |

Figure 2-21: Mailbox Settings page for Microsoft Exchange Server 2010 and later

5. Enter the following Mailbox Settings:

= Alias: Enfer the Alias for the mailbox user.

= Mailbox database: The mailbox database is automatically selected by the Microsoft
Exchange Server if not specified. To specify the mailbox database, select the check
box which enables the drop-down list of all available mailbox databases.

= Managed folder mailbox policy: (Microsoft Exchange Server 2010 only) To apply a
managed folder policy to your mailbox, select the check box which enables the
drop-down list of all available managed folder mailbox policies in the organization.

= Exchange ActiveSync mailbox policy: To apply an ActiveSync mailbox policy to your

mailbox, select the check box which enables the drop-down list of all available
ActiveSync mailbox policies in the organization.

Note: If the Managed folder mailbox policy check box is selected, a warning appears
stating: "When assigning a managed folder mailbox policy with managed cusfom
folders to a mailbox, Microsoft Office Outlook clients older than Microsoft Office
Outlook 2007 do not have all available client features and clients older than Microsoft
Office Outlook 2003 SP2 are not supported. Are you sure you want to assign a
managed folder mailbox policy to this mailbox2g"

6. Click Next. The mailbox informationis validated.

7. Ifyou are creating a Microsoft Exchange Server 2010 (or later) mailbox, and the Archive
Seftings page appears. Select the Create an archive mailbox for this account fo associate
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an online archive mailbox with the user account. To specify the mailbox database, select
the check box which enables the drop-down list of all available mailbox databases.

Mailbox Creation Wizard ﬁ

Archive Settings

LUse this step to create an archive for the created mailbox. kems will be moved automaticalty
from the primary user mailbox to the archive based on the default retention policy settings of
the Microsoft Exchange Server.

I Create an archive mailbox for this account

-

| =)

< Back | Finish | Cancel |

Figure 2-22: Archive Settings for Microsoft Exchange Server 2010 and later

Note: If using Microsoft Exchange Server 2010 SP1 and later or Microsoft Exchange Server
2013, the mailbox database can be selected.

8. Click Finish. The mailboxis created.

Creating Mailboxes Using Copy and Paste

You can create new mailboxes by using the Copy and Paste functions. Mailbox creation through
copying can be made available or unavailable by selecting or clearing an opftion in the Mailbox
Creation group on the Target Options page of the Preferences dialog box.

Note: Source archive mailboxes are treated like regular mailboxes for the purposes of copy and
creation. When copying an archive mailbox to a target Microsoft Exchange Serverroot, the
application will attempt to identify an existing target user mailbox. If one cannot be found, a new
mailbox is created and copied to. Target archive mailboxes will not be the destination of a single
or multiple mailbox copy operation.

To create a single mailbox using copy and paste

1. Verify that Allow mailbox creation during copy option in Preferences is selected. For more
information, see "Target Options Tab".
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2.
3.

5.

Right-click the single mailboxin the Source pane and click Copy.
Highlight the target Microsoft Exchange Server and click Paste.
Note: If Paste is not available, you do not have accessrights to the source mailbox.

SEP sesam Recovery Pro queries the Active Directory for an existing mailbox-enabled user
account based on the source mailbox's GUID and name information. If the search finds
both (a fullmatch), SEP sesam Recovery Pro copies the mailbox to that full matching user's
mailbox. If the search finds only a name match, itis considered a partial match. The name
match includes checks for both the source mailbox name and alias (if it is available) in the
target environment. When a partial match is found, the target mailbox may not be for the
same user as the source mailbox. You are then prompted on how to proceed (either by
skipping, copying to the matching mailbox, or creating a new mailbox and copying info
that —see below for further details).

Note: Alias is not present in Microsoft Exchange Server 2013 and later sources, so only a
match on the mailbox GUID is considered a full match for Microsoft Exchange Server 2013
and later source mailboxes. If no fullmatching user account exists, the Mailbox Creation
wizard opens.

If a fullmatching mailbox is not found in the target, the Mailbox Copy wizard opens the
Mailbox Copy Options page.
If no match is found on the target, do one of the following in No Match group:

® Select Skip Mailbox to skip this mailbox and not copy it. (The Mailbox Creation wizard
closes and the process ends.)

= Select Create and copy to new mailbox to proceed with the Mailbox Creation wizard
and create a new target mailbox for this copy.
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7

Mailbox Creation Wizard ﬁ

Mailbox Copy Options

The mailbox could not be fully identified on the target server. Please select the copy
option for this mailbox from the options provided below.

MNa Match

Mo match for this mailbox was found on the target. Please select the copy option:
+ Skip mailbox

" Create and copy to new mailbox

"j

Mesd = Cancel

b

Figure 2-23: Mailbox Copy Options page - No Match

6. If apartialmatch is found on the target, do one of the following in Partial Match group:

m Select Skip Mailbox o skip this mailbox and not copy it. (The Mailbox Creation wizard
closes and the process ends.)

= Select Copy to existing mailbox to copy the mailbox. (The Mailbox Creation wizard
closes and the copy begins.)

= Select Create and copy to new mailbox to proceed with the Mailbox Creation wizard
and create a new target mailbox for this copy.
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Mailbox Creation Wizard ﬁ

Mailbox Copy Options

Copying multiple mailboxes to the target server. Flease select the desired behavior from
the copy options provided below.

Mo Match
Select the copy option for mailboxes that do not match any found on the target:
" Skip mailbox

* Create and copy to new mailbox

Partial Match

Select the copy option for mailboxes that partialty match. When a partial match is found
the target mailbox may not be for the same user as the source mailboe:

" Skip mailbox
"~ Copy to existing mailbox
(¢ Create and copy to new mailbox

Mesd = Cancel

b

Figure 2-24: Mailbox Copy Options page - Partial Match

Click Next.

If you selected the Create and copy to new mailbox option: Confirm the content of the User
Information page is correct or make any changes and click Next.

Confirm the content of the Mailbox Settings is correct or make any changes and click Finish
(or Next, if using Microsoft Exchange Server 2010 or later). The mailbox information is
validated.

Note: If the source mailbox does not have an alias (as is the case with Microsoff Exchange
Server2013), the UPN, userlogon name (pre-Windows 2000), and Alias are aufo-generated
based on the source mailbox name.

If you are using Microsoft Exchange Server 2010 or later, the Archive Settings page appears.
Select the Create an archive mailbox for this account fo associate an online archive
mailbox with the user account. To specify the mailbox database, select the check box
which enables the drop-down list of all available mailbox databases.
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Mailbox Creation Wizard ﬁ

Archive Settings

LUse this step to create an archive for the created mailbox. kems will be moved automaticalty
from the primary user mailbox to the archive based on the default retention policy settings of
the Microsoft Exchange Server.

I Create an archive mailbox for this account

-

| =)

< Back | Finish | Cancel |

Figure 2-25: Archive Settings for Microsoft Exchange Server 2010 and later

Note: If using Microsoft Exchange Server 2010 SP1 and later or Microsoft Exchange Server
2013, the mailbox database can be selected.

11. Click Finish. The mailbox is created and the copy proceeds. Progress information appearsin
a Report dialog box.

12. Click Print to print the report, Save to save the report to your hard drive, or Close to close the
Copy Progress window. The mailbox from the source EDB you copied is now a new mailbox
inthe Target pane.

To create multiple Microsoft Exchange Server mailboxes using copy and paste

1. Verify that Allow mailbox creation during copy opfion in Preferences is selected. For more
information, see "Target Options Tab".

2. Do one of the following:

= Right-click the EDB file root node in the source tree and click Copy. Then highlight the
target Microsoft Exchange Server and click Paste.

Note: If Paste is not available, you do not have accessrights to the source mailbox.

= Select the EDB file root node in the source tree and drag it to the Microsoft Exchange
Servernode in the target tree.
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The New Mailbox wizard opens the Mailbox Copy Options page, which allows you to
customize the behavior when copying all the mailboxes in the source EDB. Here you
configure the wizard to process the possible scenarios of no match, partial match, and
public folder mailboxes during the copy. While the likelihood of each scenario during the
copy is unknown, the Mailbox Copy Option page allows you to instruct the wizard how to
process each one if it occurs during the copy.

. Ifnomatchis found on the target for one the source mailboxes, choose one of the following
in No Match group:

® Select Skip Mailbox to skip the mailbox and not copy it. Mailboxes with no match
found during the copy are skipped.

= Select Create and copy to new mailbox fo create a target mailbox and copy foit.
Mailboxes with no match found during the copy have a new target mailbox created
and copied to that new target mailbox.

. Ifapartialmatch is found on the target for of the source mailboxes, choose one of the
following in Partial Match group:

m Select Skip Mailbox to skip the mailbox and not copy it. Mailboxes with a partial
match found during the copy are skipped.

m Select Copy to existing mailbox to copy the mailbox to the existing mailbox (no new
mailbox is created). Mailboxes with a partial match found during the copy are
copied to the partial matching mailbox.

= Select Create and copy to new mailbox to create a new target mailbox and copy to
the mailbox to that target. Mailboxes with a partial match found during the copy
have a new target mailbox created and copied to that new target mailbox.
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5.

7

Mailbox Creation Wizard ﬁ

Mailbox Copy Options

Copying multiple mailboxes to the target server. Flease select the desired behavior from
the copy options provided below.

Mo Match

Select the copy option for mailboxes that do not match any found on the target:
" Skip mailbox

* Create and copy to new mailbox

Partial Match

Select the copy option for mailboxes that partially match. When a partial match is found
the target mailbox may not be for the same user as the source mailboe:

* Skip mailbox
" Copy to existing mailbox

" Create and copy to new mailbox

Mesd = Cancel

b

Figure 2-26: Mailbox Copy Options page

If the source EDB originates from a Microsoft Exchange Server 2013 and later and the target

is connected to All Public Folders, choose one of the following in the Public Folder
Mailboxes group:

= Select Skip Mailbox to not copy the public folders contained in Public Folder
mailboxes found during the copy.

= Select Copy to public folders to copy the public folders in Public Folder mailboxes
found during to copy to the target's All Public Folders.
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Mailbox Creation Wizard ﬁ

Mailbox Copy Options

Copying multiple mailboxes to the target server. Flease select the desired behavior from
the copy options provided below.

Mo Match
Select the copy option for mailboxes that do not match any found on the target:
" Skip mailbox

* Create and copy to new mailbox

Partial Match

Select the copy option for mailboxes that partialty match. When a partial match is found
the target mailbox may not be for the same user as the source mailboe:

* Skip mailbox
" Copy to existing mailbox
" Create and copy to new mailbox

Public: Folder Mailboxes

Public folder mailboxes can be copied to the public folders on the target server. Flease
select the copy option:

* Skip mailbox

" Copy to public folders

Mesd = Cancel |

b

Figure 2-27: Mailbox Copy Options - Public Folder Mailboxes

6. Click Next.

If you selected Create and copy to a new mailboxin No Match or Partial Match, the
Mailbox Creation wizard proceeds. Otherwise, the copy begins.

Confirm the content of the User Information page is correct or make any changes and click
Next.

Note: Not all fields can be changed.

Confirm the content of the Mailbox Settings is correct or make any changes and click Next.

Note: When copying multiple mailboxes, the UPN, user logon name (pre-Windows 2000),
and Alias for new mailboxes are auto-generated based on the source mailbox. If the source
mailbox contains an alias (Microsoft Exchange Server 2010 and earlier) this is used. If the
source mailbox does not contain an alias (as is the case with Microsoft Exchange Server
2013), the source mailbox name is used (afterremoving any illegal characters).
Alternatively, a different type value can be used. By selecting the 'Alias base' check box,
these fields are set to an auto-generated value thatis a number appended fo the Alias
base (or just a numberif the Alias base is empty). If you choose, you can change the field
values on the New Mailbox Summary page for any mailbox being created as part of the

copy.
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r ™y
Mailbox Creation Wizard ﬁ

Mailbox Settings

Auto-populated fieldz are derived from the gource mailbos,

[~ Alias base [will be uzed to generate aliases automatically)
[ Specify the maibox database rather than using a database automatically selected:

| =
™ Managed folder mailbox policy:

| =

[~ Exchange ActiveSyne maibos policy:

| =]

<Back [ Fnsh | cancel |

Figure 2-28: Mailbox Settings (Microsoft Exchange Server 2010 and later) - Multiple copy

r ™y
Mailbox Creation Wizard ﬁ

Mailbox Settings

Auto-populated fieldz are derived from the gource mailbos,

[~ alias baze [will be uzed to generate aliases automatically)

Server:
IE2K?1

Storage group:
M ailbox databaze:

[~ Managed folder mailbox policy:

[~ Exchange ActiveSyne maibos policy:

Kl

El

Kl

Kl

<Back [ Fnsh | cancel |

Figure 2-29: Mailbox Settings (Microsoft Exchange Server 2007 and earlier) - Multiple copy



Note: If Managed folder mailbox policy is selected, a warning appears stating: "When
assigning a managed folder mailbox policy with managed custom folders to a mailbox,
Microsoft Office Outlook clients older than Microsoft Office Outlook 2007 do not have all
available client features and clients older than Microsoft Office Outlook 2003 SP2 are not
supported. Are you sure you want fo assign a managed folder mailbox policy to this
mailboxeg"

If you are using Microsoft Exchange Server 2010 or later, the Archive Settings page appears.
Select the Create an archive mailbox for this account fo associate an online archive
mailbox with the user account. To specify the mailbox database, select the check box
which enables the drop-down list of all available mailbox databases.

Mailbox Creation Wizard l-zhj

Archive Settings

LUse this step to create an archive for the created mailbox. kems will be moved automaticalty
from the primary user mailbox to the archive based on the default retention policy settings of
the Microsoft Exchange Server.

I Create an archive mailbox for this account

-

| =)

< Back | Finish | Cancel |

Figure 2-30: Archive Settings for Microsoft Exchange Server 2010 and later

Note: If using Microsoft Exchange Server 2010 SP1 and later or Microsoft Exchange Server
2013, the mailbox database can be selected.

Click Next. SEP sesam Recovery Pro analyzes the source and target selections to determine
the new mailboxes that will be created on the target. While performing this analysis, the
Identifying New Mailboxes page appears and displays progress information.

Note: If the 'Alias base' check box on the Mailbox Settings page is selected, the UPN, user
logon name, and Alias are auto-generated using the Alias base field value. Otherwise, the
values are set based on the source mailbox. This inifial auto-generated value can be
modified on the New Mailbox Summary page using the Edit Mailbox Item dialog box.

. When SEP sesam Recovery Pro finishes analyzing, the progress information clears and the

Mailbox Creation wizard displays the New Mailbox Summary page.
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12. Onthe New Mailbox Summary page, review the list of mailboxes to be created.

Mailbox Creation Wizard ﬁ

New Mailboxes Summary

Bazed on the zource and target selections thiz step lists the mailboxes that will be nevly
created on the target, Usge thiz step to review and optionally configure each new mailbos.
Uncheck any mailboxes you wish to zkip entirely.

| Source Mailbiox Narme | Target Uzer Name | U zer Principle Name | Alias |

John Johin Fred@domain.local  John
Brawn Browan browni@damain, local  Brown
[l Testlser TestUzerl Aliasl@domain,local - Aliasl

Check Al | Uncheck Al Edit [tem

v Feport file: |I::'\Mailbc-:< Creation Report. cvs

< Back | Finish | Cancel |

Figure 2-31: New Mailboxes Summary page

13. Ifyou want to edit a mailbox, do the following:
m Select the mailbox and click Edit Item or double-click the mailbox.

® Use the Edit Mailbox Item dialog box to make changes to any target information and
click OK to validate the new content.
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Edit Mailbox ltem

Source Mailbo:
Mame:

John

Target Information:
Firsk narne: Initials: Last name:

Mame:
|Juhn

Ilser logon name {User Principal Mame): IIPM SufFis:

| John |@|:Iu:umain.h:u:al ﬂ

Ilser logon name {pre-Windows 20000;
|Juhn

alias
| John|

K | Cancel

Figure 2-32: Edit Mailbox Item dialog box

m [fthe information you supply is not valid, an error message appears. Correct the issue
on the Edit Mailbox Item dialog box and click OK.

14. Onthe New Mailbox Summary page, clear the check box for any mailboxes you want to
skip entirely (do not create and copy). You can select or clear the entire list by clicking
Check All or Uncheck All.

15. Select Reportfile if you want to generate a CSV file listing the Source Mailbox Name, Target
User Name, User Principal Name, and Alias for each mailbox created during the copy.

16. Click Finish and the copy proceeds with progress information appearing in the Report
dialog box.

17. Click Print to send the report to a printer, Save to save the report to a hard drive, or Close to
close the Copy Progress window. Each mailbox from the source EDB you copied that did
not previously exist is now listed as a new mailboxin the Target pane.

Licensing Information

License information for the Microsoft Exchange Server database currently in use can be obtained
by right-clicking on the source root in the Source pane and selecting Save Licensing Information.

The file savesinto a text format and automatically names it "ServerProperties.txt."
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Chapter 3: Finding Messages

Overview

The Find in Source window letfs you search a source EDB, PST, or CAS file for message items that are
defined by such criteria as keywords, message senders and recipients, and message creation
dates. In addition, this window lets you define the scope of your search: an EDB, PST, or CAS file,
one or more mailboxes or folders (for example, Inbox), dates, or even previous search results.

The Find in Exchange Server Target window adds the ability to search alive Microsoft Exchange
Server target and perform actions on the search results.

Guidelines for Using the Find Window

The Find Now button only becomes available if af least one of the following conditions is
met:

* Afleast one Searchin check boxis selected.
* The Sent from or Sent to box contains at least one character.
* The Created Dated after or Created Dated before check boxis selected.

Each Search in check box that you selectis run as a separate query, and the results of the
query are combined (i.e., OR'd together). For example, if you enter "solution" in the Search
for words box, and then select the Message Subject and Message Body check boxes, SEP
sesam Recovery Pro will refurn message items that contain "solution” in either the message
subject or message body.

If you select one or more Search in check boxes, but specify no additional search criteriq,
SEP sesam Recovery Pro will return all of the message items in the folder(s) undergoing the
search.

SEP sesam Recovery Pro can search multiple information stores at the same fime. In the Find
in Source window, click Browse and you will see a tree view of all of the open source data
stores. You can then select multiple mailboxes or folders to include in your search.

SEP sesam Recovery Pro does not return duplicates of a message item during a search as
long as the "Check for duplicate messages during search" preference is selected. For
example, if the same message item exists in two or more data stores, only the first message
item found is listed in the search results.

The contents of aninaccessible EDB mailbox cannot be searched.

Messages in the Microsoft Exchange Server 2010 or later Recoverable ltems folder are
included in searchresults only if the Show Recoverable ltems preference is enabled. For
more information about setting preferences, see "Security Tab" .

If you use the "Mailbox Criteria (optional)" box on the Select Source Files dialog box or the
Source Selection page of the Data Wizard, only EDB mailboxes containing your entry (or
entries) are displayed on the Source pane. Any mailboxes that do not match the entered

73



string(s) do not appearin the Source pane and are not be included in any subsequent tasks
(such as searching, copying, and exporting of the entire database). For more information,
see "Mailbox Criteria".

= |fyou use the "Multi-Tenancy Criteria" box on the Select Source Files dialog box, the Source
Selection page of the Data Wizard, the Connect to Exchange Server dialog box, or the
Target Selection page of the Data Wizard, only mailboxes contained in the selected
Address Book Policy or Organization appearin the Source or Target panes. Only these
mailboxes are included in any subsequent tasks (such as searching, copying, and exporting
of the entire database). For more information, see "Multi-Tenancy Support".

Searching Sources

The Find in source window provides the ability fo search single or multiple mailboxes and perform
actions on the search results.

Tip: CAS and PST files are searchable in the Source pane but notin the Target pane.

The actions allowed to perform on search results are copying or exporting message items,
performing Integrity Checks, and viewing message items using the Message Views options. You
can have several Find in Source windows open at a tfime.

To search for message items in sources

1. Inthe Source pane, select the folder (for example, EDB or PST file, mailbox, Inbox) you want
to search. The folder(s) you select defines the scope of your search.

2. Do one of the following:
« Click Find in the toolbar to display the Find in Source window. The name of the folder
you selected appears next to the Search in folder box.
* Right-click the file and click Find.
¢ On the Tools menu, click Find.
e PressF3

Note: The first time you search for a message item, the Search in folder option is
automatically selected. Forinformation on using the Search in results option, see "Searching
Within Results".

3. Tosearch multiple mailboxes or folders, click Browse. In the Select Folder(s) window, select
the items you want to search. In the illustration below, two folders have been selected.
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6.

I

A4 Select Folders) [rvem|

- ’{@ Source 1 - mwbard T
G calendar Cancel
[FICEl Contacts
(7 Deleted Items Al
DD Drafts

¥ % Inbaox
O Journal
03 Junk E-mail
0L Motes -

L | (L] 3

m

W Search Subfolders 1 iterns selected

Figure 3-1: You can select multiple folders or mailboxes fo search.

Note: If you select the Search Subfolders check box, SEP sesam Recovery Pro includes
subfoldersin the search.

4. Click OK toreturnto the Find in Source window.

In the Search for words box, enter one or more words or phrases if you want to execute a
keyword search. Keep in mind the following poinfts:
» Putaspace between words or phrases to perform an AND operation (i.e., all words must
be matched in order to include a message item with the search results).
» Putacomma between words or phrases to perform an OR operation (i.e., only one of
the words must be matched in order to include a message item with the search results).
e Put guotation marks around word phrases (i.e., the exact phrase must be matchedin
order to include a message item with the search results).

Example: Search for words: dog cat mouse, rat

Searchresults: Message items that contain ["dog" AND "cat" AND "mouse"] OR ["rat"]
are included in the search results.

In the Exclude words box, enter words or phrases if you want to perform a NOT operation. If
matched, these words or phrases will exclude a message item from the search results. The
rules for using spaces, commas, and quotation marks apply when excluding words from a

search.
Example: Search for words: dog cat mouse, rat

Exclude words: bird
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7.

Searchresults: Message items that contain ['dog" AND "cat" AND "mouse"] OR ['rat"]
BUT NOT ["bird"] are included in the search results.

For Search in, select one or more of the following check boxes: Message Subject, Message
Body, Atachment File Name(s), or Atachment Text. Each Search in check box that you
selectisrun as a separate query, and the results of the query are combined (i.e., OR'd
together).

Note: SEP sesam Recovery Pro has the ability to search multiple levels of embedded
message items. Select Attachment Text in the Select in check box. See "Searching
Embedded Message Items" for more information.

Note about searching within attachments: SEP sesam Recovery Pro does not search within
archive file types (such as .zip or.rar files). For more information, see "Searching Within
Attachments".

In the Sent from and Sent to boxes, enter the appropriate names, if desired. Using the Sent to
box is particularly useful if you are trying to find a message item sent to multiple people. The
rules for using spaces, commas, and quotation marks apply when using the Sent from and
Sent to boxes.

For Date, select an action performed on the document (such as Received, Sent, or Due) as
a search criteria, if desired. This searches for documents based on when that action
occurred.

For After and Before, select the appropriate check box, if desired. You may select both
check boxes. Then type or select the part of the date you want to change.

« After: Searches for documents created on or after the selected date.
» Before: Searches fordocuments created on or before the selected date.

. When you have finished specifying search criteria, click Find Now. The results of your search

appearin the message item list. In Search Results column, the Date displays the time of the
action selectedin the Time search criteria.

To preview the message items returned by the search, click the Preview check box.
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r) Find in Source EI@
File Edit Tools
o Search infolder: |Source 1 Browse...
(" Search in results:
Search for words: |
Exclude words: | copy Clear Fields
Clear Results
Search in: [¥ Message Subject [ Attachment File Name(s)
[ Message Body [~ Attachment Text Help
Sent frorm: | j’:)
Sentto: |
[~ Preview
Drate: |Created j [~ After:| 2{18/2015 [~ Before:| 2f1G[2015 Save Report...
Results
0 | 1] | Frorn |T|:| | Subject | Create Date | Source # | Folder | S
k4 YicePresident, ... Director, Darla Widget 3000 Thu 11/02/200.., 1 Mailbox Store....
4 YiceFresident, ... Directar, Datla Widget 3000 Ki.., Thu 11027200, 1 ttailbox Stare....,
[ | YicePresident, ... Directar, Darla Widget 3000 Ki... Thu 115027200, 1 Mailbox Store.,.,
B VicePresident, .. President, Patri.. Widgetthroug.. Sat 11/04/2006.. 1 Mailbox Store....
1| 1l [
Search Complete - 4 Message Iternis) Matched Criteria

Figure 3-2: Find window with results and message pane

Searching Embedded Message Items

You can search mulfiple levels of embedded message items in SEP sesam Recovery Pro.

Note: Searching attachments (email and non-email) is available only when the Agent for
Advanced Searching for Microsoft Exchange Serveris enabled.

To search embedded message items

1. Performsteps 1 through 6 in "Searching Sources".
2. ForSearchin, click Atachment Text.
3. Confinue with step 8in the "Searching Sources" process.

Searching Within Results

The Search inresults option lets you refine the search process using the previous search results.



To search within results

To make the Search in results option available, you must perform atf least one search.

2. Modify the search criteria as desired. For information on specifying search criteria, see
"Searching Sources".

3. Select the Search in results option at the top left of the Find in Source window.
Click Find Now. The results of your new search appear in the message item list.
5. To preview the message itemsreturned by the search, click the Preview check box.

)-) Find in Source E\@

File Edit Tools

(* Search in folder: |Snurce 1 Browse... Find Mow

" Search in results:

Search for words: | agreerment Previous

Exclude words: | Clear Fields

Clear Results

R1 11}

Search in: [¥ Message Subject [ Attachment File Mame(s)
[~ Message Bady [ Attachrment Text

Sentfrorm: |

Sent to: |

<]
h
o
=
T
i

Diate: |Created j ™ After:| 2112015 [~ Before:| 2{11{2015 Save Report...

L

Results
] | ] | Frorm | Tao | Subject | Create Date | Source # | Folder -
[ Lawyer, Larry Froductmanag.. License agree..  ‘Wed 11/15/200.. 1 Mailbox Store... =
— Ak : = Sl = -
From: Lawyer, Larry To: P!roduclmanager, -
Paul
Subject: License agreement -

I've taken a look at the license agreement for the new product arrangment with the partner
in the KM channel. My concern, and that of the board will probably be that we get some
value for the grant of exclusivity, and that we protect our intellectual property.

Larry

Search Complete - 4 Message Itemis) Matched Criteria

Figure 3-3: Checking the Preview option adds a message Preview pane

You can click the Previous button multiple fimes to return to any previous search criteria and
searchresults. This button becomes unavailable when there are no more previous results.



To view previous search results

1. Perform atleast two searches so the Previous button becomes available.
2. Click Previous. The results of the previous search appearin the in the message item list.

3. You can now view the previous search, or you can modify the search criteria and conduct
anew search. Forinformation on specifying search criteria, see "Searching Sources".

If you click the Clear Fields button, all of the search criteria that you entered in the Find in Source
window are refurned to the default settings. If you click the Clear Results button, all current and
past search results are cleared.

Searching Microsoft Exchange Server Target

You cansearch alive Microsoft Exchange Server target and delete, move, copy, or export the
search results. This means you can search and delete, or move specific message items from a
Microsoft Exchange Server target. You can have only one search session Find in Exchange Target
window open at one time.

Note: Only accessible mailboxes and public folders of the Microsoft Exchange Server can be
searched.

Tip: CAS and PST files are not searchable in the Target pane but are searchable in the source
pane.

To search a Microsoft Exchange Server target

1. Do one of the following to display the Find in Exchange Target window:
¢ Right-click the valid objectin the Target pane and click Find.
¢ OntheTools menu, click Find.

* Onthetoolbar, click the Find icon IO

e PressF3.
2. Conductsearch as described in "Searching Sources".

Tip: Microsoft Exchange Server target search results can have an Integrity Check performed
either by right-clicking the message or clicking Integrity Check in the Tools menu.

Managing Message Items

Once you have performed a target search, several functions are available on the search results
including cut, move, export, copy, and delete.
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Moving message items from the search results to another folder within the target directory
removes the message items from the original location. You can move message items by using the
Move To Folder function, or by dragging to the destination folder.

Move to Folder

SEP sesam Recovery Pro presents you with a Move To Folder option and a corresponding Move
lfems destination selection window.

Note: Message items cannot be moved to a Content Analysis Store (CAS).
To move to folder using Move To Folder

1. Do one of the following to display the Move ltems window:
* Right-click the message item(s) in the search results and click Move To Folder.
* Onthe Edit menu, click Move To Folder.
2. Selectafolder as the destination and click OK. The Copy Progress window appears.

3. Select Print to print the progress report, Save to save the progress report to your hard drive,
or Close to close the window.

Dragging a Message

Dragging a Find in Target search result list has a "Move" option. This option behavesin the same
manner as the Move to Folder function or cut and paste.

To drag to a folder

1. Right-click the message item in the search results and drag to a mailboxin the Target pane.

2. Atthe destination mailbox, a shortcut menu appears with the options of Paste, Move, Paste
Special, or Cancel. Select one and the Copy Progress window appears.

3. Click Print to print the progress report, Save to save the progress report to your hard drive, or
Close to close the window.

You can copy message items to Microsoft Exchange Server and PST file targets. Only valid targets
are displayed in the Copy ltems window.

Copy to Folder

SEP sesam Recovery Pro presents you with a Copy To Folder option which copies the item and
keeps itinits originallocation to be pasted in a designated location.
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To copy to folder

1. Onthe Edit menu, click Copy To Folder. The Copy Items window appears.

2. Select afolder as the destination and click OK. The message itemis now copied and pasted
to the designated location.

3. Inthe Copy Progress window, click Print to print the progress report, Save to save the
progress report to your hard drive, or Close o close the window.

The target search results has two new actions, cutting message items and deleting message items,
which are only available in the target search results window.

Cutting Message ltems
Cutting a message item moves the item from the original location to a given target.
Deleting Message ltems

Deleting a message itemin the search results works in a similar manner as deleting message items
from the main target list. When you delete message items from the search results list, they are also
deleted from the main target list if the same message item is currently displayed.

Note: You cannot delete message items from the main target list if the Find in Exchange Target
dialogis open.

Saving and Using Search Profiles

SEP sesam Recovery Pro allows you to save search criteria to a text file for the purpose of using the
search criteriain future searches. There are two menu commands that allow you to perform these
functions: "Save Criteria" and "Use Previous Criteria." In addition, if you want to modify the search
criteriain a search profile, you can edit the text file with a text editor.

When creating a search profile, you can save the following search criteria. The "Search For,"
"Exclude Words,""Sent from," and "Sent to" fields have a maximum of 4,095 characters.

= Search for words

= Exclude words

= Searchin

= Sentfrom

= Sentto

= Created Dated after
= Created Dated before

Note: The saved criteria of a content analysis store profile folder can be used for a search.

Conversely, the saved criteria for a search can be used to create a content analysis store profile
folder. For more information on content analysis stores, see "Content Analysis Store".
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To create a search profile

Open the Find in Source window, and enter search criteria.
On the File menu in the Find in Source window, click Save Criteria.
In the Save As window, specify a name and location for the search profile text file.

Moo bd -

Click Save.

To edit a search profile

1. Locate and open the search profile that you want to edit.
2. Modify the search criteria as desired and save the text file.

To use a search profile when performing a search

1. Open the Find in Source window.
2. Onthe File menu in the Find in Source window, click Use Previous Criteria.

3. Inthe Open window, locate and open the search profile that you want to use for your
search.

4. Click Open.The Find in Source window is populated with the search criteria specified in the
search profile.

Using Multiple Search Windows

SEP sesam Recovery Pro allows you to open multiple instances of the Find in Source window to
search any combination of information stores at the same time. There is no limit other than system
resources for the number of concurrent searches you can initiate.

When searching on a live Microsoft Exchange Server target, you are able to have only one
instance of a search session Find in Exchange target window atf one time.

Note: If you are using multiple instances of the Find in Source window to search within the same
mailbox, you may nofice a slowdown in performance.

Searching Within Attachments

In both the Find in Source and Find in Exchange Target windows, you can search the text of email
attachments. The Searching within Attachments feature supports Unicode text and is available for
EDB, PST, CAS sources, and Microsoft Exchange Server targets. SEP sesam Recovery Pro supports
Microsoft Office documents and many other popular file types.

Note about the licensing agent: The "Agent for Advanced Searching" must be enabled in order to
search attachments. For more information, see "Enabling the Licensed Agents"in the Readme file.
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Search for words: |

Exclude words: | Clear Fields
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[ Message Bady v Attachment Text Help

Sentfrom: |

vl LR LR g

Sentto: |
[~ Preview

Drate: |Created j [ After:| 271272015 [~ Befare:| Z/12/2015 I

|

Ready

Figure 3-4: Select the Attachment Text option to include in your search
To search within altachments

1. Inthe Find in Source or Find in Exchange Target window, select the Aitachment Text check
box.

2. Specify other desired search criteria. For more information, see "Searching Sources".

3. Click Find Now. If SEP sesam Recovery Pro matches a keyword or phrase in the text of the
aftachment, it willreturn a "Hit" just as it would if it found a keyword or phrase in the body or
subject of a message item.

Exceptions When Searching Within Attachments

SEP sesam Recovery Pro does not search for the following items:

m Archive files (forexample, .zip, .rar)
= Binary files (for example, .dll, .exe, .jpg)
= Metadata associated with files (for example, author and company informationin an .xs file)

Other SEP sesam Recovery Pro Features
Available Through the Find Window

In addition to the search features described in the previous sections, there are several SEP sesam
Recovery Pro features available through the Find window.
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Opening and Saving Attachments in the Find Window

To open an attachment's file type in the Find window, you must have an application installed on
your computer that can perform this function. If no associated program is available for the
attachment file type, SEP sesam Recovery Pro presents a message window saying the attachment
cannoft be viewed.

Forinstructions on opening and saving attachments, see "Opening Aftachments" and "Saving
Attachments".

Exporting Message Items from the Find Window

The Export feature allows you to copy individual message items from the Find window to alocal or
network drive destination. You can choose to save exported message items as plain text files (.ixt),
Microsoft Office Outlook files (.msg), or Outlook Data files (.pst). For more information, see
"Exporting Messages".

To export message items from the Find window

In the Find in Source or Find in Exchange Target window, perform a search.
In the Results area, select the message items you want to export.
On the Tools menu in the Find in Source or Find in Exchange Target window, click Export.

Moo bd -

In the Export window, specify options and click Export. For more information on the export
options, see "Exporting Messages".

Restoring Message Items from the Find Window

The results of conducting a search appearin the message item list in the Find window. You can
restore the message items in this list by dragging them or copying and pasting them into the target
folder. If you want to maintain the directory structure of restored individual message items, use the
Paste Special command.

You can also restore message items by browsing in the main window and dragging or copying
and pasting from the main window fo the target. You do not need to search to restore message
items. For more information, see "Restoring Microsoft Exchange Server Data".

Performing an Integrity Check on Message Items in the Find
in Source Window

The Find in Source window allows you to perform an integrity check on one or more message items
in the Results area. During the integrity check, SEP sesam Recovery Pro verifies that it canread all
of the properties of the message items.

Note: Only accessible mailboxes can have an Integrity Check performed.
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To perform an integrity check on message items in the Find in Source window

1. Inthe Find in Source window, perform a search.

2. Inthe Results areq, select the message items for which you want to perform an integrity
check.

3. Onthe Tools menu in the Find in Source window, click Integrity Check. The Integrity Check
window appears.

Search Results Report

You cansave a text-based report of the search results to yourlocal drive without having to copy or
export any of the search results. The search results report is saved into a file that includes the
search criteria, date/time the search was started, and a report of message items that matches the
criteria.

Save Report

You cansave the search results report once a search has been performed and either completed
or stopped.

The Save Report button creates two text-based reports. One report contains a search session
summary (Summary Report) and the otherreport contains search session message item results
(Message Report).

The information included in the Summary report is the search session details and the user-defined
search criteria for the search.

The information included in the Message report is based on the column headings in the search
results, message type, attachments, From and To, etc.

To save the report

1. After conducting the search, click Save Report. The Browse For Folder window appears.

2. Select the destination for the report and click OK. The search results reports creates both a
Message Report and a Summary Report, and are saved on your hard drive in a .ixt format.
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Figure 3-5: Summary and Messages Reports

The files are named using the date of the search and a suffix indicating the type of report.
Forexample, if you run asearch on 5/8/2007, the report names are:
SearchResults_20070508_Summary.txt for the summary report, or
SearchResults_20070508_Messages.ixt for the message report.

For cases where you choose to create more than one set of reports on the same date, files
are named using an incremental numbering convention starting with "1." If you run a
second search on 5/8/2007, the report names are:
SearchResults_20070508(1)_Summary.txt for the summary report, or
SearchResults_20070508(1)_Messages.txt for the message report.

3. Clicking Cancel during the report generation progress terminates the process and any
reports created for this Save Report action are deleted from the report destination.

The text summary or message report is tab delimited and can be imported intfo a spreadsheet if
desired. Simply drag the .txt file from its location into a blank spreadsheet. The source # in the
searchresultsis replaced with the full path fo its location in the report.



Chapter 4: Exporting Messages

Overview

You can export mail from an EDB, PST, or CAS source file or live target Microsoft Exchange Server to
alocal or network drive destination. Exported messages can be saved as Microsoft Office Outlook
files (.msg), saved as plain text files (.txt), or become contents of a PST file. This can assist you in
copying old email backupsinto an alternate or non-email system. You can export at all levels
(mailbox, folder, and individual messages) for the corresponding file type.

You can export at alllevels: an EDB file, a PST file, a CAS file, a CAS profile folder, a mailbox, a folder,
and individual messages.

You can also export forms from an organizational forms library in a public folder EDB or source
public folder mailbox. These exported files can be saved as Microsoft Office Outlook forms (.oft).

General Information about Exporting Messages

® When saving exported message items as plain text files (.txt) or Microsoft Office Outlook files
(.msg), the file name for an exported message is its subject. The file name for an exported
organizational formis the form's name. When saving exported message items to Outlook
Datafiles (.pst), the file name is either based on the name of the mailbox or set by the user
depending on the level of the source being exported. A duplicate file name will create afile
with the same name but with an (x) appended to the flename: x =1 for the first duplicate, x =
2 for the next duplicate, and so on. If the subject or form name contains illegal file name
characters, each offending character will be replaced with an underscore.

= Associated messages and folder properties will not be exported.

= When exporting individual messages, you have the option to keep the folder/mailbox
hierarchy, similar to the paste special feature. When exporting a mailbox or folder, you have
the option to also export the subfolders.

= Messages in the Microsoft Exchange Server 2010 and later Recoverable Items folders can be
exported if the Show Recoverable Items preference is enabled.

® When exporting the Recoverable Items folder, it is renamed to distinguish the copied version
from the actual version. The folder is renamed using the localized short date in parenthesis
and appended to the folder name. Example: "Recoverable ltems (1/22/2009)"

= |fyou use the "Mailbox Criteria (optional)" box on the Source Selection page of the Data
Wizard, only EDB mailboxes containing your entry (or entries) are displayed on the Source
pane. Any mailboxes that do not match the entered string(s) do not appearin the Source
pane and are not be included in any subsequent tasks (such as searching, copying, and
exporting of the entire database). For more information, see "Mailbox Criteria".

= |fyou use the "Multi-Tenancy Criteria" box on the Source Selection page of the Data Wizard,
the Connect to Exchange Server dialog box, or the Target Selection page of the Data
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Wizard, only mailboxes contained in the selected Address Book Policy or Organization
appearin the Source or Target panes. Only these mailboxes are included in any subsequent
tasks (such as searching, copying, and exporting of the entire database). For more
information, see "Multi-Tenancy Support".

About Message (.msg), Text (.txt), and PST
Export

The file type for an exported message can be either Microsoft Office Outlook (.msg) or plain text
(.txt) or PST.

Message (.msg) export

A .msg file (OLE compound document) can be imported directly into Microsoft Office Outlook.
This file type encapsulates the entire message including attachments.

Text (.txt) export

A .ixt file is created with the following information. Note that neither message attachments nor
message properties are exported.

PST export

The Export to PST option allows you to generate PST files at all levels of the following:

Off-line private store EDB files

Off-line public store EDB files (Microsoft Exchange Server 2010 and earlier)
CAS files
PST files

You can also export to PST files from a target and source Find window. For more information, see
"Exporting to PST".

Exporting Messages

You can export an EDB file, a source PST file, a source CAS file, a source CAS profile folder,
mailboxes, folders, messages, and a live Microsoft Exchange Server target.

Note: Only accessible mailbox items can be exported. If you are exporting a CAS file, only
accessible mailboxes are included in the export.

The section explains how to perform the following export tasks from the SEP sesam Recovery Pro
main window:

= "To export an entire source private EDB file, mailbox, or PST file"
= "To export a source PST folder, afolder, a CAS file, a profile CAS folder, or a public EDB file"
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= "To export a mailbox or a folder from a Microsoft Exchange Server target"
= "To export individual source or target messages”
= "To export individual messages from the Find window to a TXT or MSG file"

To export an entire source private EDB file, mailbox, or PST file

1. Inthe Source pane, select the root of the EDB file, mailbox, or PST file.
2. Do one of the following:
= OntheTools menu, click Export.

On the toolbar, click the Exporticon é .

= Right-click the EDB file, and on the shortcut menu, click Export. The Export EDB, or
Export Mailbox window appears.

Export Mailboxes

Salected mallboxes: ISoutc: 1 = Test.edb) Administrator Browse

Format Options

PST - ¥ Export Subfolders
Cancel
(_
Help
o :

[ Filer By

Export to File

| C:\Users j

Figure 4-1: PST, MSG, or TXT format can be selected for export

3. Ifyou want to export multiple objects (mailboxes, PST files), click Browse and in the Selected
Mailboxes dialog box, select the mailbox or PST file you want to export, then click Ok. (You
can select more than one).

4. Inthe Format box, select PST, MSG, or TXT. If you selected PST, Export resulits to multiple PSTs is
selected by default.

5. Ifyouwant to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter By and do the following:

= |nthe Date box, select an action performed on the document.

= For After and Before, select the appropriate check box, if desired. You may select
both check boxes. Then type or select the part of the date you want to change. After
searches fordocuments created on or after the selected date. Before searches for
documents created on or before the selected date.

6. Inthe Export to Folder or Export to File box, specify the location of the exported EDB file.
7. Click Export.
8. Inthe Export Progress window, verify the EDB file was successfully exported, and click Close.
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To export a source PST folder, a folder, a CAS file, a profile CAS folder, or a public EDB file
1. Inthe Source pane, select a PST folder, a folder, a CAS file, a profile CAS folder, or a public
EDB file root.
2. Do one of the following:

= Onthe Tools menu, click Export.

On the toolbar, click the Exporticon é .

m Right-click a PST folder, a folder, a CAS file, a profile CAS folder, or a public EDB root,

and on the shortcut menu, click Export. The Export EDB, Export Folder, or Export CAS
window appears.

Export Folder
Selected item(s); |5n:nurn:e 1 - Mailbox Database 0130876695 edb’ Admini:
Format: Cptions: Export
PST - [+ ExportSubfolders
Cancel
~ -_—
Help
{+ —_—
[ Filter By:
|Created ~|F 272012 ~| @ 11/30/2012
Export to File:

| C:\ Temp' Folder.pst j

Figure 4-2: Export Folders window

3. Inthe Format box, select PST, MSG, or TXT.
4. Inthe Export to File or Export to Folder box, do one of the following:

® |fyou selected the PST format, enter the name of the resulting PST file. If you are

exporting a mailbox, the name of the PST file defaults to the name of mailbox (which
can be modified).

= |fyou selected the MSG or TXT format, enter the location of the exported mailbox,
folder, or public EDB file.

5. Select the Export Subfolders check box if you want to export all of the subfolders for the
selected mailbox or folder.

Note: This option is selected automatically when exporting the EDB public root.
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6. If youwant to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter By and do the following:

= |nthe Date box, select an action performed on the document.

= For After and Before, select the appropriate check box, if desired. You may select
both check boxes. Then type orselect the part of the date you want to change. After
searches for documents created on or after the selected date. Before searches for
documents created on or before the selected date.

7. Click Export.

8. Inthe Export Progress window, verify the mailbox or folder was successfully exported, and
click Close. The mailbox or folder appears in the specified location. For PSTs, the exported
mailbox or folderis included in the PST file.

To export a mailbox or a folder from a Microsoft Exchange Server target

1. Inthe Target pane, select a PST file, a mailbox or a profile CAS folder, or the public EDB file
root.

2. Do one of the following:
= OntheTools menu, click Export.

On the toolbar, click the Exporticon é .

® Right-click the mailbox, folder, or public EDB root, and on the shortcut menu, click
Export. The Export Mailbox or Export Folder window appears.

Export Mailboxes

Selected itemi(s): | Target 1 - pcexch2(] baex’ arya.stark@stark.local
Format: Options: Export
PST - [ ExportSubfalders
Cancel
Help
[ Filter By:

|Created | F 1172772002 ~| P 11/30/2012
Export to Folder:

| i\ temp) VerifyEX201 6ExportToPst), j

Figure 4-3: Export Mailboxes window
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3. Inthe Format box, select PST, MSG, or TXT.
4. Inthe Export to File or Export to Folder box, do one of the following:

® |fyou selected the PST format, enter the name of the resulting PST file. If you are
exporting a mailbox, the name of the PST file defaults to the name of mailbox (which
can be modified).

® |fyou selected the MSG or TXT format, enter the location of the exported mailbox,
folder, or public EDB file.

5. Select the Export Subfolders check box if you want to export all of the subfolders for the
selected mailbox or folder.

Note: This option is selected automatically when exporting the EDB public root.
6. If youwanttolimit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter By and do the following:
= |nthe Date box, select an action performed on the document.

= For After and Before, select the appropriate check box, if desired. You may select
both check boxes. Then type or select the part of the date you want to change. After
searches fordocuments created on or after the selected date. Before searches for
documents created on or before the selected date.

7. Click Export.

8. Inthe Export Progress window, verify the mailbox or folder was successfully exported, and
click Close. The mailbox or folder appears in the specified location. For PSTs, the exported
mailbox or folderis included in the PST file.

To export individual source or target messages

1. Inthe Source orTarget pane, select one or more messages from the message list.
2. Do one of the following:
= OntheTools menu, click Export.

On the toolbar, click the Exporticon é .

= Right-click the selection, and on the shortcut menu, click Export. The Export Messages
dialog box appears.
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Export Messages

Selected itemi(s): | Target 1 - pcexch20] 6aexarya stark@stark local

Format: Options: Export
- [« Maintain Message Path
Cancel
Help

[~ Filter By:
ICreated J v

Export to Folder:

Il:: temp VerifyEX201 6ExportToPst j

Figure 4-4: PST, MSG, or TXT format can be exported

. Inthe Format box, select PST, MSG or TXT.

. Select the Maintain Message Path option if you want to maintain the directory structure of
the exported messages.

. Ifyou are exporting message from the Source pane to PST, you can also select Skip mailbox
folder to merge the exported message into the resulting PST without maintaining the
mailbox folder.

. Ifyou want to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter By and do the following:

= |nthe Date box, select an action performed on the document.

= For After and Before, select the appropriate check box, if desired. You may select
both check boxes. Then type orselect the part of the date you want to change. After
searches fordocuments created on or after the selected date. Before searches for
documents created on or before the selected date.

. Inthe Export to File or Export to Folder box, do one of the following:

® |fyou selected the PST format, enter the name of the resulting PST file.

® |fyou selected the MSG or TXT format, enter the location of the exported mailbox,
folder, or public EDB file.

8. Click Export.

. Inthe Export Progress window, verify the mailbox or folder was successfully exported, and
click Close. The messages appearin the specified location. For PSTs, the exported mailbox
or folderisincluded in the PSTfile.
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To export individual messages from the Find window to a TXT or MSG file

1. Inthe Find in Source or Find in Exchange Target window, select one or more messages from

the message list.
2. Right-click the selection, and on the shortcut menu, click Export.
3. Inthe Format box, select MSG or TXT.

Export Messages

Selected item(s): |TargEt 1 - pcexch201baexarya.stark&stark local

Format: Options: Export

MSC - [w Maintain Message Path
Cancel

Help

[~ Filter By:
| created ~|F 11/27/2012 7

Export to Folder:

l c:\temp

Figure 4-5: Exporting the MSG or TXT format

4. If you want to maintain the directory structure of the exported messages, select the
Maintain Message Path option.

(6]

. Ifyou want to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter By and do the following:

= |nthe Date box, select an action performed on the document.
= For After and Before, select the appropriate check box, if desired. You may select

both check boxes. Then type or select the part of the date you want to change. After

searches for documents created on or after the selected date. Before searches for
documents created on or before the selected date.

o

In the Export To Folder box, specify the location for the exported messages.

N

Click Export.

©

In the Export Progress window, verify your messages were successfully exported, and click
Close. The messages appear in the specified location.

Exporting to PST

You can export to a PST file from the Source and Target panes, the Source and Target Message
lists, and the Source and Target Find windows.
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When exporting to PST from the Source Pane, follow the instructions To export individual source or

target messages in "Exporting Messages”.

In the Export to File or Export to Folder box, enter the name of the resulting PST file. The exported

mailbox or folderis included in the PST file.

Export EDB

Selacted mailboxes: | Multiple Sources Selected

Farmat: Options:
PST - v
e
~
[~ Filter By:
|created ~| 2/28/2018

Export to Folder:

P

Pl

ddi

Export
Cancel

Help

=2
P
[a=]
(2]

|C:'_Users

S | B

Figure 4-6: Exporting to PST from the Source Pane

When exporting to PST from the Target Pane, follow the instructions To export a mailbox or a folder

from a Microsoft Exchange Server target in "Exporting Messages".

If you want to export all of the subfolders for the selected mailoox or folder, select the Export

Subfolders check box

Note: You can only export a single mailbox on the target, not multiple mailboxes.

In the Export to File or Export to Folder box, enter the name of the resulting PST file. The exported
mailbox or folderis included in the PST file.
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Export Mailboxes

Salacted mailboxes: ISﬂ-urce 1 - Test.edb! Administrator

Browse. ..

Format: Options:
PST - [+ ExportSubfolders
Cancel
{" Export results to multiple PSTs
Help
{* Exportresults to single PST
[~ Filter By:
Date: [Created -] I_After:| 2/28/2018 ~| |_Eef|:re:| 2/28/2018 ~|
Export to File:
IC:"lUsers j |

Figure 4-7: Exporting to PST from the Target Pane

Exporting to PST from the Message List

When exporting messages from the Message List view, you can use the Skip Mailbox Folder option

on the Export dialog box to merge the exported message into the resulting PST without

maintaining the mailbox folder.

Export Messages
Selected mailboxes: I Multiple Sources Selected Browse. .
Farmat: Options: Export
pST - [+ Maintain Message Path

Cancel

{~ Ezport results to multiple P3Ts I Skip Mailbox Folder

Help
{* Ezport results to single FST

[~ Filter By:

| bl

Date: |Created x| T oafer| 2/28/2018 ~| I Before:| 22812018 ~

Export to File:

IC:'\Users j |

Figure 4-8: Exporting to PST from the Message List
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The following two options are available when exporting to PST from the Find window.

= Export results to multiple PSTs: If selected, search results are exported based on which
mailbox or CAS profile folder they were originally stored in. One PST will be created for every
mailbox and CAS profile folder. If Maintain Message Path is also selected, the directory
structure of the exported messages inside PSTis maintained. In such cases, PST files receive
the name of the respective mailbox or CAS profile folder in which the messages were found.
Exported public EDB files are named "All Public Folders.pst."

= Export results to single PST: If selected, search results are exported to a single PST. If Maintain
Message Pathis also selected, the directory structure of the exported messages inside PST s
maintained. If Merge Mailboxes is selected, results are exported to a single PST file with alll

the standard PST folders. With Export results to a single PST, you can choose a name for a PST
file.

To export individual messages from the Find window to a PST file
1. Inthe Find in Source or Find in Exchange Target window, select one or more messages from
the message list.

2. Right-click the selection, and on the shortcut menu, click Export.
3. Inthe Format box, select PST.

Export Messages
Salacted majlboxes: | Multiple S5ources 5elected
Format: Options: Export
m = v Maintain Message Path
Cancel
(" Ewxpart results to multiple PSTs [ Merge Mailboxes =
elp
(* Ewmport results to single PST
| Filter By:
|Created ~| & 1/ 1/2000 | [ 12/20/2013
Export to File:
| C:\Users j

Figure 4-9: Exporting the PST format

4. Inthe Export to File box, specify the location for the exported messages.
5. Do one of the following:
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= To export all of the selected messages to one PST, choose Export results to single PST.
® To export messages from different mailboxes, CAS profiles, or public foldersin
respectively named separate PST files, choose Export results to multiple PSTs.
If you want to maintain the directory structure of the exported messages, select the
Maintain Message Path option.

If you selected Export results to single PST you can choose Merge Mailboxes. This option
removes the mailbox level from the directory structure of the exported messages. For more
information, see the Scenarios section that follows.

If you want to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter By and do the following:
= |nthe Date box, select an action performed on the document.
= For After and Before, select the appropriate check box, if desired. You may select
both check boxes. Then type orselect the part of the date you want to change. After

searches for documents created on or after the selected date. Before searches for
documents created on or before the selected date.

Click Export.

In the Export Progress window, verify your messages were successfully exported, and click
Close.

When exporting message from the Source pane, you can also use the Skip Mailbox Folder option
on the Export dialog box. This option merges the exported message into the resulting PST without
maintaining the mailbox folder.

Note: Before exporting to PST, ensure that you have sufficient disk space available at the
destination of the PST export.

Scenarios for exporting multiple mailboxes from the Find Window to a single PST

Scenario 1

A folder with the mailbox name for every mailbox in which messages are found is created in the
new PST. The message path is maintained, even if the higher level folder does not contain
messages. The PSTname is created by the user.
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___Mailboxbecomesfolder—__ Export.PST
_— i —
- = Mailbox 1
- —| Folderl
— Folder 1 Message 3 ’ \ L
Message 1
L Maintain Message Path [
Message 1 Merge Mailboxes (m |y

/ ~— Message 2

| [CEESH ~— Mailbox 2

Structure before export L
Message 3
Structure after export

Figure 4-10: Scenario 1

Scenario 2

Folders in which messages are found are created in the resulting PST. The message pathis
maintained from the root level (even if the higher level folder does not include messages). Mailbox
names are removed. If the folder already exists, the messages found in a different folder with the
same name and at the same hierarchy level are placed in the existing folder in the resulting PST.
The PSTname is created by the user.

Export.PST
Mailbox 1 Mailbox 2
t — Folderl
— Folder1 Message 3 t Message 1
t Maintain Message Path _

Message 1 Merge Mailboxes v | Message?2

~—— Message 2 ~—— Message 3
Structure before export
Structure after export

Figure 4-11: Scenario 2
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Scenario 3

Allmessages found are exported to the PST at the root level. The PST name is created by the user.

Mailbox 1

Mailbox 2

Folder 1 t Message 3

|

I

Message 1

| Message 2

Structure before export

Merge Mailboxes

Maintain Message Path [J

o

Figure 4-12: Scenario 3

Scenario 4

|

Export.PST

— Message 1

— Message 2

—— Message 3

Structure after export

A folder with the mailbox name for every mailbox in which messages are found is created in a new
PST. Messages found in these mailboxes reside in these new mailbox folders, without the folder
structure in which they were located originally. PSTname is created by the user.

|

Mailbox 1 Mailbox 2
— Folder1 \— Message 3
t Message 1
L | Message 2
Structure before export

Figure 4-13: Scenario 4

Maintain Message Path (]

(m

Merge Mailboxes

Export.PST

1 Mailbox 1

Message 1

Message 2

— Mailbox 2

t Message 3

Structure after export
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Scenarios for exporting multiple mailboxes from the Find Window to multiple PSTs
Scenario 5

All the folders with messages found are created, starting from the first PST level folder and not the
mailbox name. PSTis named after the corresponding EDB mailbox name.

Mailbox 1

Mailbox 2

Folder 1

\— Message 3

I

Message 1

— Message 2

Structure before export

Figure 4-14: Scenario 5

Scenario 6

Maintain Message Path @ )

Mailbox1.PST

Folder 1

Mailbox2.PST

L Message 3

t Message 1

Message 2

Structure after export

All the messages are located in the root of the PST. PST is named after the corresponding EDB
mailbox name.

Mailbox 1

Mailbox 2

Folder 1

t Message 3

I

Message 1

— Message 2

Structure before export

Figure 4-15: Scenario 6

To use an exported PST

Maintain Message Path [1 )

1. Navigate to where the PSTwas created.

Mailbox1.PST

Message 1

Message 2

Mailbox2.PST

L Message 3

Structure after export

2. Drag the PSTinto SEP sesam Recovery Proin either the source or the Target pane. The Select
Source Files window appears.

3. Inthe Select Source Files window, click OK.

The PST now appearsin the target or source directory.
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You can configure SEP sesam Recovery Pro to append messages to existing PST files. Selecting the
Append to existing PST files during export option on the Preferences dialog box updates
previously exported PST files with new messages from the export process.

If this optionis cleared, SEP sesam Recovery Pro does not append messages to an existing PST file,
but creates a new PST file with a numberin parenthesis added to the name of the exported PST file.
Forexample, if John Doe.pst already exists, a new PST files is created and named John Doe(1).pst.
If John Doe(1).pst also exists, then the most recently exported PST would be named John Doe
(2).pst.

Note: You can only append messages to existing PST files which are not password protected.

To append messages to existing PST files

1. Onthe Edit menu, click Preferences, then click General.
2. Onthe General tab of the Preferences dialog box, select Append to existing PST files during
export and click OK.
3. Perform the export to PST. For more information, see To export to PSTin "Exporting Messages”
4. Do one of the following:
® |fyou selected Exportresults to single PST, choose the existing PST file fo which you
want to append the new messages.
® [fyou selected Export results to multiple PSTs, choose a folder with PSTs you exported
previously,

5. Inthe Export Progress window, verify new messages were successfully added to existing PST,
then click Close.

Note: There is a 2 GB limit for Microsoft Office Outlook 97-2002 style PSTs. For more information, see
"Limits for PST and Folder Targets"

When exporting PST files, you can define the maximum size of single Unicode PST file using the
Target Options tab of the Preference dialog box or the Command Line.

Target Options tab

When Limit maximum PST file size is selected, SEP sesam Recovery Pro automatically creates a
new PST file when the size in the MB field is reached during export. SEP sesam Recovery Pro saves
the processed PST file with its original name and creates the next file with the same name and a _
001.pst suffix, with the folders structure similar to the original file. SEP sesam Recovery Pro then
continues exporting messages to the newly created _001.pst file, saves it at the maximum size, and
continues the process, increasing the numbered suffix (_001.pst, _002.pst, _003.pst ...) until the
entire original PST file is exported.
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SEP sesam Recovery Pro appends files to existing ones also enforces the global size limit so it tries to
add files info existing pst file and if it reaches size limit it overflows to another file.

If files are present from a previous PST file export in which where size limit was reached (For
example, OriginalFileName.pst, OriginalFileName001.pst, and OriginalFileName002.pst)SEP sesam
Recovery Pro exports files to OriginalFileName002.pst until the limit is reached and continues,
creating OriginalFileName003.pst.

Note: Microsoft supports PST files up to 47.5GB with an absolute limit of 50GB, so the MB field should
not exceed 48640.

Exporting Organizational Forms

Microsoft Exchange Organizational Forms libraries are stored in public folder databases or public
folder mailboxes. When a pubilic folder EDB or public folder mailbox containing one or more
Organizational Forms folders is loaded as a source in SEP sesam Recovery Pro, you can export the
forms from the Organizational Forms library folder(s).

To export organizational forms

1. Inthe source tree, select the root of the public folder EDB or public folder mailbox.
2. Do one of the following to open the Export Organizational Forms dialog box:

= Onthe Tools menu, click Export Organizational Forms.

= Press Chi+G.

= Right-click the selection, and on the shortcut menu, click Export Organizational
Forms.

Export Organizational Forms

Choose one of more Forms ko expaort From the Organizational Forms Library,

Lock In: |Organi2ationa| Forms Library j
Mame | Last Modified | Size (Bytes) |
MaonsterFarm 51312012 10:59 AM 9479
MyForm2 5130/2012 1:51 PM 72051
MyPersonalTaskz 5130/2012 3:01 PM 32077
Personal Task 5/24[2012 9:58 AM 32067

Figure 4-16: Export Organizational Forms dialog box
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In the Look In drop list, select the organizational forms folder containing the forms you want
to export.

Note: Organizational Forms Library folders can be stored in different public folder databases
or public folder mailboxes. All public folder databases and mailboxes list all public folders
and Organizational Forms Library folders, not just those they store content for. Only the
Organizational Forms Library folders stored within the selected public folder database or
mailbox will contain items.

4. Inthe table, select the form(s) you want to export.

Click Export. The Export Forms dialog box appears with OFT selected in the Format list box.

Export Forms
OFT -
Cancel
Help
Export To:
|C: Public_FnIders_Expnrt j

Figure 4-17: Export Forms dialog box

In the Export To box, enter the folder path to where you want the forms exported.

Note: You can use the browse button to open the Browse For Folder dialog box to select the
path.

Click Export.

. Use the Export Progress dialog box to verify your forms were successfully exported, and click

Close.
On the Export Organizational Forms dialog box, click Close.

About the Export Progress Window

Each time you attempt to export messages, the Export Progress window appears. This window
displays the following information:

Source and target

Export start fime

Number of folders to export
Number of messages to export

Warnings or errors encountered during the export process. If an error occurs on a message,
the message subject and source path along with an error message will be displayed. If the
message does not have a subject, the date (created) and message sender will be
displayed instead.

Total folders and messages successfully exported
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Export Progress

Source: CLDATAYExchange !\ Stare edb
Source Falder: Store.edb ulie
Target Folder: C:iUsersysanduser] yDocurments),

Export started on 27122015 at 7:18 AM

Exporting:

Total nurmber of falders to be processed: 12

Total number of messages to be processed: 100

Total nurmber of associated messages to be processed: 1

Creating new pst Ci\Users\sanduser ] \Docurments ), Julie. pst,
All folders successfully exported

All messages successfully exported

All associated messages successfully exported
Exportfinished on 2/12/2015 at 7:15 AM

Export Finished

00h:00m:00s

o | _sun_|

Figure 4-18: The export progress is shown

Note:

® |fan error occurs that SEP sesam Recovery Pro can recover from, such as a corruption that
prevents it from getting a message property, SEP sesam Recovery Pro willlog an error, stop
processing that message, and continue.

® |fan error occurs from which SEP sesam Recovery Pro cannot recover, such as a major
corruption error, SEP sesam Recovery Pro will log an error to the Export Progress window and
stop exporting.

Saving and Printing the Report

The contents of the exportreport can be saved by clicking Save. This opens a Save File dialog box
allowing you to select the location and name of the file. The default name of the report is
"ExportProgress.ixt."

The export report can also be printed by clicking Print.
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Chapter 5: Restoring Microsoft
Exchange Server Data

Overview

The first part of this chapter provides you with a quick look at restoring your Microsoft Exchange
Server database, so you can begin to use the Microsoft Exchange Server application of SEP sesam
Recovery Proimmediately. The second part of this chapter provides examples of restoring
messages, folders, mailboxes, and even an entire EDB file to the desired destinafion.

Note: The conceptsin this chapter apply to EDB, PST, and CAS files (unless otherwise noted), even
though all of the examples of sources are EDB files.

Note: If you use the "Mailbox Criteria (optional)" box on the Select Source Files dialog box or the
Source Selection page of the Data Wizard, only EDB mailboxes containing your entry (or entries)
are displayed on the Source pane. Any mailboxes that do not match the entered string(s) do not
appearin the Source pane and are not be included in any subsequent tasks (such as searching,
copying, and exporting of the entire database). For more information, see "Mailbox Criteria".

Note: If you use the "Multi-Tenancy Criteria" box on the Select Source Files dialog box, the Source
Selection page of the Data Wizard, the Connect to Exchange Server dialog box, or the Target
Selection page of the Data Wizard, only mailboxes contained in the selected Address Book Policy
or Organization appearin the Source or Target panes. Only these mailboxes are included in any
subsequent tasks (such as searching, copying, and exporting of the entire database). For more
information, see "Multi-Tenancy Support".

Quick Look at Restoring Your Microsoft
Exchange Server Data

Restoring data from a source EDB, PST, or CAS file to a target destination is a simple process. Just
drag or use the Copy and Paste/Paste Special commands.

m "Restoring Your Microsoft Exchange Server Data in Three Easy Steps”
= "Limits for PST and Folder Targets"

= "About Restoring Messages to a Microsoft Exchange Server"

= "About the Copy Progress Window "

= "Creating, Renaming, and Deleting Folders in the Target Pane”

= "Copying and Pasting or Dragging"
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Restoring Your Microsoft Exchange Server Data in Three
Easy Steps

If you copy an EDB file, a PST file, a mailbox, or a folder from the Source pane and paste it to any
target destination, SEP sesam Recovery Pro will preserve the directory structure of all restored
messages. When restoring individual messages, you must use the Paste Special command to
preserve their directory structure.

To restore individual messages with copy-paste

1. Inthe Source pane or Find in Source window, copy messages from the message list.
2. IntheTarget pane, paste the messagesinto a folder.

3. Inthe Copy Progress window, verify that your messages were successfully copied, and click
Close.

To restore individual messages with copy-paste special

1. Inthe Source pane or Find in Source window, copy messages from the message list.

2. Inthe Target pane, use Paste Special to paste the messages into a folder, mailbox, PSTroof,
or Microsoft Exchange Serverroot.

3. Inthe Copy Progress window, verify that your messages were successfully copied, and click
Close.

Tip: Use the Paste Special command to retain the directory structure of messages copied
from the Find in Source or Find in Exchange Target window, because messages in this
window often come from several source locations.

To restore a folder, a mailbox, an EDB file, a CAS file, or a PST file

1. Inthe Source pane, copy a folder, a mailbox, an EDB file, a CAS file, or a PST file.

2. IntheTarget pane, paste the copied item into a folder, mailbox, PSTroot, or Microsoft
Exchange Serverrootf.

3. Inthe Copy Progress window, verify that your messages were successfully copied, and click
Close.

Note: You cannot open the same PST as a source and target. In additfion, you cannot
restore messages from a PST file to a Microsoft Exchange Serverroot node.

To restore data even faster by dragging

= Example: To restore an entire EDB file, drag it to the target Microsoft Exchange Serverroot.

Limits for PST and Folder Targets

When restoring Microsoft Exchange Server Data to a target PST or folder, Microsoft Office Outlook
97-2002 style PSTs have the following limits:

Global Limits for PST Limit
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The global limit can be set for any PST file. For more information, see "Setting a Global Limit for PST
Files".

16,383 Messages Per Folder (for example, Inbox) Limit

When a targeft folder (for example, Inbox) reaches 16,383 messages, SEP sesam Recovery Pro
creates a new PST folder for the additional messages. The new folder has the same name as the
original target folder plus an appended numberin parentheses: Inbox (1), Inbox (2), and so on. SEP
sesam Recovery Pro creates the folder pathin the new folder and continues to restore Microsoft
Exchange Server data where it left off.

Note: If you have upgraded the PST file to a large table format, the PST can hold 64,000 messages
per folder. However, when a target folder (forexample, Inbox) reaches 16,383 messages, SEP
sesam Recovery Pro still creates a new PST folder for the additional messages.

To turn off the preference setting for the PST messages per folder limit
If you do not want SEP sesam Recovery Pro to create new folders when the number of messages
reaches 16,383, do the following:

1. Onthe Edit menu, click Preferences.

2. Inthe Preferences window, click the Target Options tab, and then clear the Create new PST
folders when PST message/folder limits are reached check box.

Note: If you turn off the preference, allmessages above the messages per folder limit will fail to
copy correctly, and the PST file may become corrupt.

About Restoring Messages to a Microsoft Exchange Server

You must have sufficient access rights to all of the Microsoft Exchange Server mailboxes you are
frying to restore messages fo.

Restoring Messages to Microsoft Exchange Server 2007 and later

In Microsoft Exchange Server 2007 and later, the permission that controls whether or not any
mailbox can be copied to is Full Mailbox Access. You must have Full Mailbox Access set to "Allow"
in order to copy to a mailbox other than the one you logged in under.

About the Copy Progress Window

Each time you attempt to restore messages to the Target pane, the Copy Progress window
appears. This window displays the following information about the copy operation:

= Time of copy operation
= Number of messages, associated messages, and folders
= FErrors, if any
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= Mailboxes that SEP sesam Recovery Pro connected to or failed to connect to when copying
to a Microsoft Exchange Server

= Copyresults

Important: Viewing the copy results in Copy Progress window is especially important when
aftempting to restore multiple items to a Microsoft Exchange Serverroot node. That is because SEP
sesam Recovery Pro restores one mailbox at a time; therefore, the only way you will know if all of
the mailboxes were successfully copied to the Microsoft Exchange Server will be to look at the
copy results listed in this window.

If you do not have full access rights to the mailboxes you are trying to restore messages to, SEP
sesam Recovery Pro will be unable to connect to the mailboxes. For more information, see "About
Restoring Messages to a Microsoft Exchange Server".

Creating, Renaming, and Deleting Folders in the Target Pane

The Target pane has folders in which you can place your restored messages. However, you may
want to create new folders for your messages. You can also rename or delete any folderin the
Target pane.

To create a new folder in the Target pane

1. Inthe Target pane, select a folder, a PSTroot node, or a Microsoft Exchange Server mailbox.
2. Do one of the following:

* Onthe Edit menu, click New Folder.

* Right-click and on the shortcut menu, click New Folder.

* Press Cirl+N.

3. Inthe Create New Mail Folder window, name the folder and click OK. A subfolderis created
in the target folder.

To rename a folder in the Target pane

1. IntheTarget pane, select afolder.

2. Do one of the following:
¢ On the Edit menu, click Rename.
* Right-click and on the shortcut menu, click Rename.
¢ Press Cirl+R.

3. Type anew name for the folder.

Note: You can also rename a PSTroot.
To delete afolder in the Target pane

1. IntheTarget pane, select afolder.
2. Do one of the following:
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¢ Onthe Edit menu, click Delete.
¢ Pressthe Delete key.

Copying and Pasting or Dragging
In SEP sesam Recovery Pro, you canrestore data to the Target pane by using Copy-Paste, Copy-
Paste Special, or dragging.

Note: If you copy the Recoverable Items folder, it is renamed to distinguish the copied version from
the actual version. The folderis renamed using the localized short date in parenthesis and
appended fo the folder name. Example: "Recoverable Items (10/22/2009)"

To copy an item in the Source pane or Find window
1. Inthe Source pane or Find in Source window, select messages, a folder, a mailbox, or the

entire EDB file.
Note: In the Find in Source window, you can only select messages.

2. Do one of the following:
¢ Onthe Edit menu, click Copy.
* Right-click the selected item(s), and on the shortcut menu, click Copy.

* Click the Copy Mailltemicon % onthe toolbar.
e Press Ctrl+C.

To paste an item in the Target pane

1. Inthe Target pane, select a folder, a mailbox, the PSTroot node, or the Microsoft Exchange
Serverroot node.

2. Do one of the following:
¢ On the Edit menu, click Paste.

* Right-click the selected item, and on the shortcut menu, click Paste or Paste Special. For
more information on using the Paste Special command, see "Restoring Messages with
Copy-Paste".

Click the Paste icon @ on the toolbar.
e Press Chrl+V (Paste) or Chrl+Y (Paste Special).

To drag an item to the Target pane

® Draganitem from the Source pane into a folderin the Target pane. Dragging achieves the
same results as copying and pasting.
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To use drag when right-clicking a source item

1. Inthe Source pane, select one or more messages.
2. Right-click the selected messages and drag them to a folderin the Target pane.

3. Whenyou let go of the mouse, a shortcut menu appears. On the shortcut menu, click Paste
or Paste Special. For more information on using the Paste Special command, see "Restoring
Messages with Paste Special”.

Examples of Restoring Your Microsoft Exchange
Server Data

This section provides examples of restoring messages, folders, mailboxes, and even an entire EDB
file fo the desired destination. In each case, it provides guidelines for restoring messages.

Note: The conceptsin this chapter apply to both EDB and PST files (unless otherwise noted), even
though all of the following examples are EDB files.

Restoring Messages with Copy-Paste

The following instructions show you how to restore individual messages to a folderin a target PST
file or Microsoft Exchange Server by using Copy-Paste. Keep in mind that dragging achieves the
same resulfs.

Guidelines for Restoring Messages

® You can copy messages from the message list in the Source pane or the Find in Source
window.

® You can drag or copy and paste to restore individual messages to a folderin the Target
pane.

= You cannot drag or copy and paste to restore individual messages to a PSTroot node, a
Microsoft Exchange Server root node, or a Microsoft Exchange Server mailbox. However,
you can use Paste Special to restore individual messages to these locations.

= Dragging or copying and pasting to restore individual messages does not preserve the
directory structure of the restored messages. If you want to preserve the directory structure
of restored individual messages, use Paste Special.

® You cannot copy-paste inaccessible mailboxes.

Tip: Forinformation on Paste Special, see "Restoring Messages with Paste Special”.

To restore messages with copy-paste

1. Inthe Source pane or Find in Source window, copy messages from the message list.

2. IntheTarget pane, paste the messages into a folder (for example, Inbox) in the target PST
file or Microsoft Exchange Server.
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3. Inthe Copy Progress window, verify that your messages were successfully copied. You can
also print or save the copy report by doing one of the following.

* Click Print to print the copy report.
e Click Save to save the copy report as a text file.

4. Inthe Copy Progress window, click Close to return to the main window.

Results of Restoring Messages with Copy-Paste

Allunduplicated messages appear in the target folder.

Restoring Messages with Paste Special

You can use the Paste Special command to preserve the directory structure of restored individual
messages. The Paste Special command is especially useful when restoring messages from the
message list in the Find window, since these messages offen come from several source locations.

Guidelines for Restoring Messages with Paste Special

® You can use the Paste Special command to restore individual messages to any target
destination. Using the Paste Special command preserves the directory structure of the
restored messages.

® You can use the Paste Special command to restore individual messages only. You cannot
use the Paste Special command to restore an entire EDB file, a mailbox, or a folder.

® You cannot use Paste Special to restore messages to a public folder.

= |f the target is a PST root node or folder, SEP sesam Recovery Pro creates a folder to
represent each mailbox. Each mailbox is a subfolder of the folder the user selected for the
Paste Special operation.

= |fthe target is a Microsoft Exchange Server mailbox or folder, SEP sesam Recovery Pro
copies all messages to the target. Each mailbox is a subfolder of the folder the user selected
for the Paste Special operation.

= |f the target is a Microsoft Exchange Server root node, the Paste Special code attempts to
connect to each mailbox one at a time and copies each message to its corresponding
mailbox and folder. If the folder does not exist, it will be created. If the mailbox does not
exist, SEP sesam Recovery Pro logs an error in the copy results, skips the entire mailbox, and
confinues the Paste Special operation.

Note: You cannotrestore messages from a PST file to a Microsoft Exchange Server root
node.

To restore messages to a PST root or folder with Paste Special

If the targetis a PSTroot node or folder, SEP sesam Recovery Pro creates a folder to represent each
mailbox. Each mailboxis a subfolder of the folder you selected for the Paste Special operation.
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1. Inthe Source pane or Find in Source window, copy messages from the message list.

2. Inthe Target pane, use Paste Special to paste the messages into a PSTroot node or folder.

3. Inthe Copy Progress window, verify that your messages were successfully copied. You can

also print or save the copy report by doing one of the following.
¢ Click Print to print the copy report.

e Click Save to save the copy report as a text file.

4. Inthe Copy Progress window, click Close to return to the main window.

Results of Restoring Messages to a PST Root Node or Folder with Paste Special

Allunduplicated messages appear in the target destination, and their directory structure will be

preserved.

To restore messages to a Microsoft Exchange Server mailbox or folder with Paste Special

If the target is a Microsoft Exchange Server mailbox or folder, SEP sesam Recovery Pro copies alll
messages to the target. Each mailbox is a subfolder of the folder you selected for the Paste

Special operation.

1. Inthe Source pane or Find in Source window, copy messages from the message list.

2. Inthe Target pane, use Paste Special to paste the messages into a Microsoft Exchange
Server mailbox or folder.

3. Inthe Copy Progress window, review your results to make sure all the messages were copied

to the target destination. You can also print or save the copy report by doing one of the

following.

¢ Click Print to print the copy report.

¢ Click Save to save the copy report as a text file.

4. Inthe Copy Progress window, click Close to return to the main window.

Results of Restoring Messages to a Microsoft Exchange Server Mailbox or Folder with Paste

Special

Each mailboxis a subfolder of the target destination, and all unduplicated messages are restored.
In addition, their directory structure is preserved.

| Target: C:\Documents and Settings\ My Documents\Mondays Files.pst

=1+ Evno4v30aa
[ Folder 10

B Yoo

4] Deleted Items

[24] Folder 1

[ Folder 10

[=4] Forensic certification

—I-[=2] Personal Folders

[ Calendar
[8] contacts

- [=] Deleted Items
[ Drafts

[+ Inbox

& Journal

-~

| | @ | From | Subject | Create Date |
| Exch55B Userl made some cha... Tue 3/11/2003 ...
| Microsoft Welcome to Mic...  Fri 8/09/2002 3...
&4 Evnodv3zaa PC... GugMasRWi-ou... Thu 4/14/2005...
E Evnofdvnzaa PC... cwoXFMclK-ou... Thu 4/14/2005...
4 Evnodvfcaa PC...  uGdTrjgdf-oups... Thu 4/14/2005...
4 Evnodvvnaa PC... WBKyDIapx-ou... Thu 4/14/2005...
4 Evnodvv2aa PC... EOPTRXZiQ-ou... Thu 4/14/2005...
4 Evnodv3waa P... HsOwXWell-o... Thu4/14/2005...
x| Evnofvw2aa PC... sFhvbfmiD-oup... Thu 4/14/2005...
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Figure 5-1: Results of using Paste Special on a target Microsoft Exchange Server mailbox

To restore messages to a Microsoft Exchange Server root node with Paste Special

If the target is a Microsoft Exchange Serverroot node, SEP sesam Recovery Pro attempts to
connect to each mailbox one at a time and copies each message fo its corresponding mailbox
and folder. If the folder does not exist, it is created. If the mailbox does not exist, SEP sesam
Recovery Pro logs an errorin the Copy Progress window, skips the entire mailbox, and confinues
the Paste Special operation.

The source mailbox must exist on the target Microsoft Exchange Server, and you must have full
mailbox access rights to all of the Microsoft Exchange Server mailboxes to which you are trying to
restore messages. For more information on access rights, see "About Restoring Messages to a
Microsoft Exchange Server".

1. Select one ormore messages from the message list in the Find in Source window or the
Source pane.

2. Inthe Source pane or Find in Source window, copy messages from the message list.

3. Inthe Target panes use Paste Special fo paste the messages into a Microsoft Exchange
Serverroot node.

4. Inthe Copy Progress window, verify your results to make sure that your messages from alll
mailboxes were copied to the target destination. You can also print or save the copy report
by doing one of the following:

¢ Click Print to print the copy report.
e Click Save to save the copy report as a text file.

5. Inthe Copy Progress window, click Close to return to the SEP sesam Recovery Pro main
window.

Results of Restoring Messages to a Microsoft Exchange Server Root Node with Paste Special

Allunduplicated messages are restored in each mailbox that SEP sesam Recovery Pro can
connect to, and the directory structure of the messages is preserved.

When attempting to restore multiple mailboxes to a Microsoft Exchange Serverroot node, you
must look at the Copy Progress window to verify that your messages from all mailooxes were
successfully copied to the Microsoft Exchange Server. That is because SEP sesam Recovery Pro
displays only one mailbox at a fime in the Target pane.

Restoring a Folder

The following instructions show you how to restore a folder to any target destination by using Copy-
Paste. Keep in mind that dragging achieves the same resulfs.

Guidelines for Restoring a Folder
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® You can drag or copy and paste to restore a folder to a target PSTroot node or folder, or to
a Microsoft Exchange Server mailbox or folder. If the folder does not exist in the target
destination, itis created.

= You cannotrestore afolder to a Microsoft Exchange Serverroot node.

= You cannotrestore a private folder to a public folder. But you can restore messages from a
private folder to a public folder.

® You cannot use the Paste Special command to restore a folder. You can use the Paste
Special command to restore individual messages only.

= |fyou copy the Recoverable Items folder, it is renamed to distinguish the copied version
from the actual version. The folderis renamed using the localized short date in parenthesis
and appended fo the folder name. Example: "Recoverable Items (10/22/2009)"

To restore a folder

1. Inthe Source pane, copy a folder (for example, Inbox).
2. IntheTarget pane, paste the folderinto a folder, mailbox, or PSTroot node.

3. Inthe Copy Progress window, verify your results to make sure that your messages from alll
mailboxes were copied to the target destination. You can also print or save the copy report
by doing one of the following.

¢ Click Print to print the copy report.
* Click Save to save the copy report as a text file.

4. Inthe Copy Progress window, click Close to return to the SEP sesam Recovery Pro main
window.

Results of Restoring a Folder

Allunduplicated messages in the folder are restored and their directory structure is preserved. If
the folder does not exist in the target destination, it is created.

Note: No folder is created because the copied folder (Inbox) already exists in the target Microsoft
Exchange Server mailbox.

Restoring a Mailbox

The following instructions show you how to restore a mailbox to any target destination by using
Copy-Paste. Keep in mind that dragging achieves the same results.

Guidelines for Restoring a Mailbox

® You can drag or copy and paste to restore a mailbox to a target PSTroot node or folder, or
to a Microsoft Exchange Serverroot node, mailbox, or folder.

= |f you restore a mailbox to a target PST root node: Messages from folders in the source PST
are restored to corresponding folders in the target PST (for example, messages from the
source Inbox are restored to the target Inbox). If a corresponding folder does not exist in the
target destination, itis created.
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= |f you restore a mailbox to a target PST folder, or to a Microsoft Exchange Server, mailbox,
or folder: If the mailbox does not exist in the target destination, a folder with its name is
created.

If you want to restore a mailbox to a target Microsoft Exchange Serverroot node, the
source mailbox must exist on the target Microsoft Exchange Server, and you must have full
mailbox access rights to all of the Microsoft Exchange Server mailboxes you are frying to
restore messages to. For more information on accessrights, see "About Restoring
Messages to a Microsoft Exchange Server".

= You cannotrestore a mailbox to a public folder. But you can restore messages from a
mailbox to a public folder.

® You cannot use the Paste Special command to restore a mailbox. You can use the Paste
Special command fo restore individual messages only.

To restore a mailbox

1. Inthe Source pane, copy a mailbox (for example, User 1).

2. IntheTarget pane, paste the mailbox into a folder, mailbox, PSTroot node, or Microsoft
Exchange Serverroot node.

3. Inthe Copy Progress window, verify your results to make sure that your messages from alll
mailboxes were copied to the target destination. You can also print or save the copy report
by doing one of the following.

* Click Print to print the copy report.
e Click Save to save the copy report as a text file.

4. Inthe Copy Progress window, click Close to return to the SEP sesam Recovery Pro main
window.

Results of restoring a mailbox
Allunduplicated messages in a mailbox are restored and their directory structure is preserved.

If the mailbox does not exist in the target destination, a folder with its name is created. However, if
you restore a mailbox to a target PSTroot node, a mailboxis not created. Instead, messages from
foldersin the source PST are restored to corresponding folders in the target PST.

Restoring an EDB File

The following instructions show you how to restore an entire EDB file to any target destination with
Copy-Paste. Keep in mind that dragging achieves the same results.

Guidelines for Restoring an EDB File

= |tisrecommended that you restore an EDB file to a target Microsoft Exchange Serverroot
node.

116



® You candrag or copy and paste to restore an entire EDB file. You cannot use the Paste
Special command to restore an EDB file. You can use the Paste Special command to
restore individual messages only.

If you restore an EDB file to a target Microsoft Exchange Serverroot node, the source
mailbox must exist on the target Microsoft Exchange Server, and you must have full
mailbox access rights to all of the Microsoft Exchange Server mailboxes to which you are
frying to restore messages. For more information on accessrights, see "About Restoring
Messages to a Microsoft Exchange Server".

To restore an EDB file

In the Source pane, select the EDB file.

On the Edit menu, click Copy.

Inthe Target pane, select the Microsoft Exchange Serverroot node.
On the Edit menu, click Paste.

o M-

In the Copy Progress window, review your results to make sure all the messages were copied
to the target destination. You can also print or save the copy report by doing one of the
following.

 Click Print to print the copy report.

e Click Save to save the copy report as a text file.

6. Inthe Copy Progress window, click Close to return to the SEP sesam Recovery Pro main
window.

Results of restoring an EDB file

SEP sesam Recovery Pro attempts to connect to each mailboxin the Target pane one at a time
and copies each message toits corresponding mailbox and folder. If the folder does not exist, it
will be created. If the mailbox does not exist, SEP sesam Recovery Pro displays an error in the Copy
Progress window, skips the entire mailbox, and continues the operation.

Restoring to Public Folders

The following instructions show you how to restore messages or public folders to a public folder
target. An option to open public folders is available upon connection to a Microsoft Exchange
Server.

Important: SEP sesam Recovery Pro opens public folders and your mailbox when you connect to a
Microsoft Exchange Server target. You will see those folders that you have permission to see.

Guidelines for Restoring to Public Folders

® You canrestore folders from a pub.edb database or Public Folder mailbox to a public folder
target. All public folder permissions are fransferred to the target folders. However, folder
permissions may not fransfer if the version of the source Microsoft Exchange Serveris
different than the version of the target Microsoft Exchange Server.

117



Note: Public folder permissions cannot be fransferred to Microsoft Exchange Server 2013 or
later targets.

® You canrestore messages from any database source or search results to a public folder
target.

® You cannotrestore afolder or non-Public Folder mailbox from a mailbox database to a
public folder target. But you can restore messages in a folder or non-Public Folder mailbox
to a public folder.

® You cannot use Paste Special when restoring messages to a public folder target.

Note: The ability to restore to public folders is also available at the command line.
To restore messages to a target Public Folders

1. Inthe Source pane or Find in Source window, copy messages from the message list.

2. IntheTarget pane, paste the messages into the target rootf public folder or a folder in the
public folder.

3. Inthe Copy Progress window, verify that your messages were successfully copied. You can
also print or save the copy report by doing one of the following.

¢ Click Print to print the copy report.
* Click Save to save the copy report as a text file.

4. Inthe Copy Progress window, click Close to return to the SEP sesam Recovery Pro main
window.

To restore a folder from a public database or Public Folder mailbox to a target Public Folders

1. Inthe Source pane copy a folder from a public database, or Public Folder mailboxin a
Microsoft Exchange Server 2013 or later mailbox database.

2. IntheTarget pane, paste the folderinto the target root public folder or a folderin the public
folder.

3. Inthe Copy Progress window, verify that your messages were successfully copied. You can
also print or save the copy report by doing one of the following.

¢ Click Print to print the copy report.
« Click Save to save the copy report as a text file.

4. Inthe Copy Progress window, click Close to return to the SEP sesam Recovery Pro main
window.

Note: Public folders can be stored in different pubilic folder databases or public folder mailboxes.
Allsource public folder databases and mailboxes list all public folders, not just those they store
content for. Only the pubilic folders stored within the selected public folder database or mailbox
will contain items in the Source pane.

Results of Restoring to Public Folders

When you restore folders from a pub.edb database or Public Folder mailbox to a public folder
target, the following occurs:
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= All public folder permissions are transferred to the target folders. However, folder permissions
may not fransfer if the version of the source Microsoft Exchange Server is different than the
version of the target Microsoft Exchange Server.

Note: Public folder permissions cannot be transferred to Microsoft Exchange Server 2013 or
later targets.

= The Microsoft Exchange Server user doing the restore will be added to all public folder
permissions with owner rights.

= |fyou have IFS (also known as "M:drive") enabled on your Microsoft Exchange Server,
permissions for child folders may be merged with permissions for parent folders.
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Chapter 6: Using the Command Line

Overview

The command line feature allows you to easily batch repetitive processes such as multiple copy
and export tasks without initiating the SEP sesam Recovery Pro user interface. This feature is
extremely beneficial in SEP sesam Recovery Pro production environmentimplementations.

Note: Only message containers (such as mailboxes, folders, entire EDB) can be selected for
copy/export. Allmessages contained are copied/exported. Individual messages cannot be
selected from the command line.

Command Line Syntax

The syntaxis as follows:

<<>>Required for all operations

<> Required for copy/export operations
[]1 Optional

Command Line Syntax

RPEX <<Operation>> [Operation options] <<Source Store>> [Source options] <Source Folder Path>
<Target Store>[Target options] <Target Folder Path>

<<Operation>>
-copy
Copy source selection to the data store specified by the Target details.
—export

Export source selection, creating a new item type specified by the - £ option, in the
specified Target Folder Path.

-list
List fop level folders or mailboxes for source selection.
-integ

Perform integrity check of source selection.

Open the Command Line options help.

[Operation options]
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-f:<format option>

The format option will be the data type created during an —export command.

msg

Export message as.msg (.msg is the default).
txt

Export message as .ixt.
pst

Export message to a PST.
-p:<format option>

97

Create a 97-2002 style PST (ANSI) during export.
2003
Create a 2003 style PST (Unicode) during export.
Note: See "Exporting Messages" for further detail.
-r
Include all subfolders of source selection in the export/copy function.
-d:<date criteria>
received
sent
due
expires
created
modified
starts
ends
completed
any

Note: Date criteria can be used only with -copy and -export operations.

121



Note: Option "any” can be used for filtering through all date types specific for allitem types
available in the given data sef.

—a:<mm/dd/yyyy>
Process messages dated on or after this date (optional).
-b:<mm/dd/yyyy>
Process messages dated on or before this date.
—-c:<AND or OR operators>
Adds logical operators OR/AND into several dates criteria.
Note: -c parameteris optional, if skipped set fo OR.
-0 <path ending with output filename>

Generate a process log.

Write verbose data to the output file (-o c:\output.ixt).

Note: If the file exists, SEP sesam Recovery Pro willappend to the output progress file. If the
file does not exist, SEP sesam Recovery Pro will create it.

-type<item type criteria> message

post

note

calendar

contact

task

journal

distlist
Note: Type criteria can be used only with -copy and -export operations.
<Source Store>

Full path of EDB file, CAS file, or PST file
[Source options]

-1 <log file path>

-t <temp file path>

-m <mailbox criteria>
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Filter available mailboxes by text string. Use ; to separate multiple strings.
Note: For more information, see "Mailbox Criteria".
—a

Automatically open the specified EDB source and view it in the source free
without using the Data Wizard.

< Source Folder Path >

The internal path to the desired data; the mailbox to the source folder, profile folder, or
$ROOT for all folders.

If specifying a mailbox, the mailbox name can be its display name.

If specifying a source mailbox that isin the current environment, the mailbox name can be
its display name or the UPN (for example, mailbox@domain.local).

If specifying multiple folders or mailboxes, separate their names with a pipe
example, folder1 | folder2 | folder3).

| " symbol (for

Note: If the "Enforce ABP or Hosted Organization for current user" security preference is selected on
the Security tab of the Preferences dialog box, only matching mailboxes can be accessed. For
more information, see "Multi-Tenancy Support".

<Target Store>
The ServerName;mailbox , path to folder, or Full path and name of PST.
Note: The ServerName can be omitted if Autodiscoveris being used.

Note: The Target Store is not needed for export. Default path for output will be the current path of
the command line.

[Target options]
-pub
Connects to target's Public Folders
-partialmatch:<copy | skip>
copy
Allow copy of partial match mailboxes into target.
skip
Skip all partial match mailboxes during copy.

-—autodiscover:<on|off>

on
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Use Autodiscover to connect to the target mailbox.
off
Do not use Autodiscover to connect to the target mailbox.
-outlookanywhere:<on|off>
on
Use Outlook Anywhere to connect to the target mailbox.
off
Do not use Outlook Anywhere to connect to the target mailbox.

<Outlook Anywhere Required Options> (Not needed and ignored if —autodiscover.onis
specified)

-proxy <proxy server>
Name of Exchange proxy server for Outlook Anywhere.
-authentication:<authentication mode>
basic
Use basic authentication.

ntlm

Use NTLM authentication.
negotiate

Use Negotiate authentication.

[Outlook Anywhere Options] (ignored if —autodiscover:onisspecified)
-ssl

Use SSL for Outlook Anywhere connection, required if using basic authentication.
-principal <certificate principal name>

Principal name to look for when validating proxy server certificate.
-httpfirstonfast

On fast networks, use HTTP to connect first, then use TCP/IP.
-httpfirstonslow

On slow networks, use HTTP to connect first, then use TCP/IP.
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<Target Folder Path>

Target destination: the full path, including mailbox to the target folder to be copied/exported to,
SROOT forroot datastore folder, or SPUBLIC_ROOT for root of "All Public Folders".

SROOT

Examples of Using the Command Line

The following examples are for pre-populate EDB file, copy, export, integrity check, and list (such
asreportinformation about the database).

Example 1: Pre-populate the EDB file, log and temp path fields of the Open Source dialog.

RPEX c:\ExchangeDb.edb -1 c:\Log Dir -t c:\Temp Dir

Pre-populate the EDB file, log and temp path fields of the open source
dialog

<Source Store> Explanation

c:\ExchangeDb.edb |Pathto the EDB file

-lc:\Log_Dir Log file path

[T c:\Temp_Dir Temporary file path P

Example 2: Open an EDB file from the command line without using the Data Wizard.

RPEX c:\ExchangeDb.edb -1 c:\Log Dir -t c:\Temp Dir -a

<Operation> Explanation

c:\ExchangeDb.edb Path to the EDB file

-lc:\Log_Dir Log file path

-t c:\Temp_Dir Temporary file path

- Automatically open the source without using the Data Wizard )

Example 3: Copy mbxUser's Inbox and all subfolders from c:\ExchangeDb.edb to the Inboxin
c:\Target.pst. c:\OutputReport.txt will contain the copy report.

RPEX —-copy —-r -o c:\OutputReport.txt c:\ExchangeDb.edb -1 c:\LogDir -t
c:\TempDir mbxUser\inbox c:\Target.pst S$SROOT

<Operation> Explanation

-copy Perform a copy operation

[Operation options] Explanation

-r Copy subfolders

-0 c:\OutputReport.ixt Outputreport file name )
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<Operation> Explanation

<Source Store>

Explanation

c:\ExchangeDb.edb

Path to the database file name

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path
<Source Folder Path> Explanation
mbxUser\inbox Source folder to copy
<Target Store> Explanation

c:\target.pst

Target data store

<Target Folder Path>

Explanation

L:1‘>ROOT

Copy to the root folder of the data store )

Example 4: Copy mbxUser's Inbox and all subfolders from c:\ExchangeDb.edb to mbxUser's Inbox
on an active Microsoft Exchange Server ExchangeTarget.

RPEX c:\OutputReport.txt will contain the copy report.

-copy -r -0

c:\OutputReport.txt c:\ExchangeDb.edb -1 c:\LogDir -t c:\TempDir

mbxUser\inbox ExchangeTarget;mbxUser inbox

<Operation> Explanation

-copy Perform a copy operation
[Operation options] Explanation
-r Copy subfolders

-0 c:\OutputReport.txt

Outputreport file name

<Source Store>

Explanation

c:\ExchangeDb.edb

Path to the database file name

[Source options] Explanation
-l c:\LogDir Logfile path
-t c\TempDir Temporary file path

<Source Folder Path>

Explanation

mbxUser\inbox

Source folder to copy

<Target Store>

Explanation

ExchangeTarget;mbxUser

Target data store (Microsoft Exchange Server name andlogon ID)

<Target Folder Path> Explanation
inbox Copy to the inbox P
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Example 5: Export mbxUser 's mailbox and all subfolders from ExchangeDb.edb as text to
c:\ExportDir.

RPEX —-export -r -f:txt —-o c:\OutputReport.txt c:\ExchangeDb.edb -1 c:\LogDir
-t c:\TempDir mbxUser c:\ExportDir

<Operation> Explanation

-export Perform an export operation
[Operation options] Explanation
-r Export subfolders

-fiixt

Messages will be exported as .txt

-0 c:\OutputReport.txt

Export report file name

<Source Store>

Explanation

c:\p cdata.edb

Path to the database file name

[Source options] Explanation
-l c:\LogDir Log file path
-t c:\TempDir Temporary file path

<Source Folder Path>

Explanation

mlbxUser

Source folder to copy

<Target Store>

Explanation

Lc:\ExporTDir

Target data store

Example 6: Provides information on the databases including a list of mailboxes.

RPEX -list -o c:\mblist.txt c:\ExchangeDb.edb -1 c:\LogDir -t c:\TempDir

-list

Perform a list operation

[Operation options]

Explanation

-0 c:\mblist.txt

Outputreport file name

<Source Store>

Explanation

c:\ExchangeDb.edb

Path to the database file name

[Source options] Explanation
-l c:\LogDir Log file path
[T c:\TempDir Temporary file path )

Example 7: Provides information on the databases including a list of mailboxes filtered by mailbox
criteria.

RPEX -list -o c:\mbxlist.txt c:\ExchangeDb.edb -1 c:\LogDir -t c:\TempDir -m
mbxUserl;mbxUser?2
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<Operation> Explanation

>-list

Perform a list operation

<Operation>

Explanation

-0 c:\mblist.txt

Output report file name

<Source Store>

Explanation

c:\ExchangeDb.edb

Path to the database file name

[Source options]

Log file path

-l c:\LogDir

Temporary file path

[T c:\TempDir

Only open pcuser] and pcuser2 mailboxes

Example 8: Perform an integrity check on an entire EDB.

RPEX -integ -r —-o c:\OutputReport.txt c:\ExchangeDb.edb -1 c:\LogDir -t

c:\TempDir S$ROOT

<Operation> Explanation

-integ

Perform an integrity check on a database

[Operation options]

Explanation

-0 c:\OutputReport.txt

Output report file name

<Source Store>

Explanation

c:\ExchangeDb.edb

Path to the database file name

[Source options] Explanation
-l c:\LogDir Log file path
-t c\TempDir Temporary file path

<Source Folder Path>

Explanation

L21‘>ROOT

Root of the EDB (entire EDB)

Example 9: Copy a folder from a pub EDB to public folders (only copy messages dated after

01/01/2000).

RPEX -copy —-r —o c:\OutputReport.txt -d:created-a:01/01/2000
c:\ExchangePUB.edb -1 c:\LogDir -t c:\TempDir newsgroups
ExchangeTarget;mbxUser -pub SPUBLIC ROOT

<Operation> Explanation

-copy Perform a copy operation
[Operation options] Explanation
-r Copy subfolders

-0 c:\OutputReport.txt

Outputreport file name

N
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<Operation> Explanation

-d:created-a:01/01/2000

Only copy messages that were created after this date

<Source Store>

Explanation

c:\ExchangeDb.edb

Path to the database file name

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path
<Source Folder Path> Explanation
Newsgroups Source folder to copy
<Target Store> Explanation

ExchangeTarget;mbxUser

Target data store (Microsoft Exchange Server name and
logon ID)

<Target Options>

Explanation

-pub

Copy to public folders

<Target Folder Path>

Explanation

L$PUBLIC_ROOT

Public folders root

Example 10: Perform anintegrity check on an entire Content Analysis Store.

RPEX -integ -r -o c:\OutputReport.txt c:\source.cas S$ROOT

<Operation> Explanation

-integ Perform an integrity check on a database
[Operation options] Explanation
-r Check subfolders

-0 c:\OutputReport.txt

outputreport file name

<Source Store>

Explanation

c:\source.cas

Path to the Content Analysis Store file name

<Source Folder Path>

Explanation

L$ROOT

Root of the CAS (entire CAS)

Example 11: Copy Profile1 from c:\source.cas to the root in c:\target.pst.

RPEX -copy -r -o c:\OutputReport.txt c:\source.cas Profilel c:\Target.pst

SROOT
<Operation> Explanation
-copy Perform a copy operation
l[Operation options] Explanation J
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<Operation> Explanation

-r Copy subfolders

-0 c:\OutputReport.txt outputreport file name

<Source Store> Explanation

c:\source.cas Path to the Content Analysis Store file name

<Source Folder Path> Explanation

Profile1 Source folder to copy

<Target Store> Explanation

c:\target.pst Target data store

<Target Folder Path> Explanation

@ROOT Copy to the root folder of the data store )

Example 12: Export Profile2 from source.cas as text to c:\export.

RPEX -export -r —-f:txt -o c:\OutputReport.txt c:\source.cas Profile2
c:\ExportDir

<Operation> Explanation

-export Perform an export operation

[Operation options] Explanation

-r Export subfolders

-fiixt Messages will be exported as .txt

-0 c:\OutputReport.txt Export report file name

<Source Store> Explanation

c:\source.cas Path to the Content Analysis Store file name
<Source Folder Path> Explanation

Profile2 Source folder to copy

<Target Store> Explanation

L<::\Expor’rDir Target data store )

Example 13: Copy all subfolders and messages from the mbxUser mailboxin c:\ExchangeDb.edb
to the mailbox at mail@exchserver.local. Use Autodiscover to connect, but do not use Outlook
Anywhere to connect.

RPEX -copy -r -o c:\OutputReport.txt c:\ExchangeDb.edb -1 c:\LogDir -t
c:\TempDir mbxUser mailboxl@exchserverl.local -autodiscover:on -
outlookanywhere:off SROOT

<Operation> Explanation
-copy Perform a copy operation
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<Operation> Explanation

[Operation options]

-r Copy subfolders

-0 c:\OutputReport.txt Output report file name
<Source Store> Explanation
C:\ExchangeDb.edb Path to the database file
[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path
<Source Path> Explanation

mibbxUser Source folder to copy
<Target Store> Explanation

:mailbox@exchserverl .local

Target mailbox (autodiscovery provides the Exchange
environment)

[Target options]

Explanation

-autodiscover:on

Use Autodiscover to connect. Autodiscover will detect the
Exchange server

-outlookanywhere:off

Do not use Outlook Anywhere to connect

<Target Path>

Explanation

L$ROOT

Copy to the root of the mailbox

J

Example 14: Copy all subfolders and messages from the mbxUser mailbox in c:\ExchangeDb.edb

to the mailbox at mbxUser@exchserverl.local. Do not use Autodiscover to connect. Use the

Outlook Anywhere with settings as follows: proxy serveris
exchservervas.exchserver.local,connecting using SSL, use basic authentication.

RPEX -copy-r -o c:\OutputReport.txt c:\ExchangeDb.edb -1 c:\LogDir -t
c:\TempDir mbxUser ExchangeTarget;mbxUser@ExchangeTarget.local -

autodiscover:off -outlookanywhere:on -proxy ExchangeCAS.ExchangeTarget.local
-authentication:basic -SSL $ROOT

<Operation> Explanation

-Copy

Perform a copy operation

[Operation options]

-

Copy subfolders

-0 c:\OutputReport.txt

Outputreport file name

<Source Store>

Explanation

Lc:\ExchongeDb.edb

Path to the database file
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<Operation> Explanation

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path
<Source Path> Explanation

mibbxUser Source folder to copy
<Target Store> Explanation

ExchangeTarget;mbxUser@ExchangeTarget.local

Target Exchange server and mailbox.
Server must be specified because
Autodiscoveris not being used

<Target options>

Explanation

-autodiscover:off

Do not use Auto Discover to connect to
target mailbox.

-outlookanywhere:on

Use Outlook Anywhere to connect to the
target mailbox.

<Outlook Anywhere Required Options>

Explanation

-proxy ExchangeCAS.ExchangeTarget.local

Name of Exchange proxy server for Outlook
Anywhere.

-authentication:basic

Use basic authentication

<Outlook Anywhere Options>

Explanation

-SSL

Use SSL for Outlook Anywhere connection,
required if using basic authentication

<Target Folder Path>

Explanation

L$ROOT

$ROQOT for the root of the mailbox "mbeser"J

Example 15: Export mbxUser 's mailbox and all subfolders from ExchangeDb.edb as text to
c:\ExportDir (export only messages with create date after 01/01/2000 and before 05/01/2000, or
with send date after 01/01/2000 and before 05/01/2000).

RPEX -export -r -f:txt -o c:\OutputReport.txt -d:created-a:01/01/2000-
b:05/01/2000-c:0R -d:sent-a:01/01/2000-b:05/01/2000 c:\ExchangeDb.edb -1
c:\LogDir -t c:\TempDir mbxUser c:\ExportDir

<Operation> Explanation

—export Perform an export operation
[Operation options] Explanation

-r Export subfolders

-fiixt Messages will be exported as .txt

-0 c:\OutputReport.txt

Export report file name
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<Operation> Explanation

-d:created-a:01/01/2000-
:05/01/2000-c:OR -d:sent-
a:01/01/2000-b:05/01/2000

Date criteria - only export messages that were created
between 01/01/2000-05/01/2000 or were sent between
01/01/2000-05/01/2000

<Source Store>

Explanation

c:\ExchangeDb.edb

Path to the database file name

[Source options] Explanation
-l c:\LogDir Log file path
-t c:\TempDir Temporary file path

<Source Folder Path>

Explanation

mioxUser

Source folder to copy

<Target Folder Path>

Explanation

Lc:\Expor’rDir

Target data store

Example 16: Export mbxUser 's mailbox and all subfolders from ExchangeDb.edb as text to

c:\ExportDir (export only (message type or calendar type items) that have any date property

after01/01/2000 and before 05/01/2000).

RPEX —export —-r -f:txt -o c:\OutputReport.txt -type:message;calendar -d:any-
a:01/01/2000-b:05/01/2000

c:\ExchangeDb.edb -1 c:\LogDir -t c:\TempDir mbxUser c:\ExportDir
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Chapter 7: Reporting

Overview

This section shows you how to create reports, view the statistics in the generated reports, and save
the reports as either tab-delimited or comma-delimited text files. Any data store opened as a
source can be the source of areport.

Note: If you use the "Mailbox Criteria (optional)" box on the Select Source Files dialog box or the
Source Selection page of the Data Wizard, only EDB mailboxes containing your entry (or entries)
are displayed on the Source pane. Any mailboxes that do not match the entered string(s) do not
appearin the Source pane and are not be included in any subsequent tasks (such as searching,
copying, and exporting of the entire database). For more information, see "Mailbox Criteria".

Note: If you use the "Multi-Tenancy Criteria" box on the Select Source Files dialog box, the Source
Selection page of the Data Wizard, the Connect to Exchange Server dialog box, or the Target
Selection page of the Data Wizard, only mailboxes contained in the selected Address Book Policy
or Organization appearin the Source or Target panes. Only these mailboxes are included in any
subsequent tasks (such as searching, copying, and exporting of the entire database). For more
information, see "Multi-Tenancy Support".

Creating Reports

You can generate reports on an EDB, PST, or CAS source data store in SEP sesam Recovery Pro. The
reports contain statistics about the data store such as sizes and counts for attachments and
messages, and may be generated per attachment type, domain, mailbox, database, and date.
The Mailbox and Date reports are available for Priv EDB data sources only.

Note: Only accessible mailboxes can generate areport.
To create one or more reports

1. Inthe Source pane, select an EDB, PST, or CAS data source.
2. Onthe Tools menu, click Create Reports. The Create Reports window appears.

» Ifyou selected a Priv EDB as the source for the report, the list pane displays all mailboxes
inthe EDB.

» Ifyouselected a PST or Pub EDB as the source, the list pane displays all folders
immediately under the root of the PST or Pub EDB.
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Create Reports

Selectfolders to include in reports

Falders

Calendar
Cuntacts
Deleted Iterns
Drafts
Inhax
Jnurnal
Nntes
Outbux
[¥] R55 Feeds
Sent Iterns
Tasks

Select All Deselect All

Eeparts

[~ Attachment Statistics
[ Domain Statistics

¥ Messages by Database
o

o

Include messages with a received date in the range

™ On or after | Z{12}2015

=]

[ Onor befare | 2121208

=]

Croup statistics by |{se|ect groups

Message Qptions

~
v

Cenerate Beports

Cancel

Help

Figure 7-1: The Create Reports dialog box
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Create Reports g|

Select profile folders to include in reports Reparts

Profile Folders | [~ Attachment Statistics

| Domain Statistics
¥ Messages by Database
Iv Messages by Profile Folder

[~ Messages by Date

Include messages with a received date in the range
Be 10119/2 =
= onarbeare [ionar ]

Croup statistics by | t _J

Message Options

¥ Include messages in deleted item retention

¥ Include messages not in deleted item retention

Select All Deselect All 5: 1 alu) Cancel Help

Figure 7-2: The Create Reports window fora CAS

3. Do one of the following:

« For Priv EDB: Under Mailboxes, select the mailboxes to be included in the report(s). All

e For Pub EDB or PST: Under Folders, select the folders to be included in the report(s). All

mailboxes are selected by default.

folders are selected by default.

e For CAS: Under Profile Folders, select the folders to be included in the report(s). All folders

are selected by default.

4. Under Reports, select one or more reports that you would like to create:

5. Under Message Options, select the appropriate deleted item retention option(s). Both
options are selected by default. For PST sources, the first optionis cleared. You cannot

Attachment Statistics

Domain Statistics

Messages by Database

Messages by Profile Folder: This report is available for CAS data sources only.
Messages by Mailbox: This reportis available for Priv EDB data sources only.

Messages by Date: If you select thisreport, then specify the appropriate options for

received date range and date unit (for example, hour, day, week, month). Thisreport is

available for Priv EDB and CAS data sources only.

modify the default options for PST sources.

136



* Include messages in deleted item retention: Select this option to include messagesin
deleted itemretention.

Note for Microsoft Exchange Server 2010 and 2013 sources: When the Show
Recoverable Items preference is enabled (for more information, see "Security Tab"),
the messagesin the Recoverable Items folder are included in the reports for
Microsoft Exchange Server 2010 and 2013 sources only if the Include messages in
deleted item retention check box is selected. If the preference setting is cleared,
then the Include messages in deleted item retention check box is unchecked and
disabled for Microsoft Exchange Server 2010 and 2013 reports.

* Include messages not in deleted item retention: Select this option to include messages
that are not in deleted itemretention. In most cases, this option represents most of the
messages in the source data store.

6. Click Generate Reports. The Reports window appears. For more information the contents of
the reports, see "Viewing Reporis".

Viewing Reports

The Reports window shows the progress of the report generation and also shows the reports
themselves. This window consists of a tabbed view of the reports, with each tab containing a
single report.

&7 Reparts [E=8(EoR (>
Database Report |
Database | Curnulative Murmber of Messages | Curnulative Size of Messages | Luserage Size of Messages I Curnulative Size of Sttachmer
kailbox .., 3,468 48,256,951 bytes 13,910 bytes 39,570,526 by
< i ; 3
1 items
Feporting finished successfully.
00h:00m:00s
1l
Help Save... ‘ Close |

Figure 7-3: The Reports progress window
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Single Instance Storage (SIS) vs. Cumulative Counts

The Attachment Statistics and Messages by Database reports use the terms "SIS" (Single Instance
Storage) and "Cumulative" when referring to the number and size of attachments in the data
store. The term "SIS" counts attachments only once and does not include their duplicates. The term
"cumulative"refers to all of the attachments or messages, including their duplicates.

Example: An attachment of type .doc of size 100 KB is being shared by three messages. As the
table shows, the SIS size more closely estimates how much of the EDB size is atftributed to the
attachment.

The cumulative size more closely estimates how much of the EDB size is atfributed to attachments if
the data store did not have SIS.

Method of Counting Attach- Total # of .doc Attach- Total Size of .doc
ments/Messages ments Files
SIS Count 1 100 KB
LCumqu’rive Count 3 300 KB

Attachment Statistics Report

The Attachment Statistics report provides statistics on all of the attachments contained in
messages in the selected source. The attachments are categorized by extension, which appears
in upper case letters (for example, .doc, xIs). Attachments without extensions are putinto a
separate row called "No Extension."

Column Heading Description

Aftachment Extension Attachment type by extension (forexample, .doc, .ppt, .pdf).
Cumulative Number of Cumulative number of attachments of each type found in the
Attachments Foundin processed messages.
Messages
Cumulative Size of Cumulative size of attachments of each type foundin
Attachments messages.
Average Aftachment Size Cumulative size of attachments of each type divided by the
cumulative number of attachments found in messages.
\ y
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Column Heading Description

Percent of Total by Number Number of attachments of each type divided by total
aftachments of all types.

Percent of Total by Size Total size of attachments of each type divided by the total size
of attachments of all types.

SISNumber of Attachments | SIS number of attachments of each type. NA for PST sources.

SIS Size of Attachments SIS size of attachments of each type. NA for PST sources.

SIS Percent of Total by Size SIS size of attachments of each type divided by SIS size of
aftachments of all types in attachment table. NA for PST
sources.

\ J

Domain Statistics Report

The Domain Statistics report provides statistics on messages grouped by the domain from which
the messages were sent.

The domain is determined using the PR_SENDER_ADDRTYPE in combination with the PR_SENDER_
EMAIL_ADDRESS as follows:

o |[fPR_SENDER_ADDRTYPEis"EX" or "SYSTEM," then it is a Microsoft Exchange Server
message and the domainis "infernal.”

+ |[fPR_SENDER_ADDRTYPEis "SMTP", then the domain is whatever follows the @ in the PR_
SENDER_EMAIL_ADDRESS property.

» |fPR_SENDER_ADDRTYPE is something else, then the domain is "unknown."

Column Description

Heading

Domain The name of the domain (for example, www.sepsoftware.com) from
which the message was sent. Allmessages whose domain cannot be
determined are placed into an "unknown" domain. All Microsoft
Exchange Server messages are placed into an "internal" domain.

Number of Total count of messages that were received from each domain.
Messages

Total Size of | Totalsize of allmessages that were received from each domain.
Messages
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Column Description
Heading
Percent of Number of messages from each domain divided by the total number of
Total by messages from all domains.
Number
Percent of Total size of messages from each domain divided by the total size of
Total by Size | messages from alldomains.
\ J

Messages by Database Report

The Messages by Database report provides statistics on the database that contains the processed

messages. In the current version of SEP sesam Recovery Pro, reports are limited to a single EDB or

PST, which means the database report has only one row of information. For example, the
database report for Privl.edb has one row of information listing all message statistics for Privl.edb

and its mailboxes.

Column Heading Description

Database (EDB, PST,
or CAS)

The database name (for example, Privl.edb, Pub1.edb, Microsoft
Office Outlook.pst, Userl.cas).

Cumulative Number
of Messages

Cumulative number of messages.

Cumulative Size of

Cumulative size of all messages processed.

Messages
Average Size of Cumulative size of messages divided by cumulative number of
Messages messages.

Cumulative Size of

Cumulative size of attachmentsin all messages processed.

Attachments
SIS Size of SIS total size of attachments. This column applies only fo EDB sources.
Attachments For PST and CAS data stores, this columnis NA.

\ y
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P>

Create Reports @
Selectfolders to include in reports ~Reports
Folders 1 [T Attachment Statistics
matt
i [ Domain Statistics
orig lots o security [+ Messages by Database
EXCH.00 B
EXCH.01 [T Messages by Mailbox
EXCH.02 s
EXCH.03
EXCH.05 Include messages with a received date in the range
EXCH.06
[ On or after 20217015
EXCH.07 ‘ ided :J
EXCH.08 [~ Onoar befare I 2/12/2015 j
EXCH.09
VX2000.Ev Group statistics by [<selectgroup> -]
VX2003.00
publ.edb )
test Message Options
[ testsecurityfolder ¥ Include messages in deleted item retention
[¥] tom
v Include messages not in deleted item retention
Select All I Deselect All I Cenerate Reports ] Cancel Help J

Figure 7-4: The Create Reports dialog box for a Priv EDB source

Messages by Mailbox Report

The Messages by Mailbox report provides message statistics for all selected mailboxes in a Priv EDB
datastore.

Note: This report is available only for a Priv EDB.

Column Head- Description
ing
Mailbox Name of the mailbox: Display name (alias)
Number of Total number of messages in the mailbox.
Messages
Total Size of Total size of all messages in the mailbox.
Messages
Average Size Total size of messages divided by number of messages.
of Messages
\ /
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Column Head- Description
ing
Total Total size of attachments in all messages in this mailbox. Attachmentsin
Attachment messages in this mailbox that are also in messages in another mailbox are
Size countedin both mailboxes.
Shared Size of attachments that are found more than once, either multiple times in
Aftachment this mailbox or in this mailbox and other mailboxes. Calculated as total size of
Size aftachments minus the non-shared attachment size.
Non-shared Size of attachments that are not shared with other messages.
Attachment
Size
Internal Received messages of type "EX" or "SYSTEM."
Received
Messages
SMTP Received messages of type "SMTP."
Received
Messages
Other Received messages not of type "EX,""SMTP," or "SYSTEM."
Received
Messages
. J

Note: Fora definition of "received message,"see the "Glossary".

Messages by Date Report

The Messages by Date report provides statistics for messages in a date range, such as 1/1/2004 to
1/1/2005, and a unit of hours, days, weeks, or months. The report is keyed off of the received date
of the message.

Note: Thisreport is available only for a Priv EDB and CAS files.

Column Heading

Hour/Day/Week/Month

Description

The date unit that was selected in the Create Reports window.

Examples are: Hour:"12/25/2004 - 9 PM" Day: "12/25/2004" Week:
"12/26/2004 - 1/1/2005" (Weeks start on Sunday and end on
Saturday.) Month: "12/2004"
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Column Heading Description

Messages

Internal Received

Received messages of type "EX" or "SYSTEM."

Total Size of Internall The sum of the internal received message sizes.
Received Messages

SMTP Received Messages | Received messages of type "SMTP."

Total Size of SMTP
Received Messages

The sum of the SMTP received message sizes.

Other Received Messages | Received messages nof of type "EX," "SMTP," or "SYSTEM."

\

Total Size of Other
Received Messages

The sum of the otherreceived message sizes.

Note: For a definition of "received message," see the "Glossary".

Messages by Profile Folder

The Messages by Profile Folder report provides statistics for messages in a profile folder, the number
of messages, total size of messages, average size of messages, total attachment size, shared
aftachment size, non-shared attachment size, internal received messages, SMTP received
messages, and otherreceived messages. The report is keyed off of the profile folder.

Note: The Messages by Profile Folder report only includes information gathered from accessible

mailboxes.

Note: This report is available only for a CAS.

Column Head-

ing

Description

Profile Folder

Title of the profile folder.

Number of
Messages

Total number of messages in the profile folder.

Total Size of
Messages

Total size of allmessages in the profile folder.

Average Size
of Messages

Total size of messages in the profile folder divided by number of messages.
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Column Head- Description

ing

Total Totalsize of attachments in all messages in the profile folder.
Attachment
Size

Shared Size of attachments that are found more than once, either multiple fimes in
Aftachment this profile folder or in this profile folder and other profile folders.
Size

Non-shared Size of attachments that are not shared with other messages.
Attachment
Size

Internal Received messages of type "EX" or "SYSTEM."
Received
Messages

SMTP Received | Received message of type "SMTP."
Messages

Other Received messages not of type "EX," "SMTP," or "SYSTEM."
Received

Messages
.

Note: For a definition of "received message," see the "Glossary".

Sorting Reports

Sorting of reports is available after the reporting process has finished. The order in which stafistics
first appearin the Reports window is based on the ascending order of statistics in the first column
(forexample, for the Attachment Staftistics column, .doc precedes .txt). However, you can sort
statistics based on any column heading.

To sort the statistics in a report

1. Click a column heading to sort the statistics based on that heading. An arrow appears
indicating the sort direction. An up arrow indicates the statistics appearin ascending (A-Z)
order. A down arrow indicates that the statistics appearin descending (Z-A) order.

2. Toreverse the order of the statistics based on that column heading, click the column
heading again. The arrow reverses directions.

An Example of Sorting
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The Attachment Statistics report is originally sorted based on the ascending order of attachment
extensions (for example, .doc precedes .ixi). If you click the Attachment Extension heading, the
down arrow appears and statistics are sorted in descending order (for example, .txt precedes
.doc).

If you click the "Number of Attachments Found in Messages" column heading, the up arrow
appears and statistics are sorted based on ascending order. This means that the attachment
extension occurring least frequently in the data source appears first in the report.

Saving Reports

You may save the currently active report as either a tab-separated or comma-separated text file.
The report name defaults to the name shown on the report tab, without the spaces and with a .ixt
extension (for example, MailboxReport.ixt). The file type defaults to a tab-separated text file.

To save areport
1. Inthe Reports window, make the desired report active by clicking its tab (for example,
Attachment Report, Database Report).

2. Click Save.

3. Inthe Save Report window, specify the name, location, and file type for the report. You may
save the report as either a tab-separated or comma-separated text file.

4. Click Save toretfurn to the Reports window.
5. Repeatsteps 1-4 for each report you want to save.
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Chapter 8: Content Analysis Store

Overview

The content analysis store (CAS) enables you to automate and save search results by selecting
sources. Sources include entire EDB files, individual mailboxes from an EDB, or folders from an EDB.
Any number of sources is allowed, including multiple EDBs.

After selecting specific sources, you can create profile folders as subfolders to the content analysis
store. Each profile folder has the same criteria as the search criteria, such as, "From,""To," "Subject,"
etc. Only messages matching the criteria are contained in the profile. Multiple profile folders are
possible. Every profile folder processes simultaneously. This allows you to make many separate

searches (profiles) for the same set of sources.

After the processing is complete, you can open the content analysis store as a source. This allows
you to use the CAS for searching, copying, exporting, and integrity checks. It allows you to copy
the data out of the CAS into PSTs or to a Microsoft Exchange Server. It allows you to repeatedly use
a specific set of profile results without having to rerun the profile processing. The results of the profile
can be saved between sessions using the CAS. You can also save the CAS on one computer and
reopen it on a different computer to share the results of a profile.

Content analysis stores provide a method for an email administrator fo perform content analysis
offline from their production server. This feature:

= Minimizes the time it takes to detect/filter out emails that include specific content.

= Minimizes the time it takes to detect/filter out a specific type of email file that is being sent or
received (for example, specific extension, subject, date).

= Analyzes the number of emails being sent/received that contain what could be legally
damaging content (for example, admission of guilt).

® Analyzes the number of emails being sent/received that contain politically incorrect
content (forexample, tasteless jokes, pornography).

= Analyzes the number of emails with confidential content that go out unprotected -
unencrypted.

= Minimizes the time it takes to determine if someone is using the system for unauthorized
activity (forexample, spamming, inappropriate downloads, starting a business).

Creating a Content Analysis Store

A new content analysis store can be created from the File menu, from the toolbar, or from the Data
Wizard. After the CAS file is created, a new content analysis store shows in the Target pane.
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To create a content analysis store using the toolbar

1. Onthe toolbar, click the Create/Open Target Content Analysis Store icon ﬁ located on
the toolbar. The Opening a Content Analysis File window appears.

2. Enter aFile name andin the Look in box, select a destination.

3. Click Open. The name of the store defaults to the file name you entered instep 2. It can be
renamed as any other target folder.

To open or create a target Content Analysis Store using the menu

1. Todisplay the Opening a Content Analysis File window, on the File menu, point to Open
Target Content Analysis Store and click Open Existing or Create New.

2. lIf creating a new target CAS, enter a File name and click Open.

3. If opening an existing target CAS, select the CAS from the list and click Open.

To open or create a target Content Analysis Store using the Data Wizard

1. Onthe File menu, click Use Wizard.
2. Onthe Source Selection page, click Content Analysis Store (.cas) in Select Source list.
Data Wizard

Source Selection

Flease select the type of source you want to open and its location. If wou do not want to open a source at this time, click Skip
and select your target.

Select Source:

Content Analysis Store Path (¥ cas)

EDE File {" edb)
COutlook Data File (" pst) || j Browse. ..

Content Analysis Store . cas)

W Run On Startup | Mext > | Skip»» Cancel

Figure 8-1: Selecting a CAS on the Source Selection page

3. Onthe Content Analysis Store (.cas) box, click Browse to open the Create Content Analysis
File window and locate the source CAS.
4. Click Next.

5. Onthe Target Selection page, click Content Analysis Store (.cas) in Select Target list.
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Data Wizard

Target Selection

Please select the type of target you want to open and its location. If you do not want to open a target at this ume, click Skip.

Select Target:

H £
Outlook Data File (*_pst) Content Analysis Store Path (*_cas)

Content Analysis Store (*.cas) | j Browse. ..

Single Mailbox (Office 363)
Single Mailbox {on-premise)
All Mailboxes (on-premise)

< Back | Nea> | Skip>> Cancel

Figure 8-2: Selecting Content Analysis Store on the Target Selection page

6. Do one of the following:
= |fyou know the target CAS file path, type it in the Content Analysis Store Path box.
= Click Browse to open the Create Content Analysis Store window, and navigate to the
desired location. Then create a new CAS file by typing a name in the File name box,
or select an existing CAS file. Then click Open. The path of the target CAS file appears
in the Content Analysis Store Path box.

7. Click Next.

Creating a Content Analysis Store with Microsoft Exchange
Server 2010 and 2013 Data

Any source or target content analysis store (CAS) created with Microsoft Exchange Server 2010
and 2013 datais subject to different handling based on the Recoverable Items preference
settings. For more information, see "Security Tab".

When a CAS is created, whatever the Recoverable Iltems preference setting is at that time will be
stored with that CAS. If you attempt to open a CAS as a source or target, the preference storedin
the CAS is checked against the current preference setting. If they do not match, the following

message displays: "The current "Show Recoverable items' preference setting does not match the
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setting for the Content Analysis Store. The Content Analysis Store cannot be opened unless its
setting is changed. To change the setting the Content Analysis Store, click "OK.' The Content

Analysis Store will be opened as a target and all profiles will be reprocessed. Click "Cancel' to
cancel opening the Content Analysis Store."

Note: If a Microsoft Exchange Server 2010 or 2013 source EDB file has multi-tenancy criteria
applied, it cannot be added to a target CAS file.

Creating and Processing Content Analysis Store Profile
Folders

A content analysis store profile folder is created as a subfolder of the content analysis store to filter
EDB messages (only) based on the profile criteria.

When the profile folderis created, a folder appears under the content analysis store and SEP
sesam Recovery Pro searches all the sources in the content analysis store for messages that match
the criteria for the profile folder.

During processing (searching), the profile folder is green and its status willindicate that processing
is faking place. The status bar at the lower left also indicates the status. The message pane on the
right populates with the results when the profile folder is selected or when the screenis refreshed.

Deduplication can be performed on a per profile basis and if selected does not return duplicates
of a message during a search. For example, if the same message exists in two or more data stores,
only the first message found is listed in the search results. Selecting this option may result in slower
search performance.

Note: Only accessible mailboxes in the EDB source can populate the CAS target profile with
messages.

Note: If asource EDB is opened with multi-tenancy restrictions, it cannot be used as a source fora
target CAS.

To create and process a content analysis store profile folder

1. Select atarget content analysis store root.

2. Inthe Profile menu on the menu bar, click Create Profile. The Create Profile window opens
with "Profile 1" as the default Profile Name. Once created, the content analysis store profile
folder can be renamed just as any folder would be.

3. Enterthe criteria for the content analysis. This window offers similar search options as the Find
window. For more information, see "Finding Messages".

Note: The profile criteria can be saved and imported.
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/® Create Profile Folder

File

Name: | Profile]

Search for words: | Cancel

Exclude words: | Clear Fields

> Help
Search in: ¥ Message Subject [T Arttachment File Name(s)
[ Message Body [ Attachment Text v E"c'"_'de

Duplicates

Sent from: |

Sent to: I

[~ Created Date after: v [~ Created Date before: ) b ]

Figure 8-3: The Create Profile Folder window is used to enter profile criteria

4. Click OK.SEP sesam Recovery Pro indicates that a profile is processing when the color of the
profile folderis green and its status states "Processing." When the profile is selected, the
status shown in the status bar at the lower left of the main window indicates that the profile is
processing. For more information, see "Profile Processing Statuses ™.

5. When the processing for a profile is complete, the color of the profile icon changes from
green to blue andits status states "Completed." Allmessages from the content analysis store
EDBs that match the criteria are contained in the profile folder.

Note: A content analysis store cannot be opened as a source until all profile processing
has completed.

Target: C:\Documents and Settings\ Desktop\PC Test Data\CAS Files\Datawizard\11.15ste

[ 11.15step3 A B0 From | subject | createpate [ DB 2
@ @_ System Admin... Undeliverable: Tue 2/03/2004 ... }
o m Profle 2 (Compdeted) B System Admin... Undeliverable: Tue 2032004 ... 1 |
E @ Personal Folders =l sSyscHECKae... TR el &
-l Bt B4 ] SYSCHECK@c..  LEASE COL.. Tue 2032004 ... 1
: @ Ehl::;rx | |E ) SYSCHECK@c..  LEASE COL.. Tue 2/03/2004 ... 1
-[F8 Contacts B4 ) SYSCHECK@c..  LEASECOL.. Tue 2/03/2004 ... 1
- {7 Deleted Ttems B4 |l SYSCHECK®c..  LEASE COL.. Tue 2j03/2004... 1
53 Drafis B4 |l SYSCHECK®@c.. LEASECOL.. Tue 2/03/2004... 1
=[] Evnodv = Tue 2/03/2004... 1 |
| L. Folder 10 Q Ml SYSCHECK®@c..  LEASE COL.. Tue 2/03/2004... 1/

Figure 8-4: Messages displayed after profile folder created

Note: If the same source is added to the content analysis store twice for processing, SEP
sesam Recovery Pro ignores the second copy. The source is not listed twice noris an error
message displayed.
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The content analysis store profile folder message views include a column to display a database
number to enable you to frace back to the actual database in the content analysis store. This
number does not correlate to the profile folder number or source #, i.e., "Profile1" or "Source 1"
does not necessarily correlate with DB #1. The correlation is between the profile folder message

and the source database.

Example:
™ | 0 | From | Subject | Create Date DB # | Folder | stat
B System Attendant The MicrosoftE... Sat&f17/2006... |1 priv1.edb‘Admi...
B System Attendant The MicrosoftE... Sat&6/10/2006 ... 14 priv 1.edbyAdmi...
Bl System Attendant The MicosoftE... Sat&f03/2006... 1 priv1.edbyAdmi...
Bl System Attendar Hioblc Falder lesrans 1 privi.edbiAdmi...
Bl |l System Attendar — E a1 priv1.edbadmi...
Bl System Attendant  The MicrosoftE...  Sat 5/13/2006 ... 1 priv L.edb\Admi...
oW System Attendant  The MicrosoftE...  Fri 2/03/2006 1... 1 priv1.edb\Admi...
A il [ A A s U FNS e e 1 (e £ R LT YL E 4 S L e
gs\JBrown\Desktop\ PCCAS Test Data\CAS HIes\Datawizard‘-,;bl.lSsteplcas
M| 0 | From | Subject | Create Date DB £ ||Folder | stat
G4 Systemn Adminis...  Undeliverable: Tue 2032004 ... | 1 privi.edbiUser ...
G4 System Adminis... Undeliverable: Tue 2/03/2004 ... | 1 priv1l.edb\User ...
B SYSCHECK®@¢si... LEASECOMMI... Tue 2/03/2004... 1 privl.edb\User ...
= SYSCHECK @csi LE Content Analysis Store Message priv1l.edb\User
1M SYSCHECK@csi... LE privl.edbUser ...
W SYSCHECK@csi... LEASE COMMI... Tue 2/03/2004... 1 priv1.edbUser ...
Bl [l SYSCHECK@csi... LEASECOMMI.. Tue 2/03/2004.. 1 priv1.edbiUser ...

Figure 8-5: The Database numbers are tied to the actual database.

Note: Database (DB) numbers are tied to the actual database, not the folder so each folder from

the same EDB will have the same DB number. DB numbers increment from 1 for each different

database added to the content analysis store, not for each folder.

When the profile is processing, there are four possible statuses that are displayed: Processing,

Suspended, Completed, and Completed with errors.

|Target: C:' Documents and Settings', bs

= @] asdf
(8 Profilel (Completed)
- [£8 Profile2 (Suspended)
‘ IE Profile3 {Processing)

m Profile2 {Completed with errors)

Figure 8-6: Profile Processing Status folders are indicated by different colors
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Processing

After entering the profile criteria, the profile is created and is represented by a folder under the
content analysis store. During processing (searching), the profile folderis green and its status states
"Processing." Selecting the profile folder or pressing F5 populates the message pane with
messages when the processing is complete.

Processing occurs when a new profile is created, when removing a source, when adding a
source, when editing a profile, when copying a source profile folder to a target content analysis
store, or when resuming a suspended profile.

Note: If unrecoverable errors are encountered during processing then the profile is not fully
processed and is blue in color with a red lindicating the error.

Suspended

Processing can be suspended on any profile folder during processing. Suspended profile folders
arered in color. The status also indicates that the profile is suspended. For more information, see
"Suspending and Resuming Content Analysis Store Profile Folders".

Completed
Once the processing is complete, the profile folder turns blue and its status states "Completed.”
Completed with errors

If SEP sesam Recovery Pro detects corruption or some otherissues while processing, the profile
folder status states "Completed with errors." To obtain details on the error, view the Properties on
the profile folder by right-clicking on the profile folder and selecting Properties.

Properties of Profile1

Full Path: Content Analysis Store' Profilel
Number of Messages: 127

Approximate Total Size of Messages: 0 Bytes

Number of Messages Processed: 641
Status: Finished counting.
Processing State; Completed processing with errors. Errors were encountered

when writing the Content Analysis Store. (0x00000000)

OK | Help

Figure 8-7: An error message displays when processing cannot be completed

Profile criteria can be saved and laterimported intfo a new profile in the Create Profile window to
save time.
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To save a profile criteria

1. On the File menu, click Save Criteria.

2. Inthe Save As window, enter a File name and click Save. Be sure to note where the criteria
file is being savedin the Look in: box.

Note: The profile folder name is not saved.
To import saved profile criteria

1. Onthe File menu, click Use Previous Criteria.
2. Inthe Open window, select the previously saved profile criteria .txt file.

3. Click Open. All previously saved profile criteria, except for the Profile Name, reads from the
file andis placed into the Create Profile fields.

4. Enter a new Profile Name.

Note: Search criteria from previous and current versions of SEP sesam Recovery Pro can be
importedinto SEP sesam Recovery Pro for find and profile criteria.

Suspending and Resuming Content Analysis Store Profile
Folders

You can pause the processing of one or more profile criteria folders and then resume processing
at alater time. Suspended profile folders are red in color and then turn to green when processing is
resumed. The folder then turns to blue when processing is complete. For more information, see
"Profile Processing Statuses ".

Processing of all profiles is suspended automatically if you exit SEP sesam Recovery Pro orif you
close the content analysis store before processing is complete.

To suspend the processing on profiles

= Do one of the following:

« Select the profile folder, click the Profile menu and click Suspend Processing.
* Right-click the profile folder and click Suspend Processing.

To suspend processing on all profiles

® Do one of the following:

« Select the content analysis store root, click the Profile menu and click Suspend
Processing.

* Right-click the content analysis store root and click Suspend Processing.

Note: Suspended profiles are red in color. The status also indicates that the profile is suspended.
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To resume processing on profiles
= Do one of the following:

* Select a profile folder, click the Profile menu and click Resume Processing.
¢ Right-click the profile folder and click Resume Processing.

To resume processing of all profiles

= Do one of the following:

e Selectthe content analysis store root, click the Profile menu and click Resume
Processing.

e Right-click the profile folder and click Resume Processing.

Adding Sources to Content Analysis Stores

Only EDB store objects, EDB mailboxes, or EDB folders can be dragged or copied and pasted from
the source into the new content analysis store root to prepare for analysis.

If you open asource with a set of mailbox criteria, create a CAS using that source, then close and
re-open the source with different mailbox criteria, no additional folders or mailboxes can be
added from that source. Re-open the source with the matching mailbox criteria orremove all
references to the original source before re-adding.

Note: Messages or folders cannot be copied directly to a profile folder (results folder).
To add a folder, a mailbox, or an EDB file with copy-paste

1. Inthe Source pane, select a folder, a mailbox, or an EDB file.
2. Do one of the following:

On the Edit menu, click Copy.

Right-click the selected item(s), and on the shortcut menu, click Copy.

Click the Copy Madil ltemicon ¥ onthe toolbar.
Press Ctrl+C (Copy).

3. Inthe Target pane, click the content analysis store root and do one of the following:

On the Edit menu, click Paste.

Right-click the selected item, and on the shortcut menu, click Paste.

* Click the Paste icon r;:l on the toolbar.
Press Ctrl+V (Paste).
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4. Inthe Copy Progress window, verify that your messages were successfully copied, and click
Close.

To add data even faster, use dragging

= To move entire EDB store objects, EDB mailboxes, or EDB folders, drag to the target content
analysis store root. Dragging achieves the same results as copying and pasting.

To drag when right-clicking a source item

1. Inthe Source pane, select one or more messages.

2. Right-click the selected message containers and drag them to a content analysis store in
the Target pane.

3. Release the mouse and on the shortcut menu, click Paste.

If anew source (Inbox, Deleted items, Outbox, etc.) is dragged to the content analysis
store or the userremoves a source store from the content analysis store, all profiles
automatically process the new source.

Editing and Deleting Profiles

Deleting a profile stops any processing on that profile and removes that profile and all data
associated with it from the content analysis store. Deleting a profile does not modify the EDB
sources.

To edit a profile

1. To edit a profile, right-click the profile folder and click Edit Profile or on the Profile menu,
select Edit Profile.

2. On the Edit Profile Folder window, edit any or all of the criteria. When new criteria is entered,
allmessages in the profile are deleted, the icon changes to its processing color (green), the
profile status willupdate, and the process begins.

To delete a profile

= Do one of the following:
e Right-click the profile folder and click Delete.
¢ Click profile folder, and on the Edit menu, click Delete.
e Select the profile folder and press the Delete key on the keyboard.

Closing a Content Analysis Store

Closing a content analysis store root closes the root as well as all of the profile folders created
under that roof.
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To close a content analysis store (CAS)

= Do one of the following:
e Right-click the CAS and click Close Store.
¢ Clickthe CAS and on the File menu, click Close Store.

Opening a Content Analysis Store as Source

When all profile processing has completed, you can open the content analysis store as a source,
for which the following source operations can be performed: Copy/Paste, Paste Special, Export,
Find, Integrity Check, Properties, and Create Reports. Use copy/paste to copy source profile
search criteria to a target content analysis store.

Note: Opening a Content Analysis Store with Microsoft Exchange Server 2016 orlater data is not
supported. When a CAS open as a source containing Microsoft Exchange Server 2016 or later
data, you have the option to open the CAS as a target and remove all Microsoft Exchange Server
2016 or later data.

If a content analysis store is opened as a source and it has not completed processing all profiles, a

window indicates that the content analysis store has not completed its processing. There is then an
optionto openthe CAS as a target. If that optionis selected, SEP sesam Recovery Pro opensitasa
target and resumes processing on all remaining profiles.

To open a content analysis store as source

1. One the File menu, click Open Source.

2. Onthe Select Source Files dialog box, click Browse fo the right of Source File (*.edb, *.pst,
*.cas).

3. Inthe Open dialog box, select a.cas file and click Open.

4. Inthe Select Source Files dialog box, click OK. A source content analysis store appearsin
the left pane of source.

| Target: C:\Documents and Settings\ Desktop\test.pst

=8 11.15step2 A DLW From Subject
m Profile1 (Completed) 4 Testa engr RE: test meeting
(3 Profile2 (Completed) x| Testa engr RE: message 2
+ @ Content Analysis Store

=~ Personal Folders
[ Calendar
[ Contacts
+-[7| Deleted Items

Figure 8-8: A source content analysis store root and profile folders
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Viewing Properties of a Content Analysis Store

To view the properties of a content analysis store

= To display the CAS File Properties window, right-click the CAS in either the Source or Target

pane and click Properties.

CAS File Properties

Number of Source Containers: o
Mumber of Profile Folders: 2
Number of Messages: 248
CAS Creation Time: 10/12/2006 13:50:43
Size of CAS File: 0O MBE
D Help

Figure 8-9: The Properties of the selected CAS file
To view the properties of a content analysis store profile folder

= Right-click the profile folder and click Properties.

Properties of Profile1

Full Path: 11.15step] 25 Profilel
Number of Messages: o

Approximate Total Size of Messages: O Bytes

Number of Messages Processed: ]
Status: Finished counting.
Processing State; Completed Processing

OK | Help

Figure 8-10: The Properties of the CAS profile folder

Creating Reports in Content Analysis Store

You can create reports of the source content analysis store by right-clicking the source content
analysis store root. The reports are:
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= Attachment statistics

= Domain statistics

= Messages by Database

= Messages by Profile Folder
= Messages by Date

Forinstructions on creating reports, see "Reporting ".

Viewing Profiles in Content Analysis Store

The Viewing Profiles option allows you to view what profile criteria has been used for a specific
content analysis. All fields are read only.

To view a profile

1. Do one of the following to display the Profile Folder Properties page:

* Right-click the profile folderin either the Source pane or Target pane and point to View
Profile Folder.

¢ Click the profile in either the Source pane or Target pane, click the Profile menu and
click View Profile Folder.
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Profile Folder Properties

Mame:; Profilel

Search For:

Exclude:

Search In: Message Subject

Sent From: l

Sent To: ]

Dated After: l

Dated Before: I

Duplicates: ‘ Check for duplicate messages.

oK

Figure 8-11: Profile Folder Properties

2. Click OK to exit.

Missing Database Files

If an EDB or log file that belongs to a content analysis store is moved and then the content analysis
store is opened, there is a prompt to find or remove the missing database files. If the EDB is located
but the STM is missing, SEP sesam Recovery Pro displays an error indicating that the STM needs fo
be located in the same directory as the EDB.

Missing EDB

When there is a wrong EDB, you are prompted to locate the file.
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To locate the missing EDB

On the Missing Database File error message, click Browse. The Open window appears.
Navigate to the EDB files and double-click the appropriate file.
Click OK. The Source pane now populate with files.

Moo bd -

If you are unable to locate the EDB file, click Remove on the Missing Database File error
message.

5. When asked to confirm, click OK.

When an EDB isremoved, the complete source EDB isremoved from the CAS as well as any
source folders or mailboxes that also reference that EDB.

When there are missing log files, you are prompted to locate the log directory. The Browse button
opens a Browse for Folder dialog and defaults to the last known location of the logs.

To locate missing log files

1. Onthe Missing Database File error message, click Browse. The Open window appears.

2. Navigate to the directory containing the logs and click OK. The Source pane now populates
with files.

When logs are removed, the complete source EDB isremoved from the CAS as well as any
source folders or mailboxes that also reference that EDB and logs.

When there are missing .stm files, you are prompted to remove the files.

To remove missing .stm files

1. Onthe Missing Database File error message, click Remove.
2. When asked to confirm, click OK.

When the .stmfile isremoved, the complete source EDB isremoved from the CAS as well as
any source folders or mailboxes that also reference that EDB and .stm.

When there are missing temp file directory locations, you are prompted to locate the temp file
directory location. The Browse button opens a Browse for Folder window and defaults to the
current temporary path set by SEP sesam Recovery Pro.

To locate missing temp file directory location

1. Onthe Missing Database File error message, click Browse. The Open window appears.
2. Navigate to the directory containing the temp files.
3. Click OK.The Source pane now populates with files.
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Note: If just the temp files are missing but the directory exists, it recreates the temp files.

Wrong Database Files

When SEP sesam Recovery Pro finishes opening the EDB, it checks the database for the correct file
in the content analysis store. If it does not locate the correct file, it determines that there is a
different EDB at the original location than when the CAS was originally created. An error appears
and prompts you to remove the file from the CAS.

To remove wrond files

1. Onthe Wrong Database File error message, click Remove.

2. Amessage appears asking if you are sure you want toremove the source and allrelated
messages from the content analysis store. Click OK.

161



Chapter 9: Message Views

Overview

You can view allinstances of a given message or attachment in the EDB source(s) within the same
database as well as messages related by conversation in the Message Views option. This option is
particularly useful in assisting with administrative tasks such as database cleanup activities,
determining the history or dissemination of a message, or grouping messages by conversation
thereby allowing you to view them togetherin context without missing a reply or forward.

Message views are available for messages in the Source pane, find results pane, and also from
another message view. Message views are available only on single messages. If multiple messages
are selected in the message pane, the message view menu items and toolbar buttons are
unavailable.

You can view a message in various ways, depending on the message view option selected. Upon
option selection, you are presented the following:

= Message Table View - All the messages that are referenced by the same message table row
as the selected message.

= Attachment Table View - All the messages that have an attachment that are referenced by
the same attachment table row as the selected attachment.

= Conversation View - Messages that are related by conversation, with the sorting order of the
email thread based on who replied to whom within the thread. Messages are indented to
show the thread timeline of when replies occurred.

Note: If you use the "Mailbox Criteria (optional)" box on the Select Source Files dialog box or the
Source Selection page of the Data Wizard, only EDB mailboxes containing your entry (or entries)
are displayed on the Source pane. Any mailboxes that do not match the entered string(s) do not
appearin the Source pane and are not be included in any subsequent tasks (such as searching,
copying, and exporting of the entire database). For more information, see "Mailbox Criteria".

Note: If you use the "Multi-Tenancy Criteria" box on the Select Source Files dialog box, the Source
Selection page of the Data Wizard, the Connect to Exchange Server dialog box, or the Target
Selection page of the Data Wizard, only mailboxes contained in the selected Address Book Policy
or Organization appearin the Source or Target panes. Only these mailboxes are included in any
subsequent tasks (such as searching, copying, and exporting of the enfire database). For more
information, see "Multi-Tenancy Support".
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Message Views Menus and Toolbars

The message views are accessible via the Tools menu, toolbar buttons, and a sub-menu on the
shortcut menu in the message panes.

Message Views Menus

The Tools menu contains a sub-menu with menu items for each message view.
File Edit View Profle  Help
$E8° T @ b
Integrity Check Ctrl+I %
Source: C:\Docun Fktop\Test Data\Exch
- Adminis B Message Table View
[ cal
42 Find...

Ed] Cot F3 B Attachment Table View
D Deleted Items ]E i ﬁi Conversation View

A Do

Figure 9-1: The Tools menu leads to the Message Views options

Message Views Toolbar Icons

A toolbar button exists for each message view: Message Table View, Attachment Table View, and
Conversation View.

1 Conversation View
AN~ Eﬁfjﬂ 7|8

Message Table View Attachment Table View

Figure 9-2: The toolbar provides another option for accessing the Message Views

Message View Shortcut Menu

The Source pane shortcut menu has a Message Views sub-menu with menu items for each
message view. As with the main menu, the new Message Views menu items provides status bar
text when they are highlighted.
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™ | 0 | From | subject | Create Date | status

(= W]  Aaaa Mexchsd 1e 10,05/200. ..

------- Integrity Check Ctrl+1
B4 ] HasaTexchss oty b se 10,05/200...
Bl |l BaaaMexchss Cpen Ctrl+0 ae 10,05/200, ..
B Baaa Nexchss 2§ Copy Ctrl4C ae 10/05/200...
Ed ]l EsaaQexch55  gaject Al Cirl+a  fe 10/05/200...
k4 Eaza Qexch55 4 ae 10/05/200...
| &, Export... Cirl+P
5 @ FaaaRexchss _be 10/05/200...
5

Aaaa MexchEEi r p‘ Message Table View

| @ Attachment Table View
.ﬁ’: Conversation View

Figure 9-3: The Message View options can be reached by right-clicking an EDB message in the
upper message pane.

Tt T e e =,

Open Message Table View.... 1

Figure 9-4: The Status Bar

Message View Pane

The Message View Pane is the area that hosts the various message views. The pane provides you
the ability to view the related messages and perform various actions (for example, viewing
messages in alfernate views, exporting messages to your directory, checking the integrity).

Other Options Available in the Message View

Other actions can be performed within a Message View, such as Exporting messages, Integrity
Check, copying messages, and viewing a message in another Message View.

+% Conversation View - Welcome to Microsoft Outlook 2000!
File Edit Bk
Export... Ctrl+P

Message ' 1oty Check Cirl+l k=R
1 Message Table View Folder
. =M 0 : Attachment Table View
=1 I Microsoft Outl... | Conversation View privi e
4 [ﬂ Microsoft Qutl... . Welcome to Mi... privl.e

Figure 9-5: Other options available in the Tools menu are Copy, Export, and Integrity Check

These options are available in any Message View:
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= Copying Messages-Messages within a Message View can be copied and pasted into
foldersin the Target pane via the Edit menu or shortcut menu. For more information about
copying messages, see "Restoring Microsoft Exchange Server Data".

= Exporting Messages-Messages within a Message View can be exported as any message
can via the Tools menu or shortcut menu. For more information, see "Exporting Messages".

= |ntegrity Check -Messages within a Message View can have an integrity check performed
on them via the Tools menu or shortcut menu. For more information, see "Looking at the
Interface”.

= Message Views -Messages within a Message View can be viewed in any of the three
Message View options, Message Table View, Attachment Table View, or Conversation
View. The message view options are only available if a single message is selected.

Message View Options

You have the option of viewing allinstances of a given message or attachment in the EDB source
(s) inthree different ways-Message Table, Attachment Table View, and Conversation View.

Message Table View

Choosing the Message Table View option displays all the messages from the same EDB that
reference the same message table row (Single Instance Storage).

Example:

A message is sent to Userl, User2, and User3. The message is stored in the message table once. If a
user opens up the database and right-clicks the message in Userl's Inbox and chooses Message
Table View, a table opens with three messages in it: One in Userl's Inbox (or deleted items), onein
User2'sinbox, and one in User3's Inbox as long as they are allin the same Microsoft Exchange
Server database (EDB). If User 1, 2, or 3 are in a different EDB, those messages will not appear in this
view.

Sample
B | 0 | From | subject | Create Date | status
% JUI Aasa Mexchssb-out0  IRGEReHAE-ou... Tue 10/05/200...
C4 ) HasaTexchSsb-oul?  wggflvjky-oups... Tue 10/05/200...
B4 ] BaaaMexchSsb-outll  PmpGxhHeg-ou... Tue 10/05/200....
k4 Baaa NexchSSh-outl  YxriEQbxS-oup... Tue 10}'05;"20&...&. Deleted
Ed I EasaQexchSsb-outld  FyiACrald-oups... Tue 10/05/200...|. Delated
| Eaaa Qexch55b-outid  VPYggRYQr-ou... Tue 1um5fmo...i Deleted
B4 |l FaaaRexchS5b-outl5  CXTCloSMl-oup... Tue 10/05/200...° !
E4 Aaaa MexchSSb-outld  FBMURxGFg-ouw... Tue 10/05/200...

Figure 9-6: The Message Table View displays messages that have been deleted.
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The message pane displays the related messages in areport format showing the Message Type,
Attachment, From, To, Subject, Folder, Date, and Status (indicating if message has been deleted).

Note: Only messages within the same EDB can be viewed in the Message Table View.
To open and view messages in the Message Table View

1. Inthe message pane, select an EDB message.
2. Do one of the following to display the Message Table View:

* Click the Message Table View icon +" on the toolbar.
¢ Right-click a message and point to Message Views, then click Message Table View.
¢ Clickthe Tools menu, point fo Message Views, then click Message Table View.

Note: The first time opening a view on this EDB, a message appears stating that a Message
View file needs to generate.

Attachment Table View

Choosing the Attachment Table View option displays all of the messages in the same EDB that
have an attachment referencing the same attachment table row as the selected attachment
(Single Instance Storage). If the message contains multiple attachments, a sub-menu listing each
individual attachment allows the selection of an individual attachment.

Note: The Attachment Table View does not support Microsoft Exchange Server 2007 or later
sources, as Microsoft stopped supporting single instance storage with Microsoft Exchange Server
2007.

Example:

A message with an attachment is sent from User1 to User2 and User3. User3 forwards the email to
User4. The attachment is stored in the attachment table only once (single instance storage). A
user opens up the Microsoft Exchange Server database (EDB) containing these messages and
creates an Attachment Table View on the message in User's "Sent [tems" folder. The Attachment
Table View contains five messages: one in Userl's Sent Items, one in User2's Inbox, one is User's
Inbox, one in User3's Sent Ifems and one in User4's Inbox as long as they are allin the same EDB.

As in the Message Table View, the Attachment Table View shows the related messages in areport
format with Message Type, Attachment, From, To, Subject, Folder, Date, and Status (including
indicating if message has been deleted).

Note:

= Only messages with attachments can be viewed in the Atftachment Table View.
= Only attachments within the same EDB can be viewed in the Attachment Table View.

= Attachments within inaccessible mailboxes cannot be viewed in the Attachment Table
View.
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To open the Attachment Table View

1. Inthe message pane, select a message.
2. Do one of the following to display the Atachment Table View:

* Click the Attachment Table Viewicon *~ on the toolbar.
* Right-click a message and point to Message Views, then click Attachment Table View.
* Clickthe Tools menu, point fo Message Views, then click Attachment Table View.

Note: The first time opening a view in this EDB, a message appears stating that a Message
View file needs to generate.

‘#7 Attachment Table View - Welcome to Microsoft Outlook 20... D@
File Edit Tools

1&xchange.gif __‘_'_J

O I [m ]Frum To Subject Folder ]
E. [m Microsaoft Outl... Welcome to Mi... priv] edb\Ad...

< | >

l Message [temi(s)

Figure 9-7: The Attachment Table View displays messages with attachments

3. Toview a message within the Attachment Table View, right-click a message, point to
Message Views and select one of the following options:

* Message Table View
« AttachmentTable View
* Conversation View

4. Any message in the Atftachment Table View can be opened by double-clicking the
message in the table.
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Conversation View

Choosing the Conversation View option displays the messages that are related by conversation
showing the Message Type, Attachment, From, To, Subject, Folder, Date, and Status (including
indicating if message has been deleted). Messages are indented to show the chain of replies and
forwards.

Example:

If a user composes and sends Email 1 to another user, and that user sends Email 2, a reply to Email
I, then Email 1 has no indention and Email 2 isindented one level. If the first user then replies to
Email 2 with Email 3, then Email 3 is indented two levels.

Note:

® Only conversation threads within the same EDB can be viewed in the Conversation View.
= Messages within inaccessible mailboxes cannot be viewed in the Conversation View.

To open a Conversation View

1. Inthe message pane, select a message.
2. Do one of the following to display the Conversation View:

. #

Click the Conversation View icon ¢ on the toolbar.
* Right-click a message and point to Message Views, then click Conversation View.
e Click the Tools menu, point fo Message Views, then click Conversation View.
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,&j Caonversation Wiew - Annual Employee Reviews EI@

File Edit Tools

Message - Annual Employee Eeviews

i ] 1] | Fram To Subject 1 Folder

E. 1 hanager, Mary Supervisar, Sara  Annual Emplo..  Mailbox Store...
4 [U] Manager, Mary Supervisor, Sara Annual Emplo..  Mailbox Store.. .
4 . Supervisor, 5. Manager, Mary Ee: Annual E.. Mailbox Stare....
o . Supervisor, 5. Manager, Mary Fe: Annual E.. Mailbox Stare....
s .. Manager, M... Supervisar, Sara  Re: Annual E.. Mailbox Stare....
B4 .. Manager, M... Supervisor, Sara  Ee: Annual E.. Mailbox Store....
4 |_ m, _; F

s Message Itemis)

Figure 9-8: The Conversation View displays the conversation threads which are indicated by
indentations.

Note:

» Thefirst time opening a view on this EDB, a message appears stating that a Message
View file needs to generated.

« [fthe first message is missing, the next message in the thread is stillindented indicating
thatitis not the original message.

. To view a message within the Conversation View, right-click a message, point fo Message
Views and select one of the following options:

» Message Table View
« Attachment Table View
+ Conversation View

. Any message in the Conversation View can be opened by double-clicking the message in
the table.

Opening a View for the First Time

The first time you create any Message Table View, Attachment Table View, or Conversation View,
SEP sesam Recovery Pro creates a Message View file. If no file exists, you are prompted to create
the file.
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To create a Message View for the first time
1. When the No Message View File dialog box appears, click Yes to create the file.

Mo Message View File |E!

Mo message view file exists, Would vou like to create a message wiew File?

Yes Mo

Figure 9-9: This message informs the user that an initial message view file does not exist

A progress window appears displaying the stage, progress text, estimated time, elapsed
time, and a grow bar.

For Microsoft Exchange Server 2007 and earlier, there are 5 stages: Initializing file,
Processing attachments, Processing messages, Processing rows, and Saving file.

For Microsoft Exchange Server 2010 and later, there are 3 stages: Creating the file,
processing the conversation messages, and saving the file.

After the message view file has been created, if creating a Message Table View, the
Creating Message View File progress window is replaced by another progress dialog that
tracks the progress of view preparation. A Preparing Message Table View progress window
appears.

If you click Cancel during this process, the Message Table View is not shown.

3. Toview a message within the Message Table View, Attachment Table View, or
Conversation View, right-click a message, point o Message Views and select one of the
following options:

» Message Table View
+ Attachment Table View
+ Conversation View

4. Toopen amessage in the Message Table View, Attachment Table View, or Conversation
View, double-click the message in the table.

Find in Source Window in Message Views

You can open a message view from the Find in Source window by using the Message Views sub-
menu on the Find Window's top-level Tools menu. The messages in the Find in Source window's
results pane also have the Message Views shortcut menu by right-clicking on a message and
pointing fo Message Views.
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To open messages in Find in Source window result pane in different views

1. Click the Find icon IO on the toolbar.
2. Inthe Find in Source window, enter search criteria in the appropriate fields.
3. Click Find Now. The Results pane appears with the search results.

I) Find in Source EI

File Edit Tools

i* Search in folder: ISource 1 - Mailbox Store edb\VWicePresident, Victor\5¢  Browse. . I Find Mow

i Search in results: Stap

Search far words:l Previous

Exclude words: I copy Clear Fields

Clear Results

i

Searchin: ird Message Subject [ Attachment File Mame({s)
[ Message Body [ Attachment Text Help
Sent from: I
Sentto: I
Drate: iCreated ;! !_After:l 2f18{2015 'II_Befnre:I 2{18/z015 'I Save Report...
Results
Bl ow | From | T | subject | Create Date | source# | Folder | s
| WicePresident, ... Directar, Darla Widget 3000 Thu 11302700, 1 hlailbon Stare...,
E4 YiceFresident, ... Directar, Da e e e | 11 ik Iwlailb tOrE....
1 YicePresident, ... Director, Da Integrity Check Ctrl+1 n. 1 hlailbox Store,..,
E4 WicePresident, .. President, P Open Ctrl+0Q D6, 1 hlailbox Store...,
Copy Ctrl+C
Select Al Ctrl+2,
Export... Ctrl+P
Message Wiews 2 kessage Table Wiew
Attachment Table Yiew
| = Carrversation Wiew

|Search Complete - 4 Message Iterm(s) Matched Criteria

Figure 9-10: The Find results can be displayed in each of the Message Views

4. Do one of the following:

¢ Click the Tools menu, point fo Message Views, then click the desired view in the sub-

menu.

« Right-click the message, point to Message Views, then click the desired view in the sub-

menu.
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Glossary

Term Description

ABP Address Book Policies. With this feature, you canrestrict the users and
mailboxes they can view when sending emails in an environment using
Microsoft Exchange Server 2010 SP2 and later. Users can be assigned ABPs.
ABPs include a Global Address List (GAL) that defines the mailboxes a user
assigned an ABP can view.

Attachment A table that displays all the messages that have an attachment referenced
Table View by the same attachment table row as the selected message.

CAS See Content Analysis Store

CHK Checkpoint files (.chk files) are used forrecovering (playing) data from

fransaction logs into EDB files. The checkpoint is the place markerin the
EDB.CHK file that indicates which fransactions have been committed.
Whenever datais written to an EDB file from the transaction log, the
EDB.CHK file is updated with information specifying that the transaction was
successfully committed to the respective EDB file. Separate Exx.chk files are
maintained for each storage group using ESE (Extensible Store Engine).

Content Analysis | A data store type where each message in the root level container identifies
Store(CAS) asource container. A source container can either be an EDB, an EDB
mailbox, or an EDB folder. The CAS is used to analyze messages based on
profile criteria entered before processing.

Conversation A table that displays all messages in the database that are related by
View conversation. The conversation thread isindented to indicate replies.
Data Store A unified collection of folders and messages contained in asingle storage

medium. A PST file is a data store. A Microsoft Exchange Server Information
Store is also a data store. In a basic case, Microsoft Exchange Server has
two live data stores, one for the private mailboxes and one for the public
folders.

Data Wizard The first fime you start SEP sesam Recovery Pro, the Data Wizard starts. The
Data Wizard guides you through the loading of Microsoft Exchange Server
Database (EDB), PST files, or content analysis store (CAS) files into SEP sesam
Recovery Pro, and shows you how to specify the target PST file or Microsoft
Exchange Server.
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Term Description

Deduplication

Deduplicationis performed on a per profile basis and if selected does not
return duplicates of a message during a search. For example, if the same
message exists in two or more data stores, only the first message found is
listed in the search results.

Organization(or
Hosted
Organization)

EDB See Microsoft Exchange Server Database.

EIS See Microsoft Exchange Server Information Store.

Exchange An organizational unit created in an environment that has deployed
Hosted Microsoft Exchange Server 2010 SP1 or SP2 using the /hosting switch (Hosting

Mode). Users and associated mailboxes created in a hosted organization
can only see other users and mailboxes created in the same hosted
organization.

Log Files

Transaction log files (.log files) are history files recording server activity. These
files are usefulin restoring and backing up Microsoft Exchange Server data.
Transaction logs for Microsoft Exchange Server 5.5, 2000, and 2003 are 5 MB
insize. Transaction logs for Microsoft Exchange Server 2007 and later are 1
MB inssize.

Messages

Messages are found in the folders of a Microsoft Exchange Server
Information Store. Messages can mean "email,”" but Microsoft Office
Outlook Contacts are also messages, as are Appointments, Journal Enfries,
Sticky Notes, and Tasks.

Message Table
View

A table that displays all messages that are referenced by the same
message fable row as the selected message. For example: A message that
is sent to three different users appears three times, one in each user's Inbox.

Microsoft
Exchange
Server Database

This file, which usually has an EDB extension, contains the mailbox, folders,
and messages you see when connecting to a Microsoft Exchange Server.
The Microsoft Exchange Server reads and writes to this file inresponse to
incoming email and events from the clients. On Microsoft Exchange Server
2000, thisis one of the two files that make up the Microsoft Exchange Server
Information Store, the other being the STM file.
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Term Description

Microsoft This is the set of files that compose the data store for private mailboxes and
Exchange public folders on a Microsoft Exchange Server. On Microsoft Exchange
Server Server 5.5, thisis the single Microsoft Exchange Server Database file usually
Information named privl.edb and publ.edb. On Microsoft Exchange Server 2000 and
2003, the private mailbox data store consists of the files priv1.edb and
priv1.stm and the public folder data store consists of pub1.edb and
publ.stm. On Microsoft Exchange Server 2007 and 2010, a private mailbox
data and public folder store consist of the EDB file without a STM file. On
Microsoft Exchange Server 2013 or later, a mailbox data store consists of the
EDB file without a STM file.

Store

Multi-Tenancy Supportincludedin SEP sesam Recovery Pro for mulfi-tenant deployments
Support of Microsoft Exchange Server 2010 and later. Specifically support is

provided for environments that are utilizing the Microsoft Exchange Server
2010 SP1, SP2 Hosting Mode or Microsoft Exchange Server 2010 SP2 and later
Address Book Policy feature. Support includes the ability to limit the source
and target mailboxes a user can access based on Exchange Hosted
Organizations or Address Book Policies.

Forinformation regarding Hosting Mode using the "/hosting"” switch, see
http://technet.microsoft.com/en-us/library/ff923272.aspx
and

http://social.technet.microsoft.com/wiki/contents/articles/1110.
exchange-2010-sp1-information-for-hosted-service-providers.aspx.

Forinformation regarding Address Book Policies, see
http://technet.microsoft.com/en-us/library/hh529948.aspx
and

http://technet.microsoft.com/en-us/library/hh529916.aspx.

PAT Patchfiles (.pat files) are used to record information on page splitsin
Microsoft Exchange Server 5.5 through Microsoft Exchange Server 2000
(SP1).In Microsoft Exchange Server 2000 (SP2) and later, the functionality
provided by .pat files is incorporated into Microsoft Exchange Serverlog
files.

Profile Folder A subfolder of the content analysis store containing the results of profile
criteria entered for processing.
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Term Description

PST Personal Storage file. This file, used by Microsoft Office Outlook, contains
folders and messages that have beenretrieved from a user's Microsoft
Exchange Server mailbox and copied locally.

Received Messages that have been sent through a Microsoft Exchange Server to
Messages another mailbox. Messages in the "Sent ltems" folder are copies of messages
sent through a Microsoft Exchange Server and are not considered to be
"received messages." Because messages in the "Drafts" folder, "Notes"
folder, and other similar items are not sent through a Microsoft Exchange
Server, they too are not considered to be "received.”

Note: Because recovery software such as SEP sesam Recovery Pro restores
messages from a source to a Microsoft Exchange Server mailbox without
sending them, the messages that SEP sesam Recovery Pro restores are not
considered to be "received messages."

Shortcut Menu This menu is accessed by right-clicking on an item.
Source Data This is the data store from which folders and messages are copied. The
Store source isread-only, so items cannot be copied into, deleted from, or

changedin the source.

STM For Microsoft Exchange Server 2000 and 2003, this is one of the two files that
make up the Microsoft Exchange Server Information Store, the other being
the EDB file. The STM file stores certain data for emails that come into the
Microsoft Exchange Server through the POP or SMTP port. This email data
may eventually get moved into the EDB file over fime.

Target Data This is the data store to which folders and messages are copied. The target is
Store read-write allowing items to be added, deleted, and changed. The target
data store can be a Microsoft Exchange Server or PST file.
L J
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Appendix A: EWS Configuration

SEP sesam Recovery Prois using Exchange Web Service for connection to O365 mailboxes.

Before you start using SEP sesam Recovery Pro for Office 365 mailbox connection, please ensure
you have the correct setup in your Azure environment and Office 365 tenant.

Example of correct setup for SEP sesam Recovery Pro and Exchange Web Service
connection

1. InPortal azure, confirm that the SEP sesam Recovery Pro app is present in the App
registrations.

Home

App registrations =

1= New registration @ Endpoints ﬂ Troubleshooting O Refresh ¥ Download [ Preview features }5? Got feedback?

@ Starting June 30th, 2020 we will no longer add any new features to Azure Active Directory Authentication Library (ADAL) and Azure AD Graph. We will continue to provide technical sup
and Microsoft Graph. Learn more

All applications Owned applications Deleted applications

L Start typing a display name or application (client) ID to filter these r... +? Add filters

1 applications found

Display name T

n OPC_AppRegistration

If there is no registered SEP sesam Recovery Pro app in the App registrations, create a new
one by clicking New registration...

p — —— Services. —— —

Home >

App registrations =

New registration @ Endpoints ﬁ’ Troubleshooting C_) Refresh + Download & Preview features R'j Got feedback?

All applications Owned applications  Deleted applications

| P Start typing a display name or application (client) ID to filter these ... | +v Add filters

... thenregister the application with the following settings:
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Home > App registrations >

Register an application

* Name

The user-facing display name for this application [this can be changed later).

[ ewspcexapi

Supported account types

Who can use this application or access this API?
@ Accounts in this organizational directory only (PowerControls-Test only - Single tenant)
O Accounts in any organizational directory (Any Microsoft Entra ID tenant - Multitenant)

(O Accounts in any organizational directory (Any Microsoft Entra ID tenant - Multitenant) and personal Microsoft accounts (e.g. Skype,
Xbox)

) O Personal Microsoft accounts only

Help me choose.

Redirect URI (optional)

we'll retumn the authentication response to this URI after successfully authenticating the user. Providing this now is optional and it can be
changed later, but a value is required for most authentication scenarios.

Select a platform g ‘ eg. https://example.com/auth |

Register an app you're working on here. Integrate gallery apps and other apps from outside your organization by adding from Enterprise applications.

By proceeding, you agree to the Microsoft Platform Policies =

2. Onthe OPC_AppRegistration page (Overview tab), in the Essentials section, copy the
Application (client) ID and the Directory (tenant) ID.

— Microsoft Azure P Search resources, serv

Home > App registrations >

HH EWSPcexApi =

|,f) Search | ¢« [ Delete & Endpoints [&5] Preview features

B overview

A Essentials
&4 Quickstart

Display name : EWSPCexApi
#" Integration assistant ) ,
Application (client) ID : 605e12b4-bd1d-4c57-9e0a-f7c26f1a3d0a

K Diagnose and solve problems Object ID : efd68d48-5117-441e-a7dc-21727c386¢55

v Manage Directory (tenant) ID : 876f7a5f-7811-476d-9981-8d440597a73

3. Confirm that this AppRegistration has on the:

= Authentication page: In the Mobile and desktop applications section, the platform
added by default
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(https://login.microsoftonline.com/common/oauth2/nativeclient)is
selected.

Home > App registrations > EWSPcexApi

) EWSPcexApi | Authentication =

“i Search « .é_‘] Got feedback?
B overview
& Quickstart Platform configurations

# Integration assistant Depending on the platform or device this application is targeting, additional configuration may be required such as
redirect URIs, specific authentication settings, or fields specific to the platform.
X Diagnose and solve problems

+ Add a platform

<

Manage
B2 eranding & properties

D Authentication Mobile and desktop applications Quickstart Docs? ]

Certificates & secrets Redirect URIs

The URIs we will accept a5 destinations when retuming authentication responses (tokens) after successfully authenticating users. The redirect URI you send in
the request to the login server should match one listed here. Also referred to as reply URLs. Learn more about Redirect URIs and their restrictions '

Token configuration
-8 API permissions . .
P n https:/flogin.microsoftonline.com/common/oauth2/nativeclient m

o AP
Expose an [ hitps:f/loginlive.com/oauth20_desktop.srf (LiveSDK) [Py

)
App rojes [[] msal605e12b4-ba1d-4c57-9e0a-f7c26f1a3d0ay/auth (MSAL only) [y

&2 Owners

Add URI
&, Roles and administrators
M Mmanifest

» Support + Troubleshooting
Supported account types

Who can use this application or access this API?

= APl permissions page: In the Configured Permissions section, 0Office 365 Exchange
Online - full acccess as appispresent.

Home > App registrations > EWSPcexAp

- EWSPcexApi | APl permissions =

|; Search 3 (D mefresh A7 Got feedback?
B Overview
&b Quickstart
A\ Granting tenant-wide consent may revoke permissions that have already been granted ide for that appli jons that users have already granted on their own behalf ar

# Integration assistant

X Disgnose and solve problems
@ The “Admin consent required” column shows the detauit value for an organization. However, user consent can be customized per permission, user, ar app. This column may not reflect the
~ Manage this app will be used. Learn more

B2 eranding & properties

D authentication Configured permissions

Applications are authonized 1o call APIs when they are granted permissions by users/admins 3¢ part of the consent process. The list of configured permissions should include

Certificates & secrets all the permissions the application needs. Leam more about permissions and consent

1I! Token configuration
+ Add a permission " Grant admin consent for PowerControls-Test
-+ API permissions

API / Permissions name Type Description Admin consent requ... Status
& Expose an AP

v Office 365 Exchange Online (2) wee

App roles

& EWS AccessAsUserAll Delegated  Access mailboxes as the signed-in user via Exchange Web ... No @ Granted for PowerContr,_  =ev
Owners

. full_access_as_app application  Use Exchange Web Services with full access to all mailboxes  ves @ Granted for PowerContr,, =+«
& Roles and administrators

M Manifest

> Support + Troubleshooting To view and manage consented permissions for individual apps, as well as your tenant’s consent settings, try Enterprise applications.

4. Onthe Certificates & secrets page create New client secret that will be needed to connect

to Single Mailbox (Office 365) as a target. Provide a description, expiration date and click
Add. Copy the Value of the newly created secret.
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Home > App registratio EWSPcaxApi

EWSPcexApi | Certificates & secrets =

A Search
B Overview
& Quickstart
o Integration assistant
X oiagnose and solve problems
~ Manage
B Branding & properties
D Authentication
1 Certificates & secrets

Il Token configuration

Add a client secret X
Description e descrgtion for thischentsecret |
) .
A Got feedbadkd Expires Recommended: 180 days (6 months) ~]

Credentials enable confidential applications to identify themselves 1o the authentication service when receiving tokens at 3 web addressabl
scheme}. For a higher level of assurance, we recommend using 3 certificate (instead of a client secret) as a credential.

0 20 g secrets. credentials con be found in the tabs below.

Certificates (0)  Client secrets (1) Federated credentials ()
A secret siring that the application uses to prove ts identity when requesting a token. Also can be refemed to as application password.

t New client secret
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